C Ivie PC-40

PC-40 Computer
Controlled Spectrum
Analysis System &
Precision Sound
Level Meter

[ | 1/3 Octave Analysis
| Class lll Filter Selectivity
[ | Octave Analysis
| Precision Preamp and
Air Condensor Microphone

[ ] dBm, dBV and AC
Volts Measurement

[ ] 20 Nonvolatile Memories

[ ] Screen Dump to Optional Printer

| | Serial and Parallel Outputs

| | Drives Digital XY Plotter
Portable - Battery Operated

Power, accuracy, flexibility . . .
on the bench or in the field.




The computer based lvie PC-40 represents a significant
advancement in spectrum analyzer technology. Capable
of making a variety of measurements both quickly

and accurately, the PC-40 will handle the most
demanding requirements with ease. Its 20

Precision low noise preamp
and air condensor microphone

nonvolatile memories, and parallel and .
serial outputs making saving and storing
data simple. In addition to its built-in Dataand programs
functions, it is user program- can be saved on
able in BASIC, making its optional disk drive
capabilities almost limitless.
Up to 64 dB display range Tilt up screen with selectable
with resolutions of 1, 2, octave, 1/3 octave and weighted
or 3dB per step 1/3 octave displays
Highly selective i
Clgssylll Filters Can display 2 or more
curves simultaneously
Programmable
using BASIC Selectable detector
response time
’ Serial and o
L Parallel Outputs

Typel sound level meter
provides fast, slow, peak,
and impulse measurements

Optional Plug-in cartridge
printer, AC volt meter,

tape drive, modem or PROM--
burner

20 nonvolatile memories for
storing or accumulating data

IE-2P Precision Preamp and
1133 and 1134 mic cartridges.

The PC-40 comes standard with the
1E-2P precision preamplifier, and
your choice of the 1133 free field
response microphone, or the 1134
random response microphone. Both
mics are laboratory quality, air
condensor microphones. The IE-2P is
also compatible with other high quality,
air condensor microphones such as
Briel and Kjaer.

The typical frequency response of the
1133 or 1134 microphone is shown
below.
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STANDARD 1/3 OCTAVE DISPLAY

The PC-40 is capable of making a wide variety of 1/3
octave measurements and storing them in memory for
later analysis. In this illustration, the first ten memories
are shown in standard video. In addition to its twenty
memories, the PC-40 is capable of “snapshot” entry
of screens into memory (472 screens expandable to
8100 screens). The sample rate is also variable from
1 to 100 screens per second.

DISPLAYING MULTIPLE MEMORIES

In this illustration, two memories are being displayed;
in this case a “before” equalization and an “after”
equalization curve. Multiple curves may also be
displayed to show an envelope. An “offset” curve can
also be entered, and other curves shown as a com-
parison against that offset. Memory information can
be subjected to the PC-40’s averaging capability, and
can, of course, be dumped onto a disk or tape cartridge
for storage.

OCTAVE DISPLAY

Inthisillustration, the PC-40 is being used in the octave
mode to generate an NC curve. Withthe 1133 0r 1134
microphone cartridges supplied with the PC-40, curves
as low as NC 30 can be measured. By using other
microphones with lower noise floors, such as the 1inch
B&K 4164 microphone, curves as low as NC 15 can
be measured.

Notice that the second ten memories are shown in this
illustration as indicated by the reverse video.

THE UTILITIES MENU

The Utilities Menu should help give you a feel for how
many of the options mentioned in the three illustrations
can be initiated. This menu allows functions to be
performed such as saving data to a disk or cartridge, or
loading data from these sources. An offset curve may
be entered, or a printer selected. Screen sample rate
can be selected, and the probe or the mic can be chosen
astheinput. The “Record” function allows successive
screens to be stored into a buffer - selectable from
1to 100 screens per second, with up to 8100 screens
being stored. In “Playback,” those screens can be
played back one at a time, if desired.

OPTIONAL ACCESSORIES FOR THE PC-40

1. Digital XY Plotter. Provides hard copy for documentation purposes
2. Disk Drive. Provides data storage and retrieval. Disks are 320 k,
3 1/2 inch, single sided, single density.

3. Ivie Model 1200 Preamp and Model 1300 Power Supply & Low

Noise Amplifier. Provides ultra low-noise front end for PC-40 or

any other system using condensor microphones. The 1200 is a

low-noise preamp which can be used with the 1300 only. The

1300 provides microphone bias voltage of 0, 28, and 200 VDC.

Among its many features are filtering capabilities, and an 800

VDC output for use in electrostatic sweeping of condensor

microphones.

Digital Multimeter. Multimeter is computer controlled by BASIC.

Modem Cartridge.

Printer Cartridge. Provides 40 column, hard copy for document-

ation purposes.

7. Cassette Cartridge. Provides data storage and retrieval on
micro-cassette tapes.

8. MC-25 Microphone Extension Cable. Also comes in 50 foot
(MC-50), 75 foot, 100 foot, 150 foot, and 200 foot lengths. The
microphone on the PC-40 can be remoted up to several hundred
feet without effecting system accuracy or performance.

Db




Ilvie PC-40

TANDARD ACCESSORIES

e lvie PC-40 comes with
“Fast Charge” nickel cadmium
batteries.

Manual with instructions and
illustrations.

AC adaptor/charger

|IE-2P Precision Preamp.
1133 or 1134 microphone
IE-1036B Test Probe

PC-40 Carrying Case

ECHNICAL DATA:

EAL TIME ANALAYZER
1/3-octave operation provided from
25 Hzto 20k Hz in thirty ISO bands.
Highly selective three pole-pair filters
exceed ANSI SI.11-1966 Class |,
B.S.2475-1964 DIN 45652, and
IEC225-1966.
Relative filter flatness + 0.5dB.

1/3-octave filter display can be
“weighted” with A,C, or Flatfilters.

IEC-225 = = ==meee-
ANSI| S1.11 Class || ==ee—e—
PC-40 typical —

0.10.1502 04 06081 1.5 2 4 G 810
FREQUENCY RATIO f/fm

(fm = center frequency)

. One-octave operation provided from
25Hz to 20kHz in ten ISO bands.

- Octave filter skirt selectively satisfies
ANSIS1.11-1966 Class I, BS
2475-1964, DIN 45652, and
IEC225-1966.

SOUND LEVEL METER

m Response modes: Fast, Slow,
Impulse, and Peak.

m Instrument Range 10dBA SPL to
149dBA SPL re 20 u N M?

m  Microphone Noise Floor: 22 dBA
using the standard IE-2P and either
the 1133 or 1134 microphones.

m  Selectable true rms or peak
detectors.

m  20dB crestfactor for full scale
reading.

m  Fourdigit LCD readout with 0.1 dB

SLMresolution.

Digital display modes for continuous

sample or display hold.

Overload and underrange indicators.

Filter weights A,C and Flat.

Flat filter bandwidth 7Hz-35KHz.

Calibration microphone is

remoteable.

Meets requirements of:
ANSISI.4-1971 TYPE S1A,S1C
BS 4197-1967
DIN 45633 B1.1,B1.2 (Impulse)
IEC179-1973

MICROPHONE

m  Element: Air Condensor.
200 VDC Polarization.

m  Directional Patern: Omnidirectional.

m  Dynamic Range: Greaterthan 120
dB with supplied electronics.

m  Response: Either Free Field or
Random Response is available.

m  Frequency Response: 10Hz to
20kHz, as illustrated.

PREAMPLIFIER/ATTENUATOR

m 100Kohminputimpedance.

m Headroom: + 40dB (above display
screen) with sine wave input.
Selectable filter weighting A,C or Flat
Bandwidth 7Hz-35KHz.

Flatness + 0.5dB (20Hz-20KHz).
THD < 0.3% (@ 2.0V output level.
Inputdamage level + 100 VDC or
300 VAC (above 20 Hz.)

m  Outputshortcircuit protected.

DISPLAY

m  240by64 pixel LCD display.

m Displayrangesof 16,32, and 64 dB
are selectable with resolutions of 1,
2,or3dB perstep (.25,.5,0r1dB
per pixel).

m Screenviewing angleis adjustable.

MECHANICAL

m Allmodular construction provides
dependable operation with ease of
maintenance.

m Dimensions:131/4x81/2x31/4
inches.

m  Aluminum chasis with ABS outer
shell.

m Hardshell,foam padded travel case
included.

m  Weight: Net 10 Ibs., shipping: 21 Ibs.

ENVIRONMENTAL

m Allcircuits temperature compen-
sated. o

a2 Operatlngt ;mperature+ 5°C to
+35°C

] Nonoperatlng tem — 25°C to + 60°C.
m Operating humidity 10 to 80%.

POWER

m Battery operation; nickel cadmium,
rechargeable.

m Operating time approximately F~
41/2 hours. )

m Fastcharge cycleof 5 1/2 hours.

m Battery levelindicator.

m ACIline operation from AC
adaptor/charger.

m 115VAC or230 VAC operation
from 50to 60 Hz.

m Chargeindicator light.

WARRANTY

The PC-40 is warranted against defects in
materials and workmanship for one (1) year from
the date of shipment. During the warranty
period, Cetec Ivie will repair or, at its option
replace, components which prove to be defective
provided the unit is returned, shipping prepaid
to an authorized Cetec Ivie service facility.
Defects caused by maodifications, misuse or
accidents are not covered by this warranty.
No other warranties are expressed or implied.
Cetec Ivie is not liable for consequential
damages. All requests for repairs and
information should include the instrument
serial number to assure rapid service.

€ Ceteclvie

1366 West Center Street

Orem, Utah 84057 "
Telephone 224-1800 ‘ﬁ
TELEX or TWX 910-971-5884

FAX 801-224-7526

Cetec Ivie reserves the right to make changes in
the prices and specifications of products without
notice.

Printed in U.S.A.
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PC-40 First Aid

On rare occasions, for reasons still a mystery, the PC-40 software can be
afflicted by a bug. This is not a resident bug, but somehow gets added to the
soffware and causes a problem. We have never been able to cause the
problem intentionally, so we can’t explain the series of events or combination
of key strokes that cause the bug, but we know how to fix it and it is simple.

The bug symptoms are a reference line that will go above 140 or below 30, or
incomplete characters at the reference line or in other places. Sometimes the
bars of the graphic display will be broken or irregular, or the display will be
partially “erased.” Any combination of these symptoms may occur.

The fix is easy, but erases any memory information stored, so memories should
be saved or printed, if needed, before executing the “fix.”

Here is what to do:

1. Push the red QUIT button on the upper left of the key board. The menu
screen should now be displayed.

2. Using the cursor arrows, select the menu item "B:BASIC COM” and press the
return key. This should display the BASIC menu and another press of the
return key should cause the display of the Ok prompt and flashing cursor.

3. Type the following command: OUT 39,137 (the “O” in OUT is the lefter *O~
and not a zero. There must be a space between T and 3). Press the return
key. The OK prompt will reappear.

4. Type the following command: OUT 52,0 (again, "OUT” is the letter "O”", but
following 52, is a zero, not the letter *O.” Press the return key to get the Ok
prompt.

5. Type the word SYSTEM and press the return key. This should return the PC-40
to the main menu with the PC-40 software program being highlighted. Press
the return key to start the PC-40 program.

6. Smile smugly because you have just solved the problem! If the problem
should remain - perish the thought! - fry the procedure once more to make
sure nothing was missed. If it still doesn’t work, call the factory at 801-224-1800
and let us try 1o help.



1366 West Center St.

]
Orem, Utah 84057
VI Tel: 801-224-1800

Technologies Inc. E B T e

FAX TRANSMITTAL LETTER

Reply FAX: 801-224-7526
Number of pages (including this one) 1

12 Oct 1995
To: B. Leroux @ Mesureur
From: Craig Berry

RE: SPL versus PC-40 display - Thompson Angers

SPL cannot be exactly calculated from the spectral display of the PC-40. It
can be approximated, but it is like frying to make an apple from an orange.

SPL, by definition, has a bandwidth from 20 Hz to 40 kHz. The SPL meter section
of the PC-40 measures to 40 kHz as required, but the display screen of the PC-
40 goes out only to 20 kHz.

The measurement of SPL, by definition, requires RMS detectors. The SPL
detectors in the PC-40 are RMS, (or peak detectors if "Peak” is selected) but
the detectors of the analyzer display are averaging detectors.

The SPL meter and the analyzer sections of the PC-40 are completely different
electronics. The only thing they share is the signal input stage - same mic and
preamp. After that, the signal is processed completely differently, as required
by international standard. One cannot be exactly converted to the other by
calculation, it can only be approximated. What you are seeing is completely
normal.

Signals from a calibrator are very close in level to one another when
measured in SPL and converted to SPL from the display by calculation
because some of the variables are eliminated. Only one frequency is
observed, so the biggest differences that remain are the detectors used to
make the measurements, and the interaction of the filter skirts in the analyzer
section (although only one frequency is being input, adjacent filters sfill
register some signal). The results can get very close, but an exact conversion
by calculation is still not possible. We hope this explanation helps.

Highest regards,
Craig Berry



1366 West Center St.
Orem, Utah 84057
Tel. 801-224-1800
Fax: 801-224-7526
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Introduction

Congratulations! With your purchase of the lvie PC-40, you not only have one
of the most powerful, versatile, and accurate audio spectrum analyzers
available, but in addition you have an analysis system that is capable of
expanding as your needs expand.

This manual is intended to familiarize you with the basic operations of the PC-
40 Analyzer, and to whet your appetite concerning some of its possibilities. It is
in no way intended to be the total description of all the possibilities of the PC-40.
Since its on-board computer is easily programmed using BASIC, the
possibilities for using the PC-40, and tailoring it to your specific application
needs are almost limitless.

The PC-40 on-board computer is a 64K, CPM 2.2 machine. It has a parallel port
and two serial ports (RS 232, and high speed serial, both capable of up to 38.5k
BAUD). This manual is not intended to familiarize you with the operation of the
computer, but is intended to teach the operation of the PC-40 Analyzer. A
complete manual on the computer itself is enclosed for your reference.

With reasonable care, the PC-40 will provide a long period of useful service.
Great pains have been taken to assure performance, quality, and reliability. We
suggest that this manual be read thoroughly, and that it always be available as
a reference. The "Theory of Operation" section which follows is of particular
importance-in understanding how the PC-40 operates, and why it operates as it
does.

Theory of Operation

The PC-40 hardware is actually comprised of two sections, the precise analyzer
electronics, and the computer section. These hardware sections may even be
physically separated - the computer actually snaps away from the analyzer.
Since the analyzer is under the control of the computer, and will, in fact, not
work without the computer, it is easiest to think of the analyzer functions as
software functions. Each time a command is given the the PC-40, either by use
of the function buttons or through the use of the QWERTY keyboard, that
command is software executed.

Since the analyzer functions are software based, it gives us some interesting
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flexibility. We can make multiple measurements within a given function, or
compare and process data from different measurements, or even create our
own desired functions, using BASIC. The possibilities are extensive.

Such a broad menu of functions can also create some difficulties. For instance,
there are only 5 function buttons available on the PC-40. We were able to
double that number using the "shift" button in conjunction with the function
buttons. Still, 10 functions is far fewer than are already resident in the PC-40. A
difficult question is, "Which functions should we assign to the ten function
buttons?" The answer, as it turns out, follows a rather natural delineation.

Some functions we naturally want to be able to perform or change while the
analyzer is in operation. These would include changing the reference level, or
the filter decay time, or writing into or reading from memory. A single function
button is most convenient for initiating these kinds of functions. Other functions
don't need to be performed or changed in "real time," such as assigning output
data to a particular interface port. These latter types of functions can be
addressed from the QWERTY keyboard without inconvenience. As you operate
the PC-40, you will find that those functions you use most often, and execute in
"real time" are the functions that will be addressed by the function buttons
directly.

Getting to Know the PC-40

Installing Cartridge Accessories (The H409A Cartridge
Printer etc.)

For complete instructions on installing cartridge accessories, refer to Appendix |
of this manual which shows PC-40 disassembly and cartridge loading.

The PC-40 Microphone and Preamp

The PC-40 comes standard with a 1/2 inch air condenser microphone (your
choice of a free field or a random response microphone), and the IE-2P
Precision Preamplifier. 1/4 inch, 1/8 inch, and 1 inch air condenser

microphones are available on a special order basis.

Providing such a quality front-end with your PC-40 is not an inexpensive
proposition. You will discover that if you lose your microphone and preamp, it

4



~ will cost more than a thousand dollars to replace them. However, we feel

strongly that an analyzer and sound level meter can not be more accurate or
reliable than the microphone that comes with it. If you look at other analyzers
on the market today, you will find that many come without microphones, and
many others come with relatively inexpensive commercial microphones.
Providing laboratory quality. microphones and preamplifiers with analyzers is
almost unique to lvie.

The PC-40 is a Type | sound level meter, and has the accuracy of Class lll filters
in the analyzer section (in SLM Types, low numbers are best; in filter Classes,
high numbers are best). As long as you use the microphone and preamp that
came with your analyzer, its accuracy and performance to specifications is
assured. You may easily use other microphones with your PC-40 as long as
you remember that all readings are then relative, and are not absolute. You
must further remember that the spectral information shown on the analyzer will
be colored by the response of the microphone you are using. '

Other air condenser microphones which conform to international dimension and
thread specifications can be used with your PC-40 by simply removing the
microphone cartridge from the end of the IE-2P and replacing it with the air
condenser cartridge you wish to use. Many air condenser microphones,
including those made by B & K, ACO Pacific, and Rion are compatible with the
IE-2P. If a one inch, quarter inch, or eighth inch microphone is to be used,
adaptors will be needed to adapt to the half inch barrel of the IE-2P. Some one
inch microphones require a polarization voltage of 28 volts instead of the 200
volts which is most common. In this case, the polarization voltage of the |E-2P
will need to be switched. Some may require the use of the 20dB pad available
in the IE-2P, and, of course, changing the microphone will always require
recalibration of the system. (For information on changing polarization voltage,
the 20dB pad, and recalibration, refer to the IE-2P manual and the section in
this manual entitled "System Calibration for OSHA Measurements," under the
heading of "Sound Level Testing."

When using another microphone, it is important to know the frequency response
of the microphone in order to interpret the display information of the PC-40. The
typical frequency response of the standard microphones for the PC-40 (the
1133 Free Field and the 1134 Random Response or Pressure Response) are
shown on the following page:



1133 Typical Response
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As can be seen, these microphones have been chosen for their excellent
response characteristics, and their ability to provide maximum accuracy to the
measurement capability of the PC-40. Should you have questions about
microphones, or their application in analyzer measurements, please don't
hesitate to contact us at the factory.

Inputs and Outputs -The PC-40 Microphone Input Plug and
the PC-40 1/O  Panel
The Microphone Input Plug

The microphone input plug on the PC-40 is a six pin XLR-type connector.
Following is an illustration of the pinout of this connector:



1 \ @ f/ﬁ
2 ‘—-_____: - o 5
3 —T11 ® \\4
Figure Il

Pin 1: Input pin. The input impedance is 100 kQ. The maximum direct DC input
before damage is 100VDC. The maximum direct AC input is 300VAC from
20Hz to 4kHz. For frequencies above 4kHz, derate maximum AC input by
6dB/octave (e.g. 150VAC @ 8kHz, 75VAC @ 16kHz, 6VAC @ 20kHz)

Pin 2: Gain Trim pin. Varying the pin voltage between 8VDC and OVDC varies
the gain of the PC-40 over a 15dB range. This pin is not to be used for AGC
purposes, but only as a long term gain adjustment for calibration requirements.

Pin 3: No connection.

Pin 4. Power (V) for microphone preamplifier. It provides 10mA (maximum
current) at 12VDC.

Pin 5: Calibration pin. Pin 5 is normally tied to pin 4, which sets the PC-40
calibration for dBuV.* IF pin 5 is not tied to pin 4, calibration is set for dB.1uV.t

Pin 6: Ground.

*0dBuV = 1.0uV 1 0dB.1uV = 0.1uV

Microphone Extension Cords

It is helpful to know the microphone input pinout, especially if you plan to make
your own extension cord. Extension cords are available from lvie in lengths
from 25 ft. to 200 ft. in 25 ft. increments, but should you choose to make you own

cord, that can be easily done using a minimum of three conductor shielded
cable, and one male and one female 6 pin XLR-type connector. Pin 1 must be
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brought through, as well as pins 2, and 4. The shield should be tied to pin 6.

should be tied together at the female XLR which plugs into the PC-

If you tie them together at the male XLR connector at the other end of your

extensmn cable, no conductors will be tied to them, so they will not be tied

together at the PC-40. A highly supple (and therefore, usually expensive) cable
is recommended. '

The PC-40 I/0 Panel

The PC-40 I/0O Panel is located at the top of the PC-40 and looks like this:

r N
OVDC+B  pyENT RELAY cnmem PRE-AMP
I u IN DUT °—l
@ @ ke (O
ouT
FigurelV

The first item that should be noted is the battery charger input. As can be seen,
it is a 9 volt DC input with the center pin positive. Do n | he PC-4
charger (CH 40) into a disk drive or into the computer section of the PC-40.
These inputs are center pin negative, and you will destroy your disk drive, or
damage your computer! The battery charger input of the computer has been
covered to prevent accidental insertion of the CH 40 Charger. In the unlikely
event that the cover should come off, it should be reattached. If it is lost, another
is available upon request from lvie at no cost.

Battery and Line Operation

When fully charged, the PC-40 will operate for at least five hours continuously.
In some applications, is will last longer since the analyzer section is "slept"
while the computer section processes data. The computer alone will operate for
12 to 14 hours between charges.

Charging the PC-40 completely takes about 5 hours if the unit is off, or about 7
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hours if the unit is on. It can be operated continuously while charging with no
problem. It will toggle into trickle charge when the batteries reach a full charge.
When in the "fast charge" mode, the red LED in the Patch Panel labeled "OK"
will be illuminated. (See illustration below.)

"RED LED ONLY ILLUMINATES GREEN LED LIGHTS WITH RED LED
WHEN THE PC-40 IS IN THE \ . WHEN THE BATTERIES ARE
oK TOGGLES INTO A TRICKLE CHARGE
FINISHED
Figure V

After toggling into trickle charge, the red "OK" LED, and the green "Finished"
LED will illumninate.

In emergency situations, the PC-40 can be powered from an external 9 Volt DC
battery. The battery can be fed into the PC-40 charger input plug. Make sure to
observe proper polarity - center pin positive. Length of operation will depend
on size of external battery, and application of the PC-40. The current draw of .
the PC-40 will not exceed one amp, so the time of operation on any external
battery can be easily estimated.

The Preamp Output

PRE-AMP

O

ouT
Figure VI

The preamp output of the PC-40, located at the far, right side of the NO Panel, is
a straight analog output. It provides from 30dB of attenuation to 80dB of gain,
relative to the input, in 10dB increments - a total range of 110dB. The gain of
the preamp is controlled by the RANGE buttons of the PC-40 which are used to
raise or lower the Reference Level of the analyzer.

The output impedance of the preamp is 600 ohms. 600 ohm headphones can
be directly driven from the preamp output. The preamp input can be switched
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between the PC-40 microphone and the probe, so it can be used as either an
audio or an electrical preamp.

The weighting of the preamp output also follows-the weighting of the PC-40
SPL meter. If, for example, the SPL meter is set for "A" weighting, the preamp
output will be "A" weighted, regardless of whether making audio or electrical
measurements. The preamp. then I |l by itself weigh

preamp.
The Audio Relay

RELAY
Q._/ D
Figure VII

The Audio Relay of the PC-40 is a dry contact switch, so it doesn't care which
port is the input or which one is the output. The Audio Relay can be accessed
via the PC-40 keyboard, or through BASIC or Machine Language programming,
and is used in specialized functions of the PC-40, such as RTgg. When
performing an RTgg measurement, the signal source would be fed into the
Audio Relay and out to the "house" sound system.

Figure VIl

When performing the RTgg measurement, the function of the Audio Relay would

be to shut off the audio signal in the room to begin the test. The Audio Relay
can be used in any test setup where a programmable audio relay is necessary.

To access the audio relay via the PC-40 keyboard, hold down the CTRL key
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and press A for "Audio." This toggles the relay between open and closed.
When the relay is closed, the INS LED on the PC-40 keyboard will illuminate to
indicate relay closure.

The Event In/Out

EVENT
IN OUT

00

Figure IX

The purpose of the PC-40 Event In/Out is to allow the analyzer to be controlled
(ie. turned on or off) by an external event, or to allow an external event to be
controlled by the analyzer. The "Event IN" port is used when we want to control
the analyzer by some external event. The "Event OUT" port is used when we
want the analyzer to control some external event. Below is an illustration
detailing the electronics and voltage requirements for using the Event trigger.

External 3‘“’“"{!"‘5 _—
Supply Max. Yoltage 50 Yolts
| [ Max. Current 500 mA
+Y -| + = +
Push to
Start Event %
.Izlmjj D—-—O:l TO COMPUTER —HL ; || v—C (@—) TO COMPUTER
IN EVENT IN/OUT ouT

Figure X

The Event trigger is accessible only through BASIC or Machine Language
programming, and is not utilized by the resident PC-40 software.

The PC-40 Display Screen

On the following page is an illustration of the PC-40 display screen. The screen
is quite self explanatory, but a few items should be noted.
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The screen itself may be tilted to approximately 30° to facilitate viewing. To tilt
the screen, press the release button on top of the PC-40, and pull the top of the
screen toward you.

The memory section and other screen display sections of the PC-40 are
identified in the preceding illustration. It should be noted that the memories are
divided into two banks of ten each. The first ten are displayed in standard video
(black letters on white background), and the second ten are displayed in
inverse video (white letters on black background).

**Important Note**

Near the bottom of the display screen, a line appears all the way across the
screen when in the 3dB per step mode only. (See the illustration.) This is
called the "Invalid Data Line." Because of the number of pixels in a column on
the display screen, it works out best to show an "on screen" dynamic range
exceeding 60dB - this allows us to work in even numbers of pixels, not having to
cut any in halves or thirds, which would be impossible to display. While this
works out fine in terms of the pixels in the display, the greater than 60dB of
dynamic range actually exceeds the true dynamic range of the filters - that is, we
begin to run into the actual noise of the filters themselves when we look that
many dB down.

The Invalid Data Line represents the limits of the safe area of the display. Any
data below that line may be actual sound, or could be filter noise. Therefore,
information below the invalid data line should not be regarded as accurate. The
Reference Level should be adjusted so that all data rises above the Invalid Data
Line to prevent errors in readings. _Information below the Invalid Data Line will
not be stored in memory. For further information on this matter, consult the

section of this manual entitled, "The PC-40 Memory Functions."

Several references will be made to Figure Xl in the next pages of this manual as
we explore further the functions of the PC-40.

Individual Filter Display - Graphic & Numeric
You have already had a chance to look at the illustration of the PC-40 display
on page 12, and have probably even turned on your PC-40 to see the real-time

display for yourself. You are most likely already familiar with the kind of bar
graph display presented by the PC-40. Overall SPL is shown numerically, and
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the amplitude of each of the octave or 1/3 octave channels is shown graphically.
You can't tell it by looking at the graphic display, but the PC-40 actually
maintains a resolution of .1dB on individual filter amplitudes. Your eye can't
detect that kind of resolution, but, as you will learn later in this manual, it is
possible to obtain tabular (numerical) printouts which indicate individual filter
amplitudes to a tenth of a dB.

It is also possible to view numerically the amplitude of any given channel in
real-time. This is a very useful function, and access to it is easy.

The illustration below is a normal real-time display showing overall SPL
numerically, and individual filter amplitude graphically:

— Individual Filter Amplitude

L 1
--------------------- 80
L L ——-'-—-————T-"18 13 >
:—%_: -36 F FT
V.

Sound Pressure Level

Figure XII

Notice that the Message Window is blank during real-time operation. If you
have trouble finding the Message Window, refer back to Figure Xl on page 12.
The PC-40 can numerically display the amplitude of any filter you choose in the
Message Window. To activate this feature, simply press the letter F for "Filters."
If we pressed the letter F while viewing the above display, we would get a
display that looked something like the illustration shown on the following page.
Compare the Message Window on the two illustrations.
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Filter Selected
Amplitude

Figure Xiil

The first number in the Message Window indicates the frequency of the filter that
has been selected. In Figure Xlll, it is the 25 Hz filter. The number below
indicates the amplitude of the 25 Hz channel - in this case, 40.8 dB. The
resolution is .1dB. This is a real-time function just as the graphic display is, so
this number will be constantly updating as the amplitude in the channel
changes.

In the above example, we looked at the 25 Hz channel, but we could look at any
channel we want to. To select a different channel for viewing, use the left and
right Cursor keys. These are the keys with arrows on them located on the right
hand side of the keyboard. The left one will move lower in frequency, and the
right one will move higher in frequency. There are up and down Cursor keys
as well as left and right ones. The up and down Cursor keys, and the left and
right ones are used in many PC-40 functions.

To get out of this display mode, simply press the letter F again and it will return
the PC-40 to a standard, real-time display.

Now that you have a little taste of some of the PC-40's exciting capability, let's
move on and examine the functions accessed by the function buttons.
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The PC-40 Function Buttons and the Accumulate Function

In the highly unlikely event that you haven't already had your PC-40 on, you
may turn it on now. The OFF/ON switch is located on the right side of the unit
below the keyboard, (See Figure XIV below).

The Function Buttons of the PC-40 are located directly below the display screen
of the PC-40, (See Figure XIV below). The rest of the keys are fairly standard.

T € Ivio FT-a0

Function
Keys

OFF/0N
Switch

unheshehennhedenled e

Figure XIV

Before we discuss the function keys, let's talk about the Accumulate
Function which is activiated by pressing the letter A. This could save some
frustration later. When the letter A is pushed, the PC-40 display screen and the
SPL readout go into a peak hold mode - that is, the highest level recorded at
each filter is displayed and "frozen" on screen until something higher displaces
it. The same is true of the SPL display. If you don't know you are in this mode,
the PC-40 screen appears to have "frozen up," and yelling and thumping the
PC-40 only makes the display rise a little further, with no other apparent effect.

Actually, Accumulate is a very useful function, especially if you want to
determine a peak envelope of some program material, or walk an auditorium
listening to pink noise and accumulating the peaks. We call this function the
"Accumulate" function, and you can always tell you are in this mode by the
inverse video "A" that appears next to the SPL readout at the bottom-right of the
PC-40 display screen (see Figure Xl). To get out of the "Accumulate" function,
just press the letter A again. Now let's discuss the function keys.
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The purpose of the function keys is to simplify operation of the PC-40 without
having to make commands from the keyboard. The five right-most keys (labeled
PF1 through PF5) will be used most often since they control the basic analyzer
functions. These keys have more than one function which can be addressed by
using the Shift key in conjunction with the 1unct|on key, or in some cases the
Ctrl key with the function key.

PF1 and PF2
(The Range Function & Selecting SPL Detectors and Weightings)

Let's examine each key and its functions beginning with PF1 and PF2. These
keys have this annotation above them:

W RANGE A

The PC-40 screen display has a reference level (See Figure XI) which is
adjustable from 30 to 140dB, when using the microphone as the input, or from
50 to 180dB pvolts when using the probe as the input. In either case, the
reference level steps in 10dB increments. As the keyboard graphics indicate,
pushing PF1 (the "down" arrow) lowers the reference level by 10dB, and
pushing PF2 (the "up" arrow) increases the reference level by 10dB. This is
called the "RANGE" function because raising or lowering the reference level of
the PC-40 changes its reading range.

PF1 and PF2 also perform additional functions which are related to the SPL
meter section of the PC-40. Since the PC-40 is a Type | SPL Meter, it must, by
definition, be able to perform a number of different measurements. PF1 allows
you to select either "A" weighted (dBA) measurements, "C" weighted
measurements, or "Flat" (unweighted) measurements. (For more information
on these types of measurements, refer to the manual section on SPL
Measurements). To choose "A," "C," or "Flat" measurements, first push and hold
the Shift key and then, while holding the Shift key, push PF1. Holding down
the Shift key while pressing PF1 will cause the PC-40 to toggle through "A,"
"C," and "F" weightings. An A,C, or F will appear at the bottom right of the PC-
40's screen display to indicate what SPL weighting has been selected (See
Figure XI).

The PC-40 also contains all the SPL detector responses necessary to qualify it
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for Type | measurements. These include Fast, Slow, Peak and Impulse. These
detectors can be selected by pressing and holding Shift while pressing PF2.
The PC-40 will step through "FT," "SL," "PK," and "IM" in the same manner as
described for changing SPL weighting. Also, visual indication of the selected
detector is given in the lower right corner of the PC-40 display screen (See
Figure Xl). (For further information on detector responses, refer to the manual
section on SPL Measurements.)

PF3
(The dB per Division, and Filter Decay Functions)

Like PF1 and PF2, PF3 performs a dual function. Pushing just PF3 will allow
you to select 1, 2, or 3dB per division on the PC40 display screen. A screen
resolution of 1dB per step (.25 dB per pixel) provides a 16dB display range.
2dB per step (.5 dB per pixel) gives a 32dB display range, and 3dB per step
(1dB per pixel) yields a 64dB dynamic display range.

The Shift/PF3 function is labeled "DECAY." Pressing Shift/PF3 will allow you
to select a filter decay time of "Fast," "Medium" or "Slow." At the top, right hand
side, next to the display screen, you will find the words "fast,” "medium," and
"slow" represented (See Figure XI). The PC-40 will display a small, darkened
square beside the filter decay time selected. "Fast" is intended for monitoring
signals or program material and will respond to relatively short spikes of
information. "Slow,” on the other hand, is intended for pink noise use only. lis
averaging time is sufficiently long to hold pink noise flutter of the low frequency
filters to an acceptable minimum (about plus or minus 1dB).

PF4 and PF5
(Memory Functions and the Display and Relative Functions)

PF4 and PF5 access the 20 memories of the PC-40. To store a screen of
information in one of the memories, simply press PF4. The screen will freeze
with current data, and await your selection of one of the 20 memories for
storage. The Message Window of the PC-40 (See Figure XI) will indicate that
you have entered the storage mode. If you wish to store the data in memory
#1, for example, press PF4 (STORE) and then press the number 1 on the
QWERTY keyboard. If there is already something in memory #1, it will be
replaced by what you have just entered. Data stays in a given memory until it is
replaced by something else, or until you clear that memory.
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After you have pressed STORE, 1, the PC-40 screen will appear to do a
carriage return, and a date and time code along with a cursor will appear at the
bottom of the screen. You may now type in from the keyboard up to one full line
(40 characters) of annotation to document the screen you are storing. This note
will be stored with the screen data and will be printed out in full if you choose to
print the information in memory. In addition to storing the screen and your note,
the PC-40 also enters the date and time that the data was stored (Of course, for
the proper date and time to be stored, the PC-40 will have to have been
properly set. It leaves the factory initialized for the Mountain Time Zone, but
may have to be corrected for your area. (Information on setting the time/date
code in the PC-40 can be found later in this section of the manual under the
heading, "The Other 4 Function Buttons," and the subheading "Utilities." The
specific "Utilities" function relating to this is called "Time.") Again, if you print the
memory, the screen, the note, and the date and time it was stored will be
printed. As you can see, the possibilities for complete documentation are

provided. Figure XV below demonstrates the things we have discussed.
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Whenever a memory is occupied by data, that memory number will appear in
the memory section located on the right hand, center of the PC-40 display
screen (See Figure Xl, and Figure XV above). The first ten memories are
indicated by standard video (black lettering on a white background) and the
second ten memories are indicated by inverse video (white lettering on a black
background).

To clear a memory, store something over the top of it, or press STORE, then C.
The word "Clear" will appear in the Message Window. Next press the number
of the memory you wish to clear. That memory will be cleared, and the PC-40
will return to real-time operation.

To recall a memory, simply press PF5 (RECALL) and then the number of the
memory you want to recall. Only those memories with data stored in them may
be recalled. Notice that when recalling a memory, the "Note" does not
automatically appear. To get the note to appear on screen, press the keyboard
letter N, and the note will appear at the bottom of the screen. Pressing
RETURN will then get you back into real-time.

Some important points to remember are:

1: The "Note" in a memory may be viewed and/or changed at any time by
pressing the letter N (for "Note") while viewing the desired memory.

2: A recalled memory is recalled completely, and that data in the memory is
subject to software manipulation. For example, if we recall a memory, we can
change the Reference Level, or the dB per step, and the display will accurately
reflect the changes we have made. However, when we return a recalled
memory back into memory, it will return in the same format it had before we
recalled and manipulated it.

3: As was mentioned earlier, the 20 memories of the PC-40 are divided into
two banks of 10 each. The first 10 are indicated on the display screen by
standard video, and the second 10 are indicated by inverse video. You can
toggle back and forth between the two banks of memories by hitting the letter M
for "memory" while in either the "Store" or the "Recall" mode. For example, if
you want to store a memory in one of the second ten memories (inverse video),
and you have pressed the STORE button and the first ten memories (standard
video) are being displayed in the memory box, press M, on the keyboard. This
will cause the second ten memories to be displayed. Pressing M again, will
cause the first ten memories to be displayed once more.
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This same thing is true when selecting RECALL. Pressing M will cause the
PC-40 to toggle between displaying the first ten and the second ten memories.
Memories can be quickly recalled and displayed one after another by simply
pressing their numbers when in the Recall Mode.

4: 1t is first necessary to press either STORE or RECALL before pressing M
to get the PC-40 to toggle between displaying the two banks of memories.

***Important Feature---Displaying More Than One Memory***

More than one memory may be displayed at a time by the PC-40. To display
two memories at once, press RECALL, then the letter C. The keyboard C
stands for "Composite." Now let's look at Figure XVI below and the Message

Window:
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Figure XVi

Notice that the Message Window says RCOMP for "Recall Composite." Below
that notation in the Message Window a cursor arrow (<) and a plus (+) and a
box (Q) are located. In this illustration, the cursor arrow is pointing toward the
plus sign, and the number "1" has been printed. This means that the operator
has pressed the following keys: RECALL, C, 1; for recall composite, display
memory #1. Memory #1 has been displayed as plus signs because the cursor
arrow is pointing at the plus sign. If we now wanted to display memory #2 as
boxes to discriminate it from memory #1, we would point the cursor arrow
toward the box sign by pressing the PC-40 keyboard arrow which points right to
select boxes, and then press 2 to display memory 2. The number "2" would
appear in the message window next to the box symbol, and memory #2 would
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be displayed.

Note: If we had made an error in selecting memory #2, and really wanted to
display memory #3, we could just push 3 and memory #2 would be replaced by
memory #3 on the display screen.

More that two memories can be displayed also, but in this mode, all memories
are displayed as dashes. This mode is usually used to display a frequency
response window, since one memory display cannot easily be distinguished
from another. To display more than two memories in this mode, push RECALL,
C. Next hit Ctrl, and while holding the Control button down, press the numbers
of all the memories you want to display. Each one will be displayed as dashes
---. More information on displaying multiple memories and subtracting one
memory from another is contained in the section of this manual entitled "PC-40
Memory Functions.”

PF4 also has a shift function called "DISPLAY." The PC-40 provides four
possible screen displays. These include octave, 1/3 octave, octave weighted,
and 1/3 octave weighted. Whether the PC-40 is in the octave mode (10 bars on
the display screen) or 1/3 octave (thirty bars on the display screen) is
immediately obvious from looking at the display. However, either octave or 1/3
octave displays may be weighted. The weighting follows the "A," "C" or "F"
weighting of the SPL meter. As previously discussed, an A, C, or F appear in
the SPL section of the PC-40 display screen. If an arrow appears next to the A,
the C, or the F, the screen is weighted correspondingly (However, F or "Flat"
weighted is the same as unweighted). A quick look at Figure Xl on page 12 will
easily help locate the position of the arrow.

Shift/PF4 (DISPLAY), then allows you to toggle between selecting octave,
1/3 octave, weighted octave, and weighted 1/3 octave. To select the type of
weighting, Shift/PF1 is used.

PF5 has a Shift function which is called "RELATIVE." This is an especially
nice function to use when doing seat-to-seat variation in SPL readings in an
auditorium. To activate this function, press Shift/PF5. When this is done, the
PC-40 locks into memory the SPL reading that was occurring the moment the
"RELATIVE" function was activated. From that point forward, until "RELATIVE" is
deactivated by pressing Shift/PF5 again, the message window will display the
word "REL" and the SPL either above or below the SPL that was locked into
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memory. The SPL display will continue to display standard SPL, as shown
below:

RELATIVE
Indication

1
REL
-2.6 « + or - dB
12 35

Figure XVII

The RELATIVE function also works when viewing the amplitude of a single
channel (see pages 13 through 15 in this manual). When in RELATIVE, you
can press the letter F (or when viewing individual filter amplitude, you may
press Shift/PF5 for RELATIVE) and the Message Window will display the
channel frequency and relative amplitude, instead of relative SPL, as shown in
the illustration below:

Frequency
Indication
| I
315
80 —+ or - dB
12 5 ‘
18 -
50 e e
SPL 75.4

Figure XVIil

Notice that plus or minus dB is now shown in inverse video so that you know
you are looking at a single channel, and not broadband SPL.

In our auditorium example, if we didn't want the seat to seat SPL variation at
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4kHz to be greater than plus or minus 3dB, we could feed pink noise into the
system at some fixed level, select the 4kHz channel for amplitude viewing, then
activate the RELATIVE function and walk the auditorium while monitoring the
PC-40 Message Window to make sure the relative reading at 4kHz was not
swinging more than plus or minus 3dB.

***Important Function - The "Screen Dump” Print***

In addition to the above functions, PF5 also performs a "screen dump” printing
function. After we have selected our printer or port option (for more information
on selecting a printer, or port option, see the section of this manual entitled
"Printing Options"), we simply hold down the Ctrl key and hit PF5 for a "screen
dump" printout. When we do this, whatever is currently displayed on the PC-40
screen will be printed. If we recall a memory and print it, the note we have
attached will be printed also, as well as the date/time code indicating when the
data was put into memory. These memories are nonvolatile and can be saved
as long as needed.

**Important Note*** If you try to activate the "Screen Dump" routine and no
printer is connected to the PC-40, or the printer port assignment is incorrect, the
computer will "lock up." If this happens, press Ctrl and QUIT simultaneously
to stop the print function, and then check printer connections and port
assignments.

The Other 4 Function Buttons

There are four more function buttons on the PC-40. In order, from left to right,
they are labeled QUIT, UTILITIES, AVERAGE, and HELP. The last three
are also labeled ESC (Escape), PAUSE, and SYSTEM. These last labels do
not apply to the analyzer operation, but do apply to the computer when using
BASIC or the CPM operating system (Refer to page 2-22 of the HX-40 operating
manual). ESC, PAUSE, and SYSTEM will not be covered in this manual, but
are covered in the computer operation manual.

HELP

We are going to discuss the HELP button first, because it applies to all the
functions we have previously described, as well as those to follow. The HELP
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button accesses a context sensitive help screen. Here is the way it works: The
PC-40 always knows what function it is performing, and what it is doing within
that function. In most instances, when you want to know where you are within a
function, or what options are available from there, the "Help" function can do just
that - help you. Pressing HELP will cause information to appear on the display
screen to help you understand where you are and where you may go from
there. The best way to describe it is a built-in mini-reference manual. The
HELP button is your friend and you will want to use it often. As with most other
functions, you push HELP to get in and you push HELP again to get out of the
function. In the event you fail to press HELP again to get out of this function,
the "help" screen will go away on its own after 45 seconds.

QUIT

The red QUIT button has a simple function. In most analyzer modes, pressing
QUIT will drop the analyzer software out of working memory and return you to
the menu in the CP/M operating system. From this menu, you may choose what
function you desire to perform (BASIC, or back to the PC-40 ROM). There are a
few functions, such as "Store" and "Recall,” that will not allow you to "Quit" until
they have been completed.

UTILITIES

"UTILITIES" allows us to address a number of important and useful functions.
(We will introduce them here, but not go into them in detail. The section of this
manual entitled "Utilities Functions" goes into great depth, and should be read
carefully.) To get into this function, press the UTILITIES key. (To get out,
press the UTILITIES key again. The PC-40 is designed this way on all major
functions. To get out of any function, push the same button that got you in.)
After you press UTILITIES, a menu will appear on the PC-40 display screen.
There are ten items on this menu which can be accessed by pressing PF1
through PF5, or Shift/PF1 through Shift/PF5. In essence, the function keys
are reassigned to perform utility functions, when in the "Utilities™ mode.

Let's quickly examine these items one at a time. The first menu item is "Save."
(Unless you have the RTgqg software, in which case it will be listed first.) To
access "Save," press PF1. This function allow you to save data to a
microcassette, a disk drive, etc., and allows you to select the data you wish to
save. To get out, press PF1 again (unless the menu requests another key to

25



perform an exit command. This is generally true for getting out of all the
"UTILITIES" menus, that is, push the same key to get out that got you in, unless
the menu states otherwise.).

The second menu item is called "Time," and allows you to initialize with date
and time information. Push Shift/PF2 to get into this function. The menu here
is quite self-explanatory.

The third menu item, "Load," and allows you to load data into the PC-40 from
some selected external source, such as a disk.

The next menu item is called "Printr," for Printer, and allows you to select the
printer port you wish to use for printing. If the optional cartridge printer (the
H409A) for the PC-40 is used, three size printing formats are available, and this
utility function allows you to select which size format you desire.

"Offset" is the next utility function and in this mode you may enter a desired
curve into the PC-40. After a curve has been entered, and the "Offset" function
is active, the displayed information on the PC-40 screen will be relative to the
entered offset curve. For example, if we enter a desired house curve as our
offset, and then equalize a sound system such that we have a flat display on the
PC-40, we will have equalized to our offset curve. (In this case our desired
house curve.) Whenever the "Offset" function is activated, the word "Off" will
appear to the left of the Message Window on the PC-40 display screen (See
Figure XI).

The next utility function is called "Rate," but before we talk about it, we are going
to discuss the function before it called "Record,” so it will make better sense.
The PC-40 has the ability to store successive screens of information into buffer
memory. It can store them at a rate of from 1 screen per second up to 100
screens per second (100 is displayed as "00"in the "Rate" menu.) If you want to
record into buffer, and you want to select a different record rate, the "Rate"
function allows you to do this using the cursor keys (arrow keys) on the PC-40.
The "Rate" menu explains how to do it.

***Important Note - - - "Rate" Affects "Real Time" Data ***

Setting the "Rate" will also affect the real time display of the PC-40. If, for
example, you set the sample rate to 1 screen per second and then return to
"real time," you will see the filter display of the PC-40 update once each second.
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The SPL display upgrades once for every 10 filter display updates, so you
would see it display only once each 10 seconds. Being able to slow down the
display is a real advantage for some applications. In real time, the PC-40 is
capable of displaying up to about 18 or 20 samples per second. If you set the
"Rate slower than this, it will slow the display down. If you set the "Rate" higher
than this, the PC-40 will still display only as fast as it can - about 18 to 20
samples per second. The SPL meter in the PC-40 can handle a rate of up to 75
samples per second before it tops out. If you set a "Rate" less than 75 samples
per second, the SPL meter will be slowed accordingly. For "Rates" above 75
screens per second, the SPL meter simply does what it can - about 75. (If you
re_using the SPL meter apture short duration phenomenon, the sample
rate shoul for r higher so that no data will olored because the
isplay is sl

You may ask why we allow the setting of a sample rate that exceeds the
analyzer's ability to display the information, and that is a good question. The
answer is that while we may not be able to view the samples in real time, we
can still write them into memory at these high rates, and then recall them to
view. Let's explore that a little further. The illustration below shows the "Rate"
menu.

SAMPLE RATE

Change RATE with CURSOR CONMTROL keys
Press RETURM when dons

SLOH |

In this area (up to 20 In this area(21 to In the area above
samples/sec.) both 75 samples per 75 samples per
filters and SPL are second) SPL displays, second, all display
displayed filters do not is lost

Figure XIX
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The bar in the above menu represents the number of samples per second you
select. You change the "Rate" by using the left and right cursor arrows on the
PC-40 keyboard. The small arrow below the bar with the number by it always
tells you how many samples per second have selected. In the example on the
preceding page, we have selected 76 samples per second.

The bar is divided into three sections which represent the display capability of
the PC-40. If we are in the "Record" function, and have selected a speed of 20
or less samples per second to be written into buffer memory, all the sample
screens will be displayed as they are recorded. If we select a speed above 20
screens per second, but less than 75, the filter screen will not display the
samples as they are taken (the screen goes blank while recording), but the SPL
meter will continue to display samples as they are taken. If we exceed 75
samples per second, both the screen and the SPL display will go blank as
samples are written into memory because neither display is fast enough to keep
up with the sample recording rate. Those screens are in memory, however, and
we can recall and display them.

We have talked about getting into the "Record" function, but that needs further
discussion. Getting into and out of the "Record" function is different than the
other functions of the PC-40. When you want to get into the "Record" function,
first press the UTILITIES key. Next, select the "Rate" function by pressing
Shift/PF4, and, using the cursor keys, select the number of screens per second
you want to dump into memory. The menu will request you to hit Return to get
out of the "Rate" function and back into the "Utilities” menu.

When viewing the "Utilities" menu, you may activate the "Record” function by
pressing PF4 (If you have already been in the "Record " function and there is
data in the buffer, the screen will prompt you indicating that data will be lost if
you continue. You can choose to continue and overwrite the data, or choose
not to continue). When you activate the "Record" function, the PC-40 will revert
back to a real time display screen. The Message Window will indicate that you
are in the "Record" function, and the number of screens per second you have
selected will be printed in the Message Window as well. Note the illustration on
the next page:
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The PC-40 is in the

80 RE0E130 ~— Record Mode, set for
| 2 5 30 samples/sec. The
-18 5 01 indicates sample

#*1, which will be
-36 F r7 | taken when the "A" key

SPL 75 4 is pressed.

Figure XX

The system is now armed and ready to begin recording. Recording is started
and stopped by pressing the A key (the same as for starting and stopping the
AVERAGE function). When you press the A key, recording will begin and will
continue until you hit theA key again, or until internal memory is filled (up to 472
screens, which is expandable to 8150 screens by adding extra memory as a
factory option). The bottom number in the Message Window indicates the
number of samples taken, or identifies a particular sample screen by number.
Also. in the pl k m h mple number will identify ti i

In our illustration above, for example, we are set for 30 screens per second. If
we were looking at the samples we had taken under this setup, sample #60
would be displaced in time exactly two seconds after we began our sample
process. This leads to some interesting possibilities for time domain

measurements.

To get out of the "Record” function, you must press UTILITIES to bring
up the "Utilities" menu, then press PF4 (the "Record" function) to toggle out.
Following this procedure will allow you to toggle in and out of the "Record"
function. When you exit the "Record" function, the PC-40 will prompt you and
give you an opportunity to add a note the record buffer file. Adding a note to
the file is optional, but it is helpful when you are trying to identify the data at
some later time. To add a note, type the information you choose and press
Return. If you do not wish to add notation, simply press Return.

The "Playbk" (Playback) function allows you to play back the screens of
information you have stored in the "Record” function. When in "Playbk," the
cursor keys of the PC-40 will allow you to step forward or backward through the
screens of data, either one at a time by tapping the cursor keys, or a rapid scroll
by hold a cursor key down. You may also step through the samples in multiples
of 10 by holding down the Shift key while pressing the arrow keys. If you try to
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enter the "Playbk" mode when nothing has been recorded into buffer memory,
the menu prompt will let you know you have made an error.

The final "Utilities" function is called "Mic/Prb" (Microphone/Probe). This
function simply allows you to select the microphone for acoustical
measurements, or the probe as the input source to the analyzer for making
electrical measurements. If the probe is used, AC volts can be measured, or
dBm or dB volts. When making dBm or dB volts measurements, the resolution
is .1dB.

AVERAGE

"AVERAGE" is the last function we will discuss, and it is a somewhat
specialized, but very useful function. Basically, it allows you to average a
number of screens of information together and display that average, enter it into
a memory, or print it. Screens of information can be added to the accumulator
for averaging one at a time, or in groups. This is how it works. To enter the
"Averaging" mode, press AVERAGE. The PC-40 Message Window will
indicate that the "Averaging" function has been activated, and the letters "R,"
"S," and "M" will appear in the window as well. (If you press HELP at this point,
the menu will provide the same explanation we are about to undertake.)
Pressing R will reset the accumulators to zero and will ready the PC-40 to
begin a new measurement. |f you wish to take screen "snapshots" one at a
time, push S for "Single Samples." You may now take a "snapshot" by pressing
the A (for "Average) key which will freeze a screen of information. You can then
choose to enter this "snapshot" into the accumulators for averaging, or not enter
it if you don't like it for some reason. To enter it into the accumulators, hit
Return and it will be entered. If you don't want to enter the screen for
averaging, hit any other key. This will erase the screen, and return the PC-40 to
a real time display. When you are ready to take another "snapshot," press the A
key again. This will freeze the screen as before. If you enter this screen into the
accumulator, the number 01 will appear in the Message Window to let you know
you have one screen entered. You can continue to enter single screens in this
manner to average as many as you wish (up to 9999 samples). You may view
the average of the screens you have taken at any time by pushing V for "View."
Push V again to get back to the "Averaging" mode.

If you want to take continuous samples at a rate of about 8 to 10 screens per
second , enter the "Average" function by pressing AVERAGE and then M for
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"multiple." (If you are already in the "Average" mode taking single frames of
information, you will still need to push AVERAGE and then M to change to the
multiple frames mode of the "Average" function. Furthermore, if frames of
information are in the accumulators, they will still be there until you press R to
reset the system and clear the accumulators.) If you want your new data to be
averaged with data already in the accumulators, it will not be necessary to clear
them before you begin new measurements. The new data will be automatically
averaged with the existing data in the accumulators.

The sample rate of 8 to 10 screens per second is a maximum; fewer samples
per second may be selected by using the "Rate" function, but if you select a
higher sample rate than 8 to 10, the "Average" function will still take only 8 to 10
samples per second.

In the multiple frame mode of the "Average” function, sample taking starts and
stops with the press of the A key. In this mode, when samples are not being
taken, the display of the PC-40 is a real time display. When samples are being
taken, what is being displayed is the average which is constantly being updated
as new screens are added. Again, the display is not real time, but is a
displayed average of data taken. This means, for example, that if you fed pink
noise into the PC-40, and began to take samples in the multiple screen mode of
the "Averaging" function, the display would move around quite a bit as you
began because of the random nature of pink noise. However, with continuous
samples being taken and averaged, the screen would settle down in time to
where it didn't move at all since pink noise, averaged over a sufficiently long
time, is very flat.

Of course, if you want to view accumulated average without having to take more
samples at the same time, you can stop taking samples (which returns the PC-
40 display to a real time display) and press V to view your average. As you can
see, "Average" provides some very interesting possibilities. In doing STC, or
NIC measurements, for example, average readings are required. In entirely
different applications, such as equalization, using both a microphone
multiplexer and the PC-40 averaging capability would give you results that are
both time and spacially averaged.

We have now completed a cursory examination of many of the PC-40 functions.
We can now move on to a more in depth look at the PC-40 Utility Functions.
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Using the PC-40

The Utilities Functions in Depth

The purpose of this section of the PC-40 manual is to explore more of the power
and capabilities of the functions found in the Utilities Menu. Some of the
functions such as "Rate,"” or "Ti é" need no further explanation. However, some
of the functions, "Offset," for example, deserve substantial discussion. In this
section of the manual, we will cover only those items in the Utilities Menu which
deserve further treatment.

Save and Load

The first Utilities Menu item, "Save," which allows you to save data to some
external storage device - such as a disk, operates very much like the storage
function on any other computer. You may choose what items or blocks of
information you wish to save - a single memory, a block of 20 memories, or an
entire block of information from the record buffer. Data in the record buffer is
stored in the form of complete screens of information, and is accumulated into
buffer by use of the "Record" function. When selecting a single memory for
saving, the first 10 memories are selected by using keyboard keys 0-9 (0 being
memory 10), and memories 11 through 20 are selected by using the shift key in
ion with k - hi ing memory 20). All data is stored as data
files. These files may be saved to various storage devices called drives. The
computer utilities CP/M operating system and all files occur under CP/M.

After selecting the information you desire to save, you must select a location to
have it saved. It may be saved to Ram disk (Drive A), or floppy disk (recognized
by the system software as drive D, E, F, or G), or to a microcassette cartridge
(recognized by the system software as drive H). Complete instructions for
saving to the optional cassette drive are in the Epson manual which you should
have received with your PC-40. In the event you purchase an optional external
disk drive, a complete manual from Ivie will be shipped with it, including a
utilities disk. Between the Epson manual and the Ivie manual, you should have
all the information needed to both read and write to external disks.

After selecting the material to be saved, and the drive to be used, you must

name your file. The file name is speciﬁe‘défby a field of up to 8 alphanumeric
characters. The appropriate file name extension will be appended to the file by
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the computer. Only letters and numbers, not spaces, should be used for file
names. File name extensions used by the computer are: MEM for a single
memory, MBK for a block of 20 memories, and REC for the record buffer. The
PC-40 will prompt you through all of the above operations. Once you enter the
file name to be saved, pressing the Return key will initiate the saving process.
The exception to this occurs when you give you file a name that has already
been used. When this happens, the PC-40 will prompt to ask whether you want
to overwrite the file you have already saved. Pressing Y for "Yes" begins the
overwrite process, and pressing N for "No" aborts the saving process.

Once you have saved some data, the PC-40 will return to the beginning "Save"
prompt - it assumes you will want to save something else while in the "Save"
mode. |f you want to save something else, follow the same steps as above, but
if you are through, hit the UTILITIES key to exit the "Save" mode.

The "Load" function works very much like the "Save" function. After selecting
the "Load" function from the Utilities menu, the PC-40 will prompt you, and you
must choose the drive from which you desire to load data. You must next
choose where you want the data loaded - into the record buffer, or into one or
more of the PC-40 twenty memory locations, for example. Again, the PC-40 will
prompt and require an answer. As in the "Save" function, selection of single
memories 11 through 20 are accomplished by using the shift key in conjunctign ;
with the number keys. 7¢ f(ras< Files wha AN Shie /5 7"‘"’“/
go Yo CP~ rea A wime. Ext  ptfore
Printer and Printing W\Q”)‘/

wi™
Selecting "Printer" from the Utilities Menu allows us to select a printer port, or
the optional cartridge printer. The cartridge printer prints in three size formats,
and we therefore must select the size to be printed.

Cables are available for external ﬁfjrinters. External printers print the same size
as the optional cartridge printer in the Large Printout format, but print faster.

whi rinter | i -
rint command. it will ff into Never- logking for
printer. To bring it out of this "lock up,” you will have to hold down the Ctrl key
and hit the red Quit button. You may even have to take a pointed object (pen or
pencil) and press the recessed reset button on the right side of the computer.
This action may or may not cost you the screen you wanted to print, so treat your
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PC-40 with kindly printing commands, and it will respond with affection.

If wan abort printing that is in progress. holding down the Ctrl key and
ittin r uit n_will mplish this.

Offset

Offset is a very powerful and flexible function. It may appear to be confusing at
first glance, but it is really very easy to use. Conceptually, we can look at
"Offset" as an internal memory location to which real-time data is compared and
then displayed. Earlier in the manual, we used the example of a preferred
house curve being stored in the "Offset" memory. We would equalize the PC-40
display "flat" - visually easy to do - and once done would have equalized to our
preferred house curve. The Offset mode works in 1,2,0r 3dB per step resolution.

To perform an "Offset" function, we need three things: First a way to get into and
out of the "Offset" mode, second a way to create the curves or data that we want
to put into the "Offset” memory location, and last a way to get that data into the
"Offset" memory.

Let's take them one at a time. Firstly, you don't need to use the Utilities Menu at
all to put the PC-40 into the Offset mode, or to get it out. All you need is the O
key on the keyboard. Hitting O (for "Offset") will toggle the PC-40 into or out of
the Offset mode. It is easy to tell if you are in the Offset mode, because the
letters OFF will appear on the Offset mode. Notice the illustration below:

The PC-40 is

in "Offset”
B OFF ———
- HH -t -1q 80
s [ I 123 3
TR 1'% 7 o
- AHHHBEHHA N ot -36
Tt ittt = FFT
AR RN E RN NN eI NeSPL 75.4

Figure XXI
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When the PC-40 is in the Offset mode, it is comparing real-time data to the data
in its Offset memory and displaying the difference, between the Offset memory
and real-time - that's why it is called the Offset mode. However, there may or
may not be any data in the Offset memory. If there is not a curve there to make a
comparison to, switching the PC-40 into Offset will not change the display at all.
Next, then, let's explore how to create the data your want to put into the Offset
memory, and how to get it into the Offset memory.

To create a curve for Offset use, and to get that curve into the Offset memory, we
select the function "Offset" from the Utilities Menu. When we have done this, we
should get a display that looks like Figure XXIl below. If it does not look like this,
hold down the Ctrl button and press R. This will reset the display.

J S
25
0.0
-18
-36

Figure XXII

This curve can be manipulated using the cursor keys of the PC-40. The left and
right arrows select a frequency band, and the up and down arrows change
amplitude. In our illustration above, the Message Window tells us that we have
selected the 25Hz channel, and that the amplitude at this channel is at 0.0dB
relative to the reference line - in other words, it is right on the reference line. If
we press the down cursor arrow, the 25Hz channel will drop in 1dB increments,
and the Message Window will tell us how far below the reference we have
dropped (We could go above the reference, too, by using the up cursor arrow).
f we want finer resolution. holdin wn the Shi n whil ing th rsor

will move us in .1dB increments.

After we have adjusted the 25Hz channel to our satisfaction, we use the right
cursor arrow to move to the next channel, and then we adjust it - and so on, and
continuing through all the channels until we have the curve we desire. The
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Message window will always tell us what channel we are working on, and how
many dB above or below the reference we are.

Let's suppose that we have followed the above procedure, and have created
the curve below:

| I
20000
-16.5
-18
-36

Figure XXIlI

We have now created a curve that we may wish to place in the Offset memory,
and/or we may wish to store it in one of the 20 memories of the PC-40 for later
use, or we may want to entirely discard it because we've decided we don't like
it. We can easily do any of these things. Here is how we do it.

To store the curve for future use, simply hit the STORE button and store it the
way you would any other memory - complete with annotation if you desire. The
Reference Level of this stored curve will be the Reference Level the PC-40
showed before you entered the Offset mode. After completing the annotation,
hit Return to exit the "Store” mode. The curve has now been stored into
memory, but not into the Offset memory.

To place the curve into the Offset memory, hit Return. When in the Utilities
function "Offset." hitting Return will place the curve on screen into the Offset

memory. If there is already another curve in Offset memory, it will be
overwritten,

If you want to both store the curve in memory, and place it into Offset memory,
first store it into one of the 20 memories as outlined above. After it is stored, it
will still be on screen, and you may then hit the Return button to place it into
Offset memory as well.

If you want to discard the curve you have created, simply hit the Utilities
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button. This will place you back into the Utilities menu and your curve will be
gone. If you would rather stay in the Offset function and create a new curve,
follow this procedure: Instead of hitting the Utilities button to exit the program,
hold down the Ctrl button and hit R for "Reset." This will discard your old curve,

and initialize your screen as shown in Figure XXII. This is especially useful if
wan r veral curves and hem into the PC-40 memories for
r imply cr rv re it in 3 mem hit Ctri/R fo r
and create your next curve to be stored.

One thing that should be noted here is that in addition to discarding the curve
you may be working on, hitting Ctrl/R also clears the Offset memory. If you
have had a curve in the Offset memory, and have gone back into the Offset
function to create additional curves, and have hit Ctrl/R in the process, you no
longer have a curve in the Offset memory. You will have to put in back in again,
if you desire to use it.

The last thing we need to examine is how to get a curve from one of the PC-40's
twenty memories into the Offset memory. It is very simple. First enter the Offset
function via the Utilities menu. The "flat" curve shown in Figure XXII will appear.
Next, hit RECALL, followed by the number of the memory you wish to recall.
The memory will appear on screen. Hit RECALL again to get out of the Recall
mode. The memory curve will still be on screen. You may now hit Return to
put the curve into Offset memory.

*Important Feature*

The Offset function can be used to closely examine any curve you may have in
memory, not just curves you have created. For example, if we want to take a
very close look at a response curve that we have earlier placed in one of the
PC-40 memories, we can select the Offset function from the Utilities menu and
recall our memory as described above. We hit RECALL again to get us out of
the Recall mode, and our memory still stays on screen as though we were going
to put it into the Offset memory. Instead of putting it into Offset memory, we can
use the left and right cursor arrows to scroll through the channels. The
Window will print the channel sel nd the ampli in_th
channel to a resolution of .1dB.

As can be seen, the Offset function presents some very interesting possibilities.
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Mic/Probe

The Mic/Probe Utility is a fairly self-explanatory function, but a few items should
be noted. It is important, or example, to have the probe selected for making
electrical measurements, and the microphone selected for making acoustic
measurements. If you try to make acoustic measurements and have selected
dBm, dbV, or AC V from the menu, the PC-40 will be looking at the electrical
input for signal (the BNC connector on the PC-40), not the microphone input.
What you will see displayed in this situation will be cross-talk between the two
inputs, and it will look like nothing you are trying to measure. The closest thing
it will resemble is white noise. If you are getting strange readings that don't
seem to make sense, it's a good idea to check the Mic/Probe Utility to make
sure you have the proper input selected.

The second thing you need to be aware of is that the reference level settings
are different when using the microphone as opposed to using the probe. The
mic reference level ranges from 30dB to 140dB in 10dB increments. This
110dB range represents from 30dB of attenuation to 80dB of gain.

For electrical measurements, the reference level ranges from 50dB to 180dB.
The same preamp is used - a range of 30dB of attenuation to 80dB of gain, but
a probe pad of either 20dB or 40dB is automatically inserted. The 20dB pad is
inserted on the low end; hence we can get down to 50dB instead of 30dB as in
acoustic measurements. At the high end, the 40dB pad is inserted so we can
get up to 180dB, instead of just 140dB. On previous lvie instruments, the
20/40dB pad was on the probe itself, and one had to mentally correct
measurements. The PC-40 has the pad internally so the reading you see is the
reading you have.

The reason for the pad in the first place is to more closely match the
measurement capability to the range of signals which are normally measured.

The probe itself has a 1MQ input impedance and is rated for up to 600VDC
(includes peak AC).
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Sound Level Testing

Introduction

The decibel (dB) scale has been adopted internationally for use with sound
level meter testing. The scale begins at a reference of 0 dB in sound pressure
level (0 dB SPL) which corresponds to the smallest sound that can be heard by

a healthy human ear, and is equal to 2uN/m2, or perhaps more commonly,
20uPa. Following is a chart which shows some various sound pressure levels
(SPL's) relative to typical environmental sounds:

Noise Level (in Decibels)

Threshold of Pain 140 =
130 |
120=1 Small Aircraft Engine
110 =—

Jackhammer 100

90—

80— Automobile Horn

Average Conversation 70 =
GIES

S0—

40= Quiet Office

Yery Soft Whisper 30 -
20—

10— outdoors in the Country
Threshold of Hearing 0-—

Figure XXIV

When studying sound level measurements, it is of major importance to
understand the response characteristics of the human ear. Our ears do not
respond equally to all the frequencies of the audio spectrum - in other words,
they are not "flat" in their response. To further complicate matters, the response
characteristics of human ears change with different SPL's. At relatively quiet
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Relative Level in dB

SPL's, our ears attenuate high frequency sounds to some degree, and
drastically attenuate low frequency sounds. As SPL's increase, our ears get
more efficient at low frequencies and their response to sound becomes more
"flat," although they never achieve a totally "flat" response. Following is a set of
curves which approximate the hearing response of human ears. The "A" curve
shows how ears hear, or perceive sound at low SPL's, while the "C" curve
shows how we hear at relatively high SPL's.

0 L~ c L~ ﬁ, E n
// // ™
~10 2 \
A
20 ’ /
Y/
/
~30 7
- 40
-50

20 50 100 200 1K 2K oK 10K 20K
Frequency in Hz
Figure XXV
These curves have been integrated into sound level meters for testing sound
levels. "A" weighted (dBA) measurements use the "A" curve above, "C"
weighted (dBC) use the "C" curve above, and "Flat" (dB SPL) measurements

use no weighting at all.

Noise which causes hearing damage has been found to correlate most closely
with the "A" curve. Consequently, OSHA requirements, and many other
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government regulations are generally specified in dBA. The Walsh-Healey
Public Contracts Act, for example, specifies the following permissible human
exposure levels for industrial noise. Notice that all duration levels are specified
in dBA.

Permissible Noise Exposures

Hours Duration dBA SPL
Per Day Slow Response

S0
92
95
97
100
102
105
110
115

N WA OO

A . :
g — U

Figure XXVI

In addition to being concerned about the weighting we use when we make SPL
measurements, we need also to be aware of the measurement environment.
Sound environments can range from near-field to free-field to diffuse-field. A
free-field environment is one that is free of reflections, and is typical of anechoic
chambers (sound absorbing rooms) that have acoustically padded walls, floors,
and ceilings.

Diffuse (reverberant) fields are often encountered and are purposely created by
reverberation chambers that have been designed to cause as much reflection
between ceilings, walls, and floors as possible. A diffuse-field is one in which
the sound is uniformly distributed throughout the room. Machine noise tests are
more often made in reverberant chambers, as they are less costly to build than
anechoic chambers.

Typical sound measurements environments, however, are usually some
combination of free-fields and diffuse fields, and great care must be taken with
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the measurements to help assure that accurate results are obtained. Errors can
occur when determining the noise from a single source if tests are made too
close (near-field) to the source being measured (See Figure XXVII below). The
near-field SPL can change dramatically with small position changes of the
sound level meter. To avoid near-field errors, the sound level meter should be
located away from the source by at least a distance equal to one wavelength of
he lowest fr ncy radi from th r r more than twice the distan

of the largest dimension of the source, whichever distance is greater.

Near Field Free Field Reflections
(Erraors) |  Accurate I {(Errors)
2 I Results I
-
o s
w 25 | |
im]
e |
| |
|
Source ! .
| |
Distance 3
Figure XXVII

As can be seen from the above illustration, errors can occur not only when we
are too close to the source, but also when we get too far from the source being
measured, room reflections and other room noises may interfere with our
readings. The most desirable condition for noise testing would be to perform all
tests in a reverberant chamber (diffuse-field) or an anechoic chamber (free-
field). Since this is usually not possible, the next best alternative is to find a
free-field as close to the object being tested as possible. It is easy to identify a
free-field because the inverse square law holds true there. The inverse square
law describes the relationship between sound pressure level and distance in a
free-field. When the distance from the sound source doubles, the SPL will drop
by 6 dB. If the distance is doubled again, the SPL will drop by another 6 dB. If
this relationship occurs, the sound waves are traveling unobstructed from the
source to you, and by definition, you are standing in a free-field.
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Free Field vs. Random Response or Pressure Response
Microphones

Both free field microphones and random response microphones are used to
measure SPL. In Europe and other areas where IEC standards are required, a
free field microphone is required. A free field microphone is intended to be
used in a free field environment, and should be pointed directly at the sound
source as shown below.

D))

Using a Free Field Microphone in a Free Field Environment

Figure XXVIll

In the United States and other areas where ANSI specifications are followed, a
random response microphone is normally used on a sound level meter. A
random response microphone is intended to be used in a diffuse or reverberant
field. However, in free field use, a random response microphone can be used
to approximate the response of a free field microphone by positioning the
microphone at an angle of 70 to 80 degrees to the sound source, as shown on
the following page:
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70° to 80°

Using a Random Response Microphone in a Free Field Environment

Figure XXIX

Body Effects on Sound Measurements

Something that must be considered when making sound measurements with a
hand-held analyzer, is the effect of the operator's body on readings. The
operator's body may detract substantially from the accuracy of the
measurements. At frequencies near 400 hz, sound reflecting from the body
could cause up to 6 dB or error, if measurements are made within three feet of
the operator. To minimize this effect, the PC-40 should be positioned as far
away from the body as possible. It would also be appropriate to use a
microphone extension cable in those instances when it is deemed necessary.

Correcting for Background Noise
Often the need arises to make SPL measurements in the presence of
background noise. This can be easily done as long as the SPL of the primary
source is at least 3 dB greater than the background noise. Following are the
steps for making such a measurement.

1. Measure the total noise. (Background and primary source)

2. Turn off the primary noise source and measure the background noise only.
Both tests should be made with the microphone in the same location.
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3. Calculate the difference between the two readings measured. If the
difference is less than 3 dB, accurate measurements cannot be made. If the
difference is greater than 10dB, no correction is necessary. If the difference is
between 3 dB and 10 dB, the following chart can be used to make the needed
correction.

\
\
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i

dB Carrection
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1 2 3 4 5 6 7 8 9 10

Noise Difference in dB

Figure XXX

To use the chart, located the difference of the two measurements on the
horizontal axis. From that point, go up to intersect the curve, and then left to the
vertical axis. Then subtract the value on the vertical axis from the total noise
level first measured.

Example: Total noise = 75 dB. Background noise = 72 dB. Difference = 3 dB.
Chart correction = 3 dB. Primary source noise = 75 dB - 3dB = 72 dB.

There is something very interesting about this example. Notice that the
background noise SPL is the same as the source noise SPL, yet when we add
those equal noise levels together, the increase is only 3 dB. (72 dB of
background noise plus 72 dB of primary source noise equals 75 dB total) 3 dB
is only a slight change in the level of "loudness” perceived by the human ear.

This same ratio applies to amplifier power when fed to a speaker. If we double
the power (watts) going to a speaker, the change in sound level is only 3 dB, a
barely audible change. This gets to be pretty important if we have a huge
system using 10,000 watts of power and we decide we want it just a little louder
- amere 3dB. All we have to do to accomplish this is add another 10,000 watts!
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Adding Sound Levels

Since we have just discussed an illustration of adding sound levels together,
let's explore the subject further. If two primary sources are measured
independently, it is possible to determine what the sound level would be if both
sources were operating together. The following chart can be used to determine
this, when both tests are made with the PC-40 in the same location.
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Figure XXXI

To use the chart, first measure the levels of the two sources independently and
then find the difference between the two levels. Locate the difference on the
bottom of the chart. Go up until the curve is intersected, and then go left to the
vertical axis. Then add the correction in dB indicated by the vertical axis to the
value of the highest reading made. This number indicates the combined SPL of
the two sources.

In the example shown above, Source 1 equals 79 dB, and Source 2 equals 69
dB. The difference is 10 dB. Chart correction is .5 dB, so the total noise is 79.5
dB.
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System Calibration for OSHA Measurements

OSHA measurements generally require equipment that meets minimum
specification standards - at least an ANSI Type |I sound level meter, for
example. (The PC-40 is a Type | Sound Level Meter, and therefore exceeds
OSHA minimum requirements). In addition to the equipment meeting minimum
specification standards, it must also be properly calibrated in order for an
acceptable OSHA measurement to be made.

What this normally requires is calibration prior to the measurement, and then a
recheck of calibration after the measurement is made. In the case of SPL
measurements, a calibration device (either a pistonphone or an acoustic
calibrator) must be used. The standard PC-40 microphone is a 1/2 inch, air
condenser microphone. It's size and thread specifications are the same as
other internationally recognized 1/2 inch microphones. Any quality calibration
device will work, if it is used properly. Most calibrators are made to
accommodate a 1 inch microphone, and they have an insert to adapt them to
1/2 inch microphones. Use the 1/2 inch adapter and make sure the
microphone fits snugly inside the insert.

To calibrate for OSHA measurements, fit the calibrator on to the PC-40
microphone and turn on both the calibrator and the PC-40. Following the
directions that come with the calibrator, calibrate the PC-40 to the proper SPL.
The PC-40 calibration potentiometer is found in the IE-2P microphone
preamplifier. It is recessed inside the IE-2P tube, as shown below, and has to
be accessed with a small screw driver.

—_
oo
\ Calibration Pot

Figure XXXIi
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Pink Noise Testing with the PC-40

Introduction - Pink Noise Theory

When is pink noise flat? Never!

There are a few fundamentals that should be understood before doing pink
noise testing. Pink noise is random noise that appears flat only after being
averaged over time by special detectors on a real-time analyzer, or a true rms
voltmeter. On an oscilloscope, or a standard voltmeter, pink noise appears to
be a mass of random voltage spikes - which is exactly what it is. However,
when averaged over time, the noise appears very flat and the output rms
voltage is highly stable. When measuring with pink noise and the PC-40, the
detectors in the PC-40 should always be in the pink noise averaging mode
(slow).

We are often asked, "How flat is your noise generator?" That can be a
misleading question, because noise is never flat. As we have said, noise is
random in nature, and can be made to "appear” flat only when averaged over a
sufficiently long period of time. Noise is a statistical phenomenon, and the
averaging time necessary to create a "flat" appearance is mathematically
predictable. Far better questions to ask are , "How flat are the filters in your
noise generator?” and "What is the averaging time of the detectors in your real-
time analyzer?"

To create pink noise, a noise generator first generates white noise. Our white
noise generation is accomplished by a statistically accurate, shift register
technique. Since white noise is equal energy per frequency, the energy
content doubles each time you step up an octave. Such a signal is therefore
too "hot" at high frequencies to be used as a sound system test signal. Pink
noise, or equal energy per octave, is a much better test signal. To produce pink
noise from white noise, we run the white noise through a 3dB per octave roll-off
filter. The accuracy, or "flatness" of this filter determines the "flatness" of the pink
noise produces. The filters in our noise generators are six pole filters and are
very flat, which results in a very flat time-averaged output. The detectors in the
PC-40 (the pink noise, or "slow" detectors) are designed to allow a maximum,
+1dB flutter when the analyzer is in the 1dB/step mode. Furthermore, this mild
flutter occurs only at the lower frequencies. Since each 1/3 octave bandwidth
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contains exactly twice as many discrete frequencies as the adjacent 1/3
bandwidth below it, as we increase in frequency, we increase in statistical
stability. This means that as we continue to climb in frequency, we need shorter
and shorter averaging times to achieve statistical stability. The PC-40 does, in
fact, have shorter averaging times for the detectors at the higher frequency
bandwidths. Even with these shorter averaging times, the higher frequency
bandwidths are slightly more statistically stable than the lower frequency
bandwidths.

You can create statistical instability in your measurement by changing the PC-
40 detector response from "slow" to "medium" or even "fast." You will notice
increased random movement of the display, especially at the lower frequencies.
In the "fast" mode, it is virtually impossible to obtain a reasonable pink noise
reading at low frequencies. It can easily be seen that making pink noise "flat" is
as much a function of a good spectrum analyzer and its chosen integration time,
as it is a function of a good noise generator.

What is Crest Factor?

An important aspect of a noise generator is its crest factor. The output of Ivie
noise generators is calibrated in volts rms, and crest factor is the ratio of the
peak voltage to the rms voltage. If a noise generator had a crest factor of 2, we
could expect instantaneous voltage peaks, or spikes (either positive or
negative) to reach an amplitude twice our rms output voltage. In other words,
an rms voltage output of 1 volt could see peaks as high as 2 volts.

The purpose of pink noise is to provide a reference signal that approximates
program material as closely as possible. If the crest factor is too low, we provide
a signal with little dynamic range, which will not give us a very clear picture of
how our sound system may perform with program material having normal
dynamics. [f our crest factor is to high, on the other hand, we will provide a
signal with such a broad dynamic range that we could be causing clipping.
Experimentation has shown that a crest factor of from 3.5 to 4.0 seems to work
best and most closely approximate normal program material dynamics. lvie
noise generators have a crest factor of 3.75.

In conclusion, pink noise approximates actual audio signal better than any other

type of signal source. It is also one of the best signal sources available for
doing rigorous testing of amplifier durability, and transient signal handling
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capabilities. Pink noise is used in conjunction with a real-time analyzer more
widely than any other signal source. Some analyzers have pink noise
generators built into them. Ivie has chosen to keep its noise generators
separate from its analyzers, even though it is more expensive to do so, because
experience has shown that the location where we want to inject pink noise into
a system is rarely the same location where we want to have our analyzer.
Additionally, having the noise generator in the same box with the analyzer
generates the temptation to match one to the other, by "tweaking" the analyzer
filters to match the pink noise output. Some manufacturers do in fact do this,
which makes the analyzer incompatible with another pink noise source. At lvie,
we believe it is better to have both instruments independently flat, and so that is
the approach we use. Any lvie noise generator will work with any Ivie analyzer.

The last thing we wish to say about pink noise is that it cannot be used for
gating or pulsing techniques. The random nature of pink noise (which is, in fact,
its greatest asset) prevents it from being spectrally complete or repeatable in
short bursts. Consistent results cannot be produced.

Room Response Testing

Pink noise is often used in conjunction with a real time analyzer for testing room
response and for equalizing sound systems. Preferred equalization curve
requirements differ according to the intended use of the sound system and its
environment, and there are many opinions as to what those curves should look
like. It is not the intent of lvie to recommend one equalization curve or process
over another, but to provide equipment with sufficient flexibility to allow the user
to make his own choices.

There are, however, some useful techniques that are quite universal in
application. These involve such things as system documentation, electrical
testing and trouble-shooting, and measurement of acoustical performance.
Some of these techniques are explored in the next section of this manual
entitled "Electrical Testing and System Documentation Using Pink Noise."
Acoustical testing is touched upon as well, but there is much that is left
unexplored. There are many aspects of these techniques about which much
has been written and argued - whether to use one microphone, or several;
whether to do only time averaging, or do spacial averaging as well - this list
goes on and on. The reader is encouraged to study and learn as much about
all of these approaches as he can, and to make his own determination as to the
techniques he prefers. The PC-40 will accommodate them.
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Electrical Testing and System Documentation Using Pink
Noise

One of the most useful aspects of the PC-40 Audio Spectrum Analyzer and the
IE-20B Pink Noise Generator is their ability to be used in tandem to perform a
great variety of of useful electrical measurements. These measurements can
not only verify system specifications, but, when properly documented, can also
save literally hours in trouble shooting.

The first step in making electrical measurements is calibrating the analyzer to
the pink noise generator to establish a reference. The following illustration
demonstrates this:

Figure XXXIil

In this example, the pink noise level has been set such that the amplitude of the
display reaches a reference line. With the analyzer set to measure dB volts, an
exact signal level can be read directly to a resolution of .1dB. We now have a
reference spectral content, amplitude within each 1/3 octave band, and the
absolute level of the input signal.
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If we now insert an audio device into the circuit between the pink noise
generator and the analyzer, we can measure all kinds of parameters. Let's

take insertion loss as an example. We insert the device to be tested as shown
below:

Insertion 1oss may be different in
different frequency bands as shown.

Device Under & e FC-20
Test

I ]

Figure XXXIV

In this measurement we can see the frequency selective nature of insertion loss.
We can also measure, in dB, the exact drop in total signal level.

If our device under test were an amplifier, we could measure its 1/3 octave
frequency response, and its voltage gain. If the device under test were a
crossover, we could measure its gain or loss, see the frequency response of
each leg, view the crossover point, and verify the roll-off associated with the
band pass filters. We could measure the gain structure and frequency response
of a single filter, or a whole bank of filters such as found in an equalizer.

Let's consider another interesting measurement. We can set it up feeding pink
noise into the front end of our sound system. Using the PC-40 probe, we can
tap into the output of our amplifier (the amplifier should be loaded) and look at
the spectral display of information coming from the amplifier. Setup would be
as shown on the following page:
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Figure XXXV

Notice that the output from the amplifier has been adjusted with both low and
high end rolloff - not unlike we would expect to see. Other than that, the

response looks very flat.

Next, for fun, we can look at the acoustic output of the speaker being fed by the
amplifier to compare its spectral output with its electrical input. This time,
instead of using the PC-40 probe, we plug in the microphone and listen to the
speaker without changing our input signal. Any differences in spectral
information will reflect the performance of the speaker in its environment.
Incidentally, research has shown that the anechoic response of a speaker can
quite accurately predict its response in an ordinary room. If we have a plot of
the anechoic response, we would expect the response in our room to correlate.

At any rate, our test setup would change as shown on the following page:
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Figure XXXVI

Obviously, we would expect to see some differences in response, as this
illustration shows.

The power of this simple measurement process should become somewhat
evident. By adding simple variations to the above setups, the parameters we
can measure or verify are extensive. Let's consider the value of this approach
in trouble shooting.

We are called back to a system which is not properly operating. It's a fairly
simple system - a four input automatic mixer with an aux channel for music, a
1/3 octave equalizer, a two-way crossover, two one hundred watt amps for bass,
and three fifty watt amps driving the high end.

We bring our set of documentation for this job, and we plug our pink noise
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generator into the music channel of the mixer. Our documentation shows the
following:

1. The input level at which we should set our pink noise.

2. The settings on the mixer

3. The output level and a plot of the spectral response of the mixer (which

is also the input information for the equalizer).

The output level of the equalizer and a spectral plot of its output.

5. The output level of each of the legs of the crossover, and a spectral plot

of each one showing crossover point and filter skirts.

The input level, gain, and output spectral plot for each ampilifier.

7. A map of the listening area for the system with several points located.
For each point, there is a spectral plot and dB SPL referenced.

B

o

It is now a quick and simple matter to step through each component of the
system with the analyzer and a probe. Any defective component or change in
setting can be quickly detected. Setting changes can be speedily corrected. If
everything checks out electrically, measurements at the documented points in
the listening area can identify speaker problems. Since we know what the
output and spectral content of each amplifier is, we can verify that information at
the input of a speaker to make certain we have no wiring problems.

Obviously, we have not covered every sound system parameter, but it can be

easily seen that spending a little time in system documentation can save a lot of
time in trouble shooting and correcting system problems.
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The PC-40 Memory Functions
The 3dB/Step "Invalid Data Line"

As discussed earlier in this manual, (under the section entitled "The PC-40
Display Screen") when displaying data on screen in the 3dB/step mode, the
display of the PC-40 actually shows a dynamic range greater than the filter
dynamic range. In simple terms, this means that before a signal could drop off
the bottom of the display screen, it may run into the noise of the filters
themselves. Thus, noise at the bottom of the PC-40 screen in the 3dB/step
mode may or may not be valid data.

To help solve this problem, a line appears across the display screen, near the
bottom, when in the 3dB/step mode. This line is called the "Invalid Data Line,"
and is shown in the following illustration:

—
--------------------- 80
'?-T_E TIEVEVEE G -18 1§3 g
o S0 F T
Z SPL 75.4
Invalid Data Line

Figure XXXVII

Notice that in the above example, there are two low frequency filters and two
high frequency filters that display data below the Invalid Data Line. In practice,
we understand that this information may not be valid. An interesting question
arises when we consider what might happen if we stored the above display into
memory, recalled it, and then began to manipulate the data. If we changed the
Reference Level, for example, and moved the data up on the screen, these four
low filters would rise above the Invalid Data Line and would appear to be valid
data.

The same thing might be asked of another display which had filter noise
hanging just below the level of the display screen, so it would not be displayed.
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If we stored that display, recalled it, and then began to lower the Reference
Level, we could bring this noise up on screen and mistake it for real data.

To solve this potential problem, any data below the Invalid Data Line is not
entered into memory during the STORE function. Let's look at the preceding
example, for instance. Looking at the display tells us that several memories
have been used. However, memory #8 is vacant, so let's store the display in
memory #8. If we then RECALL memory #8, the following display would
appear:

L 1
5o | RCALL
123 5
8 25 0
_36
7 FOFT
SPL 75.4

Figure XXXVIII

Notice that the four filters which were below the Invalid Data Line have
disappeared. Questionable data has not been saved. Even if we change the
Reference Line to raise the data up on the screen, no data will appear under the
four filters in question, as shown by the following illlustration:

Figure XXXIX
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This safeguard protects against the possibiltiy that invalid data could be raised
up on the screen, or brought to the screen through manipulation of data in
memory. In this manner, measurement integrity is assured. Any data that is
display from a memory function will be good data.

Recalling and Displaying More Than One Memory

You have already learned that the PC-40 can recall and display any one of its
twenty memories. It also has the ability to recall and display 1 or 2 memories
simultaneously, or recall and display more than 2 memories simultaneoulsy.
When displaying 2 memories, each is clearly differentiated from the other.
When displaying several memories at once, one is not differentiated from the
others and the display is intended to show an envelope only.

Let's examine this in further detail. First, let's look at displaying 2 memories.
We begin by hitting the RECALL button just as if we were going to recall a
single memory. The display would then look like this:

I
RIS T 0 T T O (P
T 123 5
TITITITITITITITITITTTTTITITIUIR 78 0
R N -1 o B

Figure XL

Notice that the PC-40 Message Window reads RCALL, signifing that we are in
the Recall Function, and below RCALL, we find 0-9, C. This indicates our
function key options when in the Recall Function. Hitting one of the keys from 0
to 9 will allow us to recall a single memory. However, if we want to recall more
than one memory, we first hit C, which signifies "composite." When we hit C,
the Message Window of the PC-40 will change as shown on the following page:
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Figure XLI

Notice that the prompt "RCALL" in the message window has been replaced by
the prompt "RCOMP," signifing "Recall Composite." Below that, we see a +
symbol, and a o symbol. This means we can display one memory as plus signs,
and the other as boxes, to differentiate between the two. The arrow pointing at
the symbol tell us which symbol we have selected for display. In the above
illustration, we have selected the plus sign. If we wanted boxes instead, we
could use the curser arrow on the PC-40 keyboard to select boxes. The left and
right keyboard arrows can be used to change the direction of the pointer in the
message window.

Let's go through the steps to finish displaying two memories simultaneously.
The pointer in the above illustration has selected the plus sign for displaying the
first memory. Let's say we want to display memory number 1. Since we are
already in the RCOMP mode, the PC-40 is already to display our first memory.
We simply need to hit the key 1. Memory 1 will be displayed as shown below:

—

: : o RCOMP
T TTTTTTITTTTTTTIoToTTToToT1 80 [+1 ¢ @
it e T L ) 123 5
: - LT 78 0

F

——————————————————————————————— 36

SPL 754

Figure XLl
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Notice that the message window indicates we are displaying memory 1 as plus
signs.

Now, let's display memory 2 as boxes. We first hit the right cursor arrow on the
keyboard to get the pointer in the message window pointing at boxes. They we
hit 2 to recall memory 2. Our display will then look like this:

—
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Figure XLHI

Again, the message window tells us we have displayed - in this case, memory 2
as boxes. The first memory displayed on the PC-40 screen is clearly
differentiated from the second memory displayed. The SPL information showing
comes the last memory displayed, memory 2.

Notice also, in the above example, that both of the curves displayed have the
same amplitude at one of the filter frequencies. The plus sign and the box both
show up together, making it obvious that the values are equal.

In addition to being able to display two memories simultaneously, three or more
can be displayed to form and envelope display. To accomplish this, follow the
same keystrokes as discussed for displaying two memories:

1. Press RECALL to get into the Recall mode.

2. Press C to get into the Recall Composite mode.

Now comes the difference.

3. Hold down the Ctrl (Control) key and hit the number key for each memory
you wish to display. Each memory will be displayed as dashes ----, so one
memory cannot be differientiated from another. This display mode is for the
generation of an envelope display only.
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Important Note: To get out of the Recall Composite mode, hit RECALL. As
in most instances with the PC-40, you get out of a function using the same
button that was used to get into the function.

Very Important Note: Sometimes you may recall two memories that have
different Reference Levels. The first memory you recall will print the Reference
Level for that memory. The second memory you recall will be automatically
adjusted on the screen to be correct for the Reference Level already indicated
by the first memory. For example, you may have stored two memories that were
in about the same position on the PC-40 screen, but their Reference Levels
were 40dB apart. If you recalled both of these memories together, the second
memory may not even show up on screen because it is 40dB different in level
from the first memory. You could "find" the second memory by stepping the
Reference Level up or down, thus moving the second memory on screen and
the first memory off screen.

Subtracting One Memory from Another (The A-B Function)

In many circumstances, such as in STC and NIC measurements, it is
advantageous to be able to subtract on memory from another. This can be
useful in even more simple applications such as comparing before and after
equalization curves. Subtracting the before equalization curve from the after
equalization curve will provide a graphic display of exactly what boost or cut
had to be effected at each 1/3 octave channel to achieve the desired
equalization.

Performing the A-B Function is a simple operation. Follow the same format for
displaying two memories simultaneously. You may remember that in the
previous example, we had recalled two memories resulting in the display
shown on the following page:
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Figure XLIV

Once we reach the point of having two memories displayed, we must choose
which memory is "A" and which is "B." Keep in mind that this is an A-B function,
so "B" will always be subtracted from "A." We select the "A" memory with the
pointer in the message window. The pointer always points at the "A" memory.
In our example above, memory 2 is the "A" memory, so memory 1 is the "B"
memory. We can toggle the pointer back and forth between the two memories
to select our "A" memory by using the left and right cursor arrow keys on the PC-
40 keyboard.

Once we have selected our "A" memory, we perform the A-B function by a single
keystroke, the "minus” key on the PC-40 keyboard. (This key is on the top row
of keys, near the right-hand side, and has an "equals" symbol and a "minus"
symbol on its face).

If we follow this sequence for our example above, memory 1 will be subtracted
from memory 2, and the display on the following page will result:
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Figure XLV

The display format for the A-B function is slightly different from other display
formats for the PC-40. We show a center reference of zero dB, and 18dB above
and below that reference is indicated. |f our A and B curves were exactly
identical racting one from the other woul r iffer:

1/3 octave channel. This would be displayed as a flat curve, i mpli

reaching zero at every frequency.

Since any curve may be higher in amplitude at one frequency than another
curve, but lower in amplitude at another frequency, provision must be made to
indicate both positive and negative numbers when subtracting one curve from
the other. The A-B display format accomplishes this.

i I h PL displ in the A-B format is the differen W
the SPL's of the two curves.

Important Note #1: The A-B curve can be stored in a separate memory, if
you desire. The process is the same as with any other memory storage, simply
hit the STORE button and select one of the 20 memory locations.

Important Note #2: To get out of the A-B mode without storing the A-B curve,
use the same keystrokes in reverse order. Hitting the "minus” key again will
get us from the A-B display back to the two memory display. Hitting RECALL
again will get us out of the Recall mode back into a real-time display.

A - B Printouts

As you have already learned earlier in this manual, a "screen dump"” printout of
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the A-B curve can be executed by pressing PF5 while holding down the Ctrl
button. A tabular printout of the A-B information is also available. This is
executed by pressing P (for "print") while holding down the Ctrl key. For more
information on tabular printouts, refer to the Appendix Il of this manual entitled
"PC-40 Printing Options."

Averaging Memories Together

You should already be familiar with the PC-40's ability to average many
spectral samples together. The PC-40 can also average memories together, if
you wish. It is done in the following manner:

Step 1: From real-time operation, select the Average Mode by pressing the
AVERAGE button. Then press R to clear the accumulators. (Make sure there
is nothing in them you do not want to dump!) Then exit the Average Mode by
pressing the AVERAGE button again.

Step 2: Now enter the Recall Mode by pressing the RECALL button. Recall
any memory you wish to have averaged by selecting its number. Simply
recalling the memory will not enter it into the averaging accumulators, so you
may step through the memories, if you wish, to confirm the ones you want to
average.

Once you have selected a memory you wish to enter into the averaging
accumulators, you may enter it by pressing the AVERAGE button. Notice the
Message Window as you press the AVERAGE button. It will tell you that you
are in the Recall Mode, and will list the number of the memory you have
recalled. As you press the AVERAGE button, another number will appear
momentarily next to the memory number. This number indicates the number of
samples entered into the accumulators. The first time you press the AVERAGE
button, the number 1 will appear, the second time, the number 2, and so on.
Y hould note that you can enter a memory into the accumulators more than

once. If vou press the AVERAGE button twice while viewing the same
memory. it will be entered as a sample twice. If you wish to weight an average

by entering a sample several times, you may do so.

Step 3: After you have entered all the memory samples you wish to average
together, exit the Recall Mode by pressing the RECALL button. You may now
view the average of all the samples you have placed into the accumulators by
pressing the letter V for "View." This display can be printed, graphically, or as a
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tabular printout, the same as other displays. It can also be stored as a separate
memory. To discontinue viewing the average display, press the V key again to
return to real-time.

PC-40 BASIC Programming

The PC-40 has built-in BASIC, and therefore has the capability to be
programmed for a number of different applications. It is not the intent of Ivie to
teach programming, but we have created a number of machine language
subroutines, callable in BASIC, which perform various analyzer functions that
can be used as building blocks for assembling programs.

Information on these subroutines is available from the factory, and a complete
manual concerning them will become available from lvie at a nominal cost.
Should more subroutines become available in the future, they will be available
at no cost to those who have already purchased a manual.
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Appendix |
PC-40 Mechanical

It may sometimes be necessary to remove the computer from your PC-40. This
necessity will occur if you need to change the PC-40 ROM, or require a "hard"
reset of the computer, or desire to change one of the cartridge accessories
available for the PC-40 (printer, microcassette, modem, DMM, etc.) These
accessories are described in the PC-40 brochure.

Removing the computer is a simple matter. There is a Release Tab located on
the right side of the PC-40 as shown below. Lifting this tab releases the locking
catch to allow the computer to be slid off to the right.

Release Tab

Figure A

To remove the compuiter, lift the release tab, then get your fingers between the
computer and the dark brown PC-40 case, and slide the computer to the right as
shown in Figure B. New PC-40's are usually tight and removing the computer
the first few times will require firm pressure.
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Figure B

Once the computer is off, turn it over to expose the bottom. The slide, and
various compartments and switches are shown in Figure C below.

Cartridge Lock Memory Backup

Cartridge Out
Battery Holder

ROM and Reset Button Compartment

Figure C

The "Cartridge Lock" and "Cartridge Out" facilitate accessory cartridge removal
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or changing.

The "Memory Backup" switch should always be in the "on" position for PC-40
operation. The "off" position may be used for other computer functions. For
further details, refer to the HX-40 manual which you received with your PC-40.

The "Battery Compartment” is empty. The computer receives its power from the
PC-40 mainframe. If you wish to use the computer by itself, you may install

batteries, but, to avoid damage to the computer, they must be
i h - inframe.

A magnified view of the "ROM and Reset Button Compartment” is shown below.

ROM and Reset Button Compartment

———Reset Button

LARRIANRINNS

PC-40 ROM

Figure D

Of course, to gain access to either the "Battery Compartment or the "ROM and
Reset Button Compartment,” the slide will have to be removed. In the "ROM and
Reset Button Compartment” you will find the PC-40 ROM, the BASIC ROM, and
a "hard" reset button. Use of the "Reset Button" is detailed in Appendix IlI,
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entitled "Troubleshooting Your PC-40." We refer you to that section for
additional information.

The PC-40 ROM is easy to identify since it will always have a paper label on it
with its identifying version number hand written on the label. The ROM is in a
carrier which should be removed with it. Any new ROMs from lvie will be
supplied in a carrier for easy change out.

To change a ROM, carefully remove the old one in its carrier, and observing
proper polarity (the ROM carrier is keyed with different shaped tabs on each end
to help insure proper polarity), carefully insert the new one. The old one should
be placed in proper protective packaging and returned to lvie, since it can be
reprogrammed and used again.
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Appendix |l
PC-40 Printing Options

This short appendix is intended to familiarize you with the various printouts and
printing options of the PC-40. Many other references to printing and printing
instructions are found throughout the PC-40 manual. The information here may
serve as a reference, and additional background will be provided here which is
not found elsewhere in the manual.

Printer Ports

Printing can be assigned to three ports on the PC-40. The ports are the parallel
port, the RS232 port (these ports are labeled and are located on the top edge of
the PC-40 computer), and the cartridge printer port. The H409A Cartridge
Printer is the only cartridge printer that can be used with the PC-40, and must be
plugged into the cartridge slot on the PC-40 computer. Instructions for putting
cartridges into the PC-40 are contained in Appendix |.

Printer ports are selected through use of the UTILITIES menu, PRINTER section,
as described in the PC-40 manual. As noted there, it is very important not to
send a printing command to a port where no printer is connected. This locks up
the system.

Three printout sizes are available for graphic printouts when using the H409A
Cartridge Printer. These are labeled in the PRINTER menu as Cartridge Tiny,
Cartridge Small, and Cartridge Large. You may select the size printout that best
suits your needs. Obviously, the Cartridge Tiny format prints out much faster
than the Cartridge Large format.

It should be noted that there is no special printer driver software resident in the
-40 for formating prin n he RS232 or th rallel ._Prin

m will h me Siz figuration h ri Lar
printouts coming from the H409A Cartridge Printer. The one exception to this is
when using the PC-40 to PC software package which links the PC-40 to an MS
DOS computer. Printer driver software is resident within that system and
printouts are formatted a little differently, with both a graphic and a tabular
printout being provided.
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Graphic vs. Tabular Printouts

Graphic and tabular printouts contain exactly the same information, when
dumped from a PC-40, but each has its strong and its weak points. Graphic
printouts provide a great overall view of what is happening spectrally, but
precise amplitudes within each channel are difficult to determine visually.
Tabular printouts, on the other hand, give very precise amplitude readings in
each channel (to 1/10dB resolution), but do not provide a quick, visual
reference to amplitude relationships throughout the spectrum. A tabular printout
is especially useful for RTgg information when using the RTgp software
available for the PC-40. Each type of printout has its value, so we give you the
option of either or both.

Graphic printouts are executed by pressing PF5 while holding down the Ctrl
button, and tabular printouts are executed by pressing P while holding down
the Ctrl button. '

Graphic printouts ave available in all PC-40 functions, and tabular printouts are

available in most PC-40 functions. Printout availability for each specific PC-40
function is detailed in the manual under the function heading.
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Appendix Il
Troubleshooting Your PC-40

Navigating Around Your PC-40

The lvie PC-40 Analyzer is based on the Epson HX-40 Computer. The
functions performed by the analyzer are software functions. In other words, one
of the programs that can be run on the HX-40 is the PC-40 program. Physically,
the bottom half of the PC-40 (that part which is not the HX-40 Computer)
consists of the filters, the power supply, and other hardware which comprises
the "guts" of the PC-40. This section is analog, and the information generated
here is sent to an A/D interface where it can be accessed by the HX-40. When
the PC-40 Analyzer program is running on the HX-40, it regularly interrogates
the interface to get data it wants, and to tell the hardware what the computer
wants it to do.

This procedure is nothing new. It's just standard stuff, but the point we are trying
to make is that the PC-40 is not just a dedicated analyzer. It can also function
as a computer. While this flexibility is a positive feature, it can also cause some
problems. If you inadvertently crash the PC-40 program, or otherwise exit it,
you may find yourself in some other function of the HX-40 Computer wondering
how to get your PC-40 to be an analyzer again. This part of the manual is
designed to help you navigate around your PC-40 and still get back to where
you want to be.

One more bit of important introductory information first. The HX-40 computer
has the ability to remember where it was when you turned it off, and it will return
to that same point when you turn it back on. This is a great feature and is one of
the reasons it was chosen for the basis of the PC-40. Most other computer
systems, when they are turned on, go through a defined startup or "boot"
sequence that always places the system at the same place or prompt. The HX-
40 just returns to where it left off. If you are running the analyzer program and
turn the PC-40 off, it will come up in the analyzer program again when you turn
it back on. However, the negative side to this is also true. If you are somewhere
in the computer where you don't want to be, and you turn your PC-40 off, you
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will still be where you don't want to be when you turn it back on.
The CP/M Operating System Menu

Figure E below shows the PC-40 screen when you have called up the CP/M
Operating System Menu. This is a happy screen. It tells you that you have
returned to PC-40 access safely from wherever you were.

55.5k CP/M 12/11 (MON) 09:34:57 1/1
C:PC40V45R
I I LA ) SO R | C: STARTUP BAS

C: PC-PC BAS B: BASIC COM

Figure E

This menu shows the programs resident in the PC-40. You may select a
program shown in the menu by using the up, down, right, and left cursor arrow
keys. The program selected is shown in inverse video. In the screen shown
above, the selected program is the PC-40 Analyzer program. Notice that the
ROM version number is shown. In our example above, the ROM is version 4.5.

Other programs that can be run are also shown in the menu. Below the PC-40
Analyzer program, the PC-40 to PC program is shown. Of course, if you do not
have this optional software program, it will not show up in the menu.

To the right, the BASIC programs are are shown. B:BASIC COM is the Microsoft
BASIC program, and C:STARTUP BAS is the BASIC interface program which
allows you to interface BASIC programs you have written to the PC-40. Once
you have selected the program you wish to run, pressing RETURN will run the
program. For the purposes of discussion here, we will assume that you wish to
run the analyzer program. What we will be discussing next is how to return to
this CP/M Menu from wherever you might be in the HX-40. Once you return to
this menu, you may select the PC-40 program, and then press RETURN to
activate the PC-40 Analyzer.
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Returning to the CP/M Operating System Menu from BASIC

If your PC-40 screen looks like Figure F below, you are in the BASIC program.

BASIC Ver 1.0 (C) 1983 Microsoft & EPSON
RETURN to run or SPACE to login.

P1: 0 Bytes
P2: 0 Bytes
P3: 0 Bytes
P4. O Bytes

20313 Bytes Free

Figure F

This is the BASIC Log In Screen. The only way out of BASIC back to the CP/M
Operating System Menu is to log in. This is done by pressing the SPACE
BAR. When you press the SPACE BAR to log in to BASIC, you should get a
screen that looks like either Figure G below, or Figure H on the following page:

BASIC Ver 1.0 (C) 1983 Microsoft & EPSON
20313 Bytes Free
Ok

Figure G
This is a BASIC System Screen. (For further information on BASIC

programming, consult your HX-40 BASIC Programming Manual which came
with your PC-40).
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Ok

Figure H

This is also a BASIC System Screen, as is Figure G. To retUrn to the CP/M
Operating System Menu from here, type the word "SYSTEM" and then press
the RETURN key.

Returning to the CP/M Operating System Menu from CP/M
When you are in the CP/M Operating System, you will get an "A" Prompt screen,

if you have selected the "A" drive, or a "C" Prompt screen, if you have selected
the "C" drive, etc. An "A" Prompt screen is shown is Figure | below:

A>

Figure |

From the CP/M Prompt screen, you may enter any CP/M command. These
include commands like "DIR" to see a directory of files stored on a drive. You
may also type the name of a program to execute it and start it running. If you
typed C:PC40V45R, and then pressed RETURN, the PC-40 analyzer
program would begin to run (if, of course, your ROM was version 4.5). If you
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don't remember the version number of your ROM, and therefore can't type in
the name of your PC-40 program, you will want to return to the CP/M Operating
System Menu to reactivate the analyzer program. To do this, execute the
following steps.

First, make sure that the flashing cursor is located just after the CP/M Prompt.
This can be accomplished by using the HOME/BS key to backspace over any
existing command or space. Then press the red QUIT button at the top, left of
the keyboard. This will usually return you to the CP/M Operating System Menu.

Under some conditions, the above procedure will not return you to the CP/M
Operating System Menu. |If this is the case, you may need to re-boot your
system by pressing the RESET button found near the ON/OFF switch, on the
right side of the PC-40, as shown in Figure J below:

@ ivisPC-2

OFF/ON

g [ switch

RESET
Button

Figure J

You will need to use a pencil or ball point pen to press the RESET button. Re-
booting you system should restore the CP/M Operating System Menu, unless
the menu has somehow been turned off.

If the CP/M Operating System Menu is configured to be off, then re-booting the
system will obviously not display the menu. If you are unable to get the menu to
display, check its status to make sure it is on. To verify the status of the CP/M
Operating System Menu, hold down the CTRL key while pressing the
SYSTEM key (located just above the 4 key). This should bring up the System
Display Screen as shown in Figure K on the following page:
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* SYSTEM DISPLAY * 12/11 (MON) 10:42:53
<RAM  DISK> 26 KB <ALRM> OFF
<USER BIOS> 000256 B <AUTO> OFF
<MENU DRIVE> CBA <MENU> ON
-Select or ESC to exit. 1=RAM cartridge
2=alarm 3=auto start 4=menu

Figure K

In Figure K, we see that the menu (labeled <menu>) is ON. If it were not on, we
would, of course, want to turn it on. To do this, press 4 to select the Menu
Control screen. The Menu Control screen is shown in Figure L below:

* SYSTEM DISPLAY * 12/11 (MON) 10:42:53
<RAM DISK> 26 KB <ALRM> OFF
<USER BIOS> 000x256 B <AUTO> OFF
<MENU DRIVE> CBA <MENU> ON
-Select or ESC to return.
<MENU> 1=off 2=0n 3=drive

4=ext1 S5=ext2 6=ext3 7=ext4

Figure L

Once into the Menu Control screen, the menu can be turned on by pressing the
number 2, as shown above.

One more thing should be mentioned here. Notice the <MENU DRIVE> line in
the screen above. The drives associated with the menu are C, B, and A. The
PC-40 Analyzer program is located in drive C. If, for some reason, the C drive
were not listed, you would not be able to pull up the CP/M Operating System
Menu with the PC-40 Analyzer program listed in it. In the highly unlikely event
that the C drive is not listed, you may press the number 3, as shown in Figure L,
to select the Drive Control screen. Once in this screen, you may add the drives
you wish, but the C drive must be one of them.
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Once you have made certain that the menu is on, and have finished any other
configurations you wish to make, you may return to the main CP/M Operating
System display by pressing ESC (located just above the 2 key) once or twice
as prompted. Once you have returned to the main CP/M Operating System
display, you may pull up the CP/M Operating System menu by following the
instruction previously outlined on pages 75 and 76. This will, of course, get you
back to PC-40 Analyzer operation once again.

Recovering from Crashes, Lockups, and Other Minor
Catastrophes

Sometimes things happen which result in program crashes, lockups, or other
unpredictable occurrences. The following section will help you deal with most
of these. We will, of course, be operating under the assumptions that nothing is
wrong with the hardware, and the software is undamaged. |[f this is not the case,
these procedures will obviously not help.

The first thing to check is battery and AC charger status. Low batteries are not
usually the culprits because the system will shut itself down to computer
operation only and give an on screen, written indication of low batteries. The
converse may be true, however. If you are operating with the charger plugged
in and the batteries are quite fully charged, a dirty AC line, or an excess AC
voltage may find its way through the charger and the batteries to cause
problems. The normal symptom of this is strange looking, or a locked screen, or
sometimes failure of the signal amplitude on screen to change as the Reference
Level is changed.

Unplugging the charger from the PC-40, and turning the unit off and then on
again will normally correct this condition. Then just operate it from the batteries
only until they need to be charged.

If that does not solve the problem, or if something else has occurred which is not
related to the PC-40 power supply, you will need to try resetting, or re-booting
the system. There are several levels of reset available to you, and the reset
required is determined by the seriousness of the problem.

We refer you to page 2-62 of the Epson HX-40 manual, for a detailed
explanation of the resets available. The section of the Epson manual is
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entitled, "2.5.6 Restarting the system." For most lockups and crashes, the
first two levels of reset will not help. We will therefore not discuss them here.
The first level we will explore is pressing the RESET button. Figure J, on page
76, shows the location of the RESET button. In order to press it, a ball point
pen or pencil is required. It has been recessed to prevent accidental actuation.
Pressing the RESET button will cure the majority of PC-40 problems. Always
try this level of reset first, as the next levels may cause the loss of successively
more data.

If simply pressing the RESET button does not solve the problem, move to the
next level. Press and hold down both the SHIFT and GRPH keys, while then
pressing the RESET button. When this level of reset is executed, system
initialization takes place, followed by a cold start. This means that after the
system is up and running again, you will need to go into UTILITIES, select
"Time," and reprogram the date and time information.

The last level of reset we will consider is pressing the 7508 Reset Button
located inside the ROM and Reset Button compartment on the bottom of the HX-
40. Appendix | entitled "PC-40 Mechanical" on page 66 of this manual
details removing the HX-40 computer from the PC-40 frame, and accessing the
ROM and Reset Button compartment. We refer you to that section if you are not
already familiar with disassembling the PC-40. Figure M below shows a
closeup of the ROM and Reset Button compartment on the bottom of the HX-40:

Reset Button

alninininie!

PC-40 ROM

{ TOULILLT

Figure M
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Using the 7508 Reset Button should be a last resort. It works very effectively,
but you will have to reprogram date and time information as previously
discussed, and this level of reset can also wipe out data in the PC-40's twenty
memories, or in buffer memory. Memory destruction does not always happen,
but it can happen, so we recommend using the 7508 Reset Button only when
all else has failed.

With the above data, and the rest of the information in the appendices, you
should be in a position to solve most problems you might encounter using the
PC-40. You should find it rarely necessary to troubleshoot you PC-40, but if you
do encounter a problem you cannot solve using all the information in this and
the other manuals which came with your PC-40, please do not hesitate to give
us a call at the factory. We'll be happy to help.
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RTgg Measurements Using the PC-40

Introduction and Theory of RTgg Measurements

In theory, reverberation measurements seem easy and straight-forward to make. In
actual practice, they are not as easy as they might appear. RTgq is defined as the

time, in seconds, it takes sound in a reverberant environment to decay 60dB in
level. Measurements are usually made in narrow bands (octave or 1/3 octave),
rather than broadband (20Hz to 20kHz). 1SO standard octave bandwidths are the
most common basis of measurement, with 1SO standard 1/3 octave bandwidths
being often used as well.

To make RTgg measurements, the following items are needed: a sound source to

excite the environment being measured, a sound level meter to measure the sound
decay, and a clock to measure the time over which the decay occurs. If our sound
source were sufficiently powerful, and we had good hearing protection, we could
excite an environment to a level 65 or 70dB (60dB of decay plus 5 to 10dB of
headroom) above the ambient sound level. We could note the overall SPL, then
shut off the sound while simultaneously starting a stop watch. We could watch the
SPL meter until the sound level decayed 60dB, and then punch our stop watch.
The time showing on the stop watch could be defined as RTgq.

The accuracy of the measurement would, of course, be affected by our ability to
punch the stop watch at just the right times, and by our ability to read the SPL
meter, determining exactly when the sound had decayed 60dB. In actual practice,
a number of other factors affect both the accuracy and the interpretation of the data
gathered. In the first place, it is usually not possible to generate sound levels which
are 65 to 70dB above ambient - in many environments, such a level would
approach the threshold of pain. This means that decay has to be measured over
smaller windows than 60dB, with extrapolated RTgg then being calculated, rather

than actually measured. Also, the rate of decay can vary over the measurement
window, so, if an average of all rates of decay is desired, more calculations are
involved. Additionally, methods of exciting the environment, along with other
factors, can cause dramatic differences in the rate of decay for the first 5dB, when
compared to the rest of the decay window. Consequently, we may want to be
selective as to the section of the decay window we use to calculate decay time.



If we create a graphic plot of sound Ievel versus time, we can observe the behavior
of the sound as it decays. Of course, the number of amplitude samples we take
over our time window will affect the resolution of decay curve we construct. Once
we have this decay curve, we can make some decisions about which section of the
curve to use to calculate RTgg After a suitable section of curve has been selected,

we face the problem of determining what the average rate of decay over that
section of curve is. Once we have that, we can finish the RTGO calculation.

Perhaps the best way to handle all of these variables and calculations is through
the use of a computer. The PC-40 does just that. The diagram below helps to
explain how the PC-40 works and why it works the way it does.

RTgq Decay Curve

—
NI
-5dB
-10dB — I 1
1
20dB -25dB
m -{(1so Mathematically Derived
A -20dB — 20) — Slope
= 7
: 11
@
2 -30dB —
Q _ 4—RT60
. ] —3
—4OdB lllf|llll|llll|llIllllll|llll|

1.0 2.0 3.0 4.0 5.0 6.0

Time in Seconds
Figure 1

The above plot shows a decay curve and identifies sections of that decay curve. To
insure statistical accuracy in measuring and plotting decay, the PC-40 takes
samples (of amplitude in dB) at the rate of 100 samples per second, regardless of
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the length of the measurement window selected.

Notice that a 20dB section of decay curve has been identified. It begins at -5dB
and ends at -25dB. Since 20dB is one third of 60dB, the decay time over this 20dB
window would be 1/3 of the total RTgq, as the diagram shows. Not using the first

5dB of the decay curve in calculations of RTgg is an international practice that has
evolved due to the variations often occurring in the first 5dB of decay, as compared
to rest of the decay curve. The PC-40 uses the 20dB section of decay curve from
-5dB to -25dB for RTgq calculations and delineates these calculations as ISO (20).
The PC-40 also defines a 30dB decay window from -5dB to -35dB which can be
used for calculations if there is sufficient decay available. The PC-40 delineates
this as ISO (30). Additionally, the first 10dB of decay is often of major interest.
Calculation of RTgq based on this section of the decay curve is delineated by the

PC-40 as Early Decay. The PC-40 calculates ISO (20), ISO (30), and Early Decay
times for each frequency band. A PC-40 tabular printout of RTgqg includes

numbers for all three of these. If there were insufficient decay to calculate ISO (30)
or ISO (20), dashes would be printed to indicate insufficient data.

In our example above, a straight line has been fitted over the decay curve which
represents the average slope of the decay. It is this line from which the final RTgg
calculation is made, and therefore, the accuracy with which the line is fitted to the
decay curve affects the accuracy of the final calculation. To insure the most
accurate "fit" possible, the PC-40 uses linear regression (the "least squares”
method) to fit the line to the decay curve.

The last item that needs to be mentioned is the improved statistical accuracy
provided when several decay samples are taken and averaged together before
RTgo calculations are made. Five or more samples are sufficient to provide

excellent statistical accuracy. The PC-40 will average up to 99 decay samples, far
more than are necessary.

Measuring RTgg Using Pink Noise and the PC-40 Audio Relay

Measuring RTgq with the PC-40 is really very simple and fast. Let's go through the
procedure step by step. In an actual RTgg measurement, we would be feeding
pink noise into a sound system through the PC-40 Relay. The Relay function is to
shut off the sound as the test is begun. For the purposes of this discussion, we are
going to "cheat" a little, and feed the pink noise electrically into the PC-40, instead
of sending it through a speaker to the microphone. What we will be measuring is
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the decay of the PC-40 filters, rather than the decay of a room. The intent here is to
conveniently familiarize you with the measurement procedure in the peace and
comfort of your own office, before you have to go out and make a measurement.

A measurement setup is shown below which outlines our "office setup,” and also
the setup for an actual RTgg measurement. Only the output from the Audio Relay

differs. Our "office setup" is demonstrated by the solid lines which show pink noise
coming out of the Audio Relay, then feeding directly into the PC-40. A "real”
measurement setup is demonstrated by the broken lines which show pink noise
coming out of the Audio Relay, then feeding through a sound system, to be listened
to by the PC-40 through its microphone.

OVOCFD  EyENT RELAY CHARGER PRE-AMP
IN OUT
FINISHED
) ouT
Pink noise 1n I Pink noise out

ey
cend?

;1 Solid line output = electrical setup
;i Broken line = actual room setup

Generator set to pink
noise

Relay indicator
ON = Closed
OFF= Open .

Figure 2
4



As already mentioned, the setup in Figure 2 shows both the normal setup for
measuring room RTgg through the PC-40 microphone, and our electrical "office”

setup for feeding pink noise directly back into the PC-40. This electrical setup can
be accomplished using an Ivie 83AD adaptor (6 pin XLR to phono) plugged directly
into the microphone input. [f this adaptor is not available, the 1036B RTA Probe
supplied with the PC-40 can be used by connecting it to the BNC input of the PC-
40, and then clipping the probe to the output of the noise generator. In this
instance, you would have to go into the UTILITIES menu of the PC-40, select
Mic/Probe, and change the input to dBm, or dBV. If you failed to make this change,
(switching the PC-40 from mic input to probe input) the PC-40 would still be looking
for signal coming in through the mic input, and all it would see is crosstalk from the
probe input.

Once the setup is completed as shown in Figure 2, and pink noise can be seen on
the PC-40 screen, RTgg meas,urements can be begun. To make a measurement,

the following keystrokes are necessary:

Press UTILITIES to select the UTILITIES menu. You will see RTgq listed.
Hold down the Shift key and press PF1 to select RTgq.

The PC-40 will prompt, asking you to select a sample time base. You may choose
from 1.81 seconds to 10.86 seconds. (If instead you get a prompt at this point that
says data is already in memory and will be lost if you continue, see page 16 of this
manual under "Allocation of Buffer Memory.") Regardless of the sample time you
choose, the PC-40 will take samples at the rate of 100 per second, so accuracy of
measurement will not be affected by choosing a long sample time for a short RTg

measurement. Resolution of the decay plot will be affected, though, because the
entire width of the display screen will be equal to the time base you select. If you,
for example, select a time base of 10.86 seconds to measure a filter decay that is
less than a half a second, the decay plot will be compressed against the left side of
the display. If you chose a 1.81 second window instead, the decay plot would be
expanded and much easier to follow visually. It is best, therefore, to choose the
shortest time base that will allow for your measurement. Of course, if you choose a
time base that is shorter than the decay time you are trying to measure, you won't
get complete measurement results.

Following through with our measurement setup, select a time base of 1.81 seconds
by pressing the number 1. The PC-40 will prompt again, asking if you wish octave
analysis. If you select Y (Yes), the PC-40 will measure RTgg in octave

bandwidths. If you select N (No), the PC-40 will measure decay in 1/3 octave
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bandwidths.

For our example, hit N to select 1/3 octave band measurements. The PC-40
screen should now look like Figure 3 below.
] ———
8 PRESS Indicates
O | SPACE | |*Internal Trigger”

~18 Mode

~36 FOFT

SPL 83.9

Figure 3

The PC-40 is now ready to make a measurement. If you are not happy with the ‘ -

level of noise showing on the screen, you can adjust the Reference Level, or even
adjust the level of noise coming from the noise generator. Once you are happy
with the display, press the Space Bar to begin a measurement.

The PC-40 Relay will open, turning off the noise (visual indication of the Relay
status is provided by the Relay LED indicator - see Figure 2), and the measurement
will begin. After a moment, you should get a PC-40 screen that looks something
like Figure 4 on page 7. (Your decay curve will likely look different from the one
here because the one here has been tailored to make it easier to demonstrate the
measurement manipulations possible.)



r Start Cursor

I .
1000 ___Display Frequency
| 1.81 — Display Time
-18 13 | — Start Cursor/time
.46 | — Stop Cursor \in sec
-36 /RT60
00 1.54 S RT60 Result
L Stop Cursor Average -
Counter
Figure 4
¢ Averaqgin veral M remen mples T her:

If we were going to take several sample measurements to average them together,
we would hit the AVERAGE button at this point. This would enter all the data from
the first measurement into the accumulators and the average counter (See Figure 4
above) would increase by 1. Then, to ready the PC-40 to take another sample,
press STORE. This would reset the display screen back to its "trigger ready" mode
as shown in Figure 3. The pink noise would again come on and we would be
ready to take another measurement by pressing the Space Bar. Successive
measurements could be entered into the averaging accumulators as we continued
to follow this same procedure. It is important to note that when averaging samples,
the display shown is the display of the last sample taken. In order to view the
average of all samples taken, press V (for view). This will display the averaged
data, and the Average Counter will list the number of samples that have been
averaged. In addition, the letters "AV" (for "Average") will appear next to the
Message Window to give visual indication that averaged data is being displayed,
as shown in Figure 5 on page 8.

)



Indicates Averaged Data is Being Viewed —

I

: 1000

1 AV | 181
__________________________ 18 16
: 52

1736 RT60

W 02 1.21

Two samples averaged —

Averaging Several Measurement Samples

Figure 5

For our example here, we will not take the time to average several samples. You
can easily do that by following the above procedure when making an actual
measurement. Instead, let's examine the data shown on the PC-40 screen in
Figure 4 on page 7.

Understanding the RTQQ Display Screen

The PC-40 display shown in Figure 4 on page 7 provides a great deal of
information. Firstly, the start and stop cursors are shown selecting a section of
decay curve. The Message Window tells us what frequency band we are looking at
(in this case, 1000 Hz), and the time window we have selected (in this case, 1.81
seconds).

Below the Message Window, the time location of the start and stop cursors is
displayed. Notice that the start and stop cursors, in Figure 4, are at .13 seconds
and .46 seconds respectively. Our time references are 0.0 seconds, the left side of
our decay display, and 1.81 seconds, the far right side of our display. (You may
recall that the time window we selected was 1.81 seconds long. Our display,
therefore, shows that exact time window.)

At the bottom, right of the display, the average counter tells us the number of
samples we have averaged together to generate our data (In Figure 4, we have not
averaged any measurement samples together, so the average counter says 00).
Lastly, our RTgq calculation is displayed: 1.54 seconds.



We could conclude, then, by looking at Figuré 4: after a single sample
measurement, the calculated RTgg, based on the 20dB of decay from
approximately -5dB to -25dB on the decay curve, is 1.54 seconds. This, however,
is only the beginning of the information available.

Figure 4 shows the PC-40 "default display." That is, the 1000 Hz bandwidth is
shown, the start and stop cursors have selected the ISO (20) measurement (-5dB
to -25dB on the decay curve), and the location of the cursors is shown in time.
The PC-40 can display the decay curve and calculated RTgq for any of the other

frequency bands (it measured all the bands simultaneously), it can display ISO (30)
automatically (-5dB to -35dB on the decay curve), and it can indicate the location of
the cursor wands in dB relative to the Reference Line, as well as in time.
Furthermore, you may select any portion of the decay curve you desire, and the
PC-40 will calculate RTgq over that portion of the curve. Lastly, you may print any

decay’curve, or get a tabular printout of calculated RTgq at every bandwidth. The
commands to accomplish all of these are simple.

To_change the display from ISO (20) to ISO (30): Hold down the CTRL button and
hit the "Up" arrow key on the PC-40. Your display should then look something like

*  this.

- Start Cursor

1 ,
1000 __ Display Frequency
1.81 — Display Time
13 | — Start Cursor
59 | — Stop Cursor
RT60
1.52 _— RT60 Result
L Stop Cursor Average -
Counter
Figure 6

Notice that the start and stop cursors are now located at approximately -5dB and
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-35dB, with the stop cursor time and the calculated RTgg number having been

changed accordingly. To change back to ISO (20), hold down the CTRL key and
press the "Down" arrow key. In this manner, you may toggle back and forth from

ISO (20) to 1SO (30).

To have the start and stop cursors indicate in dB relative 1o the Reference Line: Hit

the letter D (for dB) on the keyboard. Your display should now look something like
this.

r Start Cursor

___Display Frequency
—Display Time

— Start Cursor (in dB)
— Stop Cursor (in dB)

—RT 0 Result

6

L Stop Cursor Average -/
Counter ¢

Figure 7

Notice that we are measuring ISO (30), and our start and stop cursors are
approximately 30dB apart. 1SO (30) measurements specify -5dB to -35dB on the
decay curve and the PC-40 will choose values as close to these as possible to
locate the start and stop cursors. Notice, however, that the dB locations of the start
and stop cursor printed below the Message Window are dB relative to the
Reference Line, not relative to the beginning of the decay curve. In our example
above, the start cursor is 4.7dB below the Reference Line, which is about 5dB
down on the decay curve. (In our example, the decay curve begins almost exactly
at the Reference Line.)

To change the display indication of the start and stop cursors from dB back to time:

Hit the letter T (for time). Hitting the letters D and T, then, will allow toggling
between dB and time when displaying cursor locations.

To display the decay curve from a different frequency band: Hit the "Up" arrow key

to go up in frequency, and the "Down" arrow key to go down in frequency. You will
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notice as you do this that the new frequency you have selected appears in the
Message Window. The decay curve for that frequency is also displayed
automatically, and the calculated RTgq is shown as well. The decay curves and
RTgg information for each frequency band are in the PC-40 memory, and you may
step through each band to view any frequency you wish. Let's continue with our
example. Press the "Down" arrow key and select the 500 Hz bandwidth. After you
have done this, you should get a display similar to Figure 8 below.

Figure 8

Notice that the start and stop cursors are still in ISO (30) on the new decay curve,
and their locations are shown in dB. This is how we left them before we changed

frequency bands.

To change the location of the start and stop cursors: The arrow keys are used. To

move the start cursor left or right, press the "Left" or "Right" arrow key. To move
the stop cursor left or right, hold down the Shift key while pressing the "Left" or
"Right" arrow key. To move both cursors simultaneously, hold down the CTRL
key while pressing the "Left" or "Right" arrow key. Once you have selected the
section of decay curve you wish with the start and stop cursors, press the
"Recalculate” button (PF5) to calculate RTgq based upon the section on curve you
have selected. (You will notice that as soon as you begin to move either the start or
stop cursor, the calculated RTgg number will disappear from the display. It will not
reappear until you have placed the cursors where you want them and then pressed
the "Recalculate” button.)

To print out any decay curve: Follow the same procedure as in printing other

11



screens of information - hold down the CTRL button while pressing PF5. This will
give you a "screen dump" printout, just as in other functions of the PC-40. Of
course, you must display the decay curve you want to print out before you can print
it.

To print a tabular RT report of all bands megsured: Hold down the CTRL key and

press P for "print." The PC-40 will visually step through all the decay curves and
print out a tabular report that looks something like the one printed out below. This
one is a printout for octave bandwidth measurements, but 1/3 octave
measurements would print out in a similar fashion, with all thirty 1/3 octave
channels printing out instead of just ten octave channels.

NOV. 18,'88 03:45:09 PM

RT-60 REPORT AFTER 01 SAMPLES

FREQ. EARLY IS0 (20) IS0 (30)
315 1.79 1.55 ———-
63 1.63 1.51 1.59
125 1.40 1.36 ——
250 1.02 0.99 1.00
500 0.98 0.96 0.94
1000 0.85 0.84 0.81
2000 0.76 0.73 0.74
4000 0.69 0.68 0.68
8000 0.65 0.64 0.62
16000 0.61 0.62 0.60

Figure 9

Notice that three RTgg numbers are printed for each band: Early Decay, which is

calculated from the first 10dB of decay, ISO (20), which is calculated from the -5dB
to -25dB section of the decay curve, and ISO (30), which is calculated from the
-5dB to -35dB section of the decay curve. If there is not sufficient decay to do an
ISO (20) or ISO (30) calculation, dashes ---- will be displayed or printed out.

Once you have completed your measurements, you will want to exit the RTgg
program and perhaps annotate the file that has been created. To exit the program,

12



press UTILITIES. This will create a condition on the display screen that should be
familiar to you - the screen will appear to do a carriage return and a cursor will
appear at the bottom of the display to allow you to annotate the RTgq file, if you

wish. When annotation has been completed, hit Return, and the UTILITIES menu
will appear. Pressing UTILITIES again will return the system to a real-time
function.

Note: Annotating any one decay curve (1000 Hz, for example) will automatically
annotate the rest of the decay curves. You need not annotate each curve
separately. Annotation will also appear on tabular printouts.

Measuring RTgg Using a Blank Pistol or Other External Sound
Sources |

It may not always be possible to use an existing sound system to make an RTgq
measurement, so an alternative method is sometimes necessary. A blank pistol is
often used, but in smaller rooms, a popped balloon or something similar may be
adequate. If this method is used, it is important that the measurement device be
turned on at the proper time to begin making the measurement. The PC-40
accomplishes this by "external triggering.”

External triggering occurs when measurement is begun by some external means,
as opposed to beginning by some means internal to the analyzer (such as pressing
the Space Bar). The PC-40 uses sound, at a given frequency and amplitude, to
trigger the beginning of the measurement process. Both the frequency band used,
and the amplitude required to effect triggering are selectable.

No equipment setup is necessary for this method of measuring RTgq other than the

PC-40 itself. Set it up exactly the same way as described previously in making
room measurements using pink noise. Select RTgq from the Utilities Menu, select

a time window for sample taking, and choose either octave or 1/3 octave
bandwidths for measurement purposes. This should bring you to the display
shown in Figure 10 on the next page, which is similar to the display you saw in
Figure 3, page 6, except that now you will be looking at ambient room noise
instead of pink noise.

13
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Figure 10

The Message Window says "Press Space" indicating that the PC-40 is in the
“"Internal Trigger" mode and is waiting for you to press the Space Bar to begin a
measutement. We must change the PC-40 to "External Triggerirgwg." To do this, hit
the letter T (for trigger) on the keyboard. (Hitting T again will toggle the PC-40 back
to the "Internal Trigger" mode. Successive presses of the Iette@r T will toggle the
PC-40 back and forth between "Internal Triggering" and "External Triggering.") The
Message Window will change and you will see the "default" frequency band (1000
Hz) and the "default" amplitude (0.0dB, which is equal to the Reference Level)

displayed, as shown below.

80 1000 Indicates
0.0 | ['External Trigger”
18 Mode
“36 F FT
SPL 71.3

Figure 11

The trigger frequency band and the trigger amplitude may be changed by using the
arrow keys. To change the frequency band, use the "Up" and "Down" arrow keys.
To change the trigger amplitude, use the "Left" and "Right" arrow keys. Once you
have selected the desired trigger frequency and amplitude, you are ready for the

next step.
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The Reference Level must now be properly set. Ambient noise should be far down
on the display, or even below the display screen. The blank pistol or balloon
generated noise should bring the display up near the Reference Level, high
enough to trip the "trigger,” but not so high that it drives the display above the PC-
40 screen. You may have to experiment by firing the pistol or popping the balloon
a time or two to see where the noise registers on the PC-40 display in order to get
the Reference Level properly set. Your experimentation may also cause you to
want to change the trigger amplitude or the trigger frequency.

After you are happy with your settings - you know that the noise will bring the
display up near the Reference Line, and will definitely trip the trigger at the
frequency and amplitude you have chosen, you can "arm" the system so that it will
make a measurement when the trigger is tripped. Up until this time, you have been
able to adjust and experiment without making measurements because the system
has not been armed.

To arm the system, press the Space Bar. Once this is done, the system will be
armed and a visual indication will be provided by inverse video appearing in the
Message Window. An armed system display with the proper Reference Level
setting will look something like this.

BN Ry . Ty
T Trigger Armed

36 FFT
SPL  72.1

Figure 12

Firing the pistol or popping the balloon will now trip the trigger and a measurement
will be made.

The procedures for averaging multiple measurements, manipulating displays, and

printing out data is exactly the same as has been previously described for making
measurements using pink noise.
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Allocation of Buffer Memory and Clearing Files

The RTgg program uses the same buffer memory as the Record Function. If you
have been using the Record Function and then go to RTgq, the PC-40 will prompt,
telling you that if you proceed with RTgg measurements, data already in the record

buffer memory will be lost. The converse is also true, if you have been making an
RTgo measurement and then enter the Record Function, the same prompt will

appear. Just be aware that both functions share some of the same memory, and if
you wish not to lose data as you change functions, save that data to another
location (RAM disk, external disk drive, etc.).

If you have been making RTgy measurements and have quit the program, the data
remains in nonvolatile buffer memory. If you enter the RTgq program at some later

time,' the program will return to the same spot where it was terminated. The last
display showing at the time of termination will be the display that is recalled. If you
wish to continue that same measurement (take some more samples, for example)
you may do so - it will be as though you had never quit the program.

However, if you wish to begin a completely new measurement, the data will need to
be cleared. To clear all data from the RTgq program, hold down the CTRL button

while pressing R (for "Reset"). This will clear the buffer memory and ready the PC-
40 to begin a new battery of measurements. |f you take a "bad" reading, or want to
clear the data from the program for any other reason, this same procedure may be
followed. (Please note, however, that all RTgg data will be lost, including data that

has been averaged.)

Changing the Display Time Base for Data Already Taken

Earlier in this manual we discussed the wisdom of choosing a sample window that
would provide maximum visual display of the decay curve. For example, we
wouldn't want to choose a very long sample time for a short decay because the
decay curve would be compressed against the left side of the display, giving poor
visual information.

There is a simple way, however, to change the time base (and, therefore, the
resolution) of the display window for data that has already been taken, should we
need or want to do so. In other words, if we make the mistake (Heaven Forbid!) of
choosing too long a sample time, and get a compressed display, we can expand it
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by shortening the display window. To do this, hold down the Shift key and press
the "Up" or "Down" arrow keys. This will step the display through the time
windows from 1.81 seconds minimum to 10.86 seconds maximum.

Obviously, this cannot create data that is not there. Time windows may only be
shortened, they cannot be increased above the time window wherein the
measurement was actually taken. (Remember, the sample rate is 100 samples per
second, regardless of the time period chosen. 181 samples, for example, are taken
over the 1.81 second window, and increasing the time base of the display will not
cause the PC-40 to display more than 181 samples.)

Shortening the time base, on the other hand, can be quite useful for visually
examining the behavior of the decay curve. Some care should be exercised in
noting the position of the start and stop cursors on the display. It is possible, on a
long decay time, to keep shortening the time base on the display, which expands
the decay curve and moves the cursors to the right, until the cursors have been
moved off the screen.

The "Help" Function

As with all other functions of the PC-40, the Help screens contain useful information
in making measurements. If you don't have this manual with you, and have
forgotten a "command" or "keystroke," don't forget to try the Help screen where a
summary of all the keystorke commands is shown. It will probably save you a call
to the factory.
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INTRODUCTION

The PC40 to PC file transfer program enhances the utility of the PC40. The portability of the
PC40 allows data to be easily gathered and verified in the field. Then, with the help of the
PC40 to PC file transfer program this data may be brought back into the laboratory for

analysis and formal documentation.

Data gathered in the field must be stored as a CPM file, either on the PC40 Ram disk, or on
the microcassette or floppy disk drives. Individual memories or blocks of 20 memories may be
stored as a file. Data stored in the "RECORD" buffer may also be stored as a file. Refer to
the, "Utilities Functions in Depth”, section of the PC40 manual for detailed information on
saving files.

These files may then be transferred from the PC40 to an IBM® PC or compatible clone. Once
transferred, the program allows the files to be viewed in graph and/or tabular form. The graphs
may be appended with notes and other pertinent information for purposes of documentation.
Noise Criteria and Preferred Noise Criteria overlays may be used with the graphs. Filter
weightings of "A" or "C" may be either applied to, or removed from, the octave or 1/3 octave
data.

Any graph that has been created with comments or other data may be stored as a graph file
for future reference and recall. All graphs may be printed using a standard dot-matrix "Epson
Compatible" printer or an "HP laserjet or Thinkjet " compatible printer.



SYSTEM REQUIREMENTS

PC40 with PC-PC program in ROM (Drive C:)
PC40 serial transfer cable.| Ivie part #725.

IBM PC® or compatible with:
CGA color graphics capability with Monochrome or Color monitor
Serial port (may require a female/female gender adapter for #725 cable)
Printer port
Floppy disk drive
Optional Mouse
Epson Compatible dot matrix printer or HP compatible laser printer
PC40 to PC program on floppy disk. Version 2.4

MANUAL CONVENTIONS

Throughout this manual we will be using the expression <cr> (which stands for carriage
return). Whenever you see <cr> it means you should press a certain key on your computer.
Depending upon the labeling of your computer press either the "RETURN", "ENTER" or
"Carriage Return" key when you see <cr>.

Bold type is used to indicate that you are to enter, via the keyboard the bold printed items,
into the computer. You will see text appearing in bold type along with instructions to type the
commands into the computer.

SOFTWARE INSTALLATION
As always it is good practice to make a backup copy of all program disks. So take a minute
now to make a copy of the PC40 to PC program disk. It is not copy protected.

You may run the program directly from the floppy disk or you may install it on your hard drive.
There are two files that are required for operation of the program. First, there is the file
"PC40.EXE", which is the actual program file. The second file is "PC40.PRM" which contains
user supplied preferences or parameters for the program file. These two files must always be
in the same directory. |
You will notice that there are other files on the disk. These are sample data files of individual
memories, memory blocks and record buffer files. You may use these files to become
acquainted with the graphing portion of the program. There are batch files that you will use to
select the desired print driver for your printer.

FLOPPY DISK OPERATION

Running the program directly from the floppy disk requires no installation. Insert the floppy
into the default drive and type PC40 <cr>. Remember that <cr> means to press the ENTER
or RETURN key.

You will see a screen that is blank except for a menu bar at the top of the screen. Please refer
to the program operation section of this manual for further details on program operation. To
exit the program and return to the DOS prompt, press and hold the ALT key, while pressing
the "Q" (for quit) key. Then press the <cr> key to return to the DOS prompt.




HARD DISK INSTALLATION/OPERATION

You will need to make a directory for the PC40 program. While in the ROOT directory of your
hard drive, type: MDIR \PC40 <cr>. Next type CD PC40 <cr> to change to the PC40
directory that you have just created. Now place the backup copy of the PC40 to PC program
disk into the A: drive and type the following command: COPY A:*.* <cr> This will copy all of
the files on the floppy into PC40 directory on the hard drive.

You may desire to create a sub-directory in which to store the data files transferred from the
PC40. This will allow you to keep your PC40 directory uncluttered. You could create a sub-
directory for each "job" if desired. Let's say that we wish to create a general sub-directory
called "DATA" in which we will store our files. Type: MDIR \PC40\DATA <cr>. We will
show you how to access this directory from within the file transfer program (see the Change
Default Settings menu under the "File" heading).

HARDWARE SETUP
We will assume that your PC has been functioning properly as a computer with CGA graphics
and with an Epson Compatible dot matrix printer or HP compatible laser printer.

We need to connect the PC40 to the PC. This is accomplished by using the serial connecting
cable for the PC40 (Ivie part #725). The small round end of the cable is connected to the RS-
232 connector on the PC40. The flat rectangular end of the cable goes the RS-232 serial or
COM port on the PC. Please note that you may need to purchase, from a local source, a DB-
25 gender changer (female to female) to allow the cable to match the serial connector on the
computer.

Some PCs have only one serial connector while some have more then one. Also a serial
connector may already be in use by a mouse. The PC40 to PC program will only recognize
serial communication ports one and two. So we must use port one or port two for the serial
connection between the two computers. The program will automatically look to serial port
number one (COM 1) for the file transfer data. You can use port number two (COM 2) if that
is more convenient, but when you start the program you will need to tell it to look at port
number two. This is accomplished by typing the following when starting the program:
PCEPSON COM2 <cr> (COM2 stands for Serial Communication Port #2). If you have an
available serial port (one or two) connect the #725 cable to it at this time.

What about the computer that has only one serial communications port and that port is
currently being used by a mouse? Well, you will need to share the port. If your computer has
only one serial port we will assume that this is port number one.

When you wish to make a file transfer, disconnect the mouse and restart the computer by
pressing the following three keys at the same time: Control (Ctrl), Alternate (Alt) and Delete
(Del). Now the computer will not see the mouse connected to the port as it restarts and will
treat it as an available port.



When using serial port one, start the program with the command: PCEPSON <cr> . If
desired, you may quit the program after all the data has been transferred from the PC40 to the
PC, then reconnect the mouse to the serial port and restart the computer as described above.
You can then start the program and have full use of the mouse. The PC40 does not need to
remain connected to the PC once data has been transferred. The PC40 may then be returned
to the field for other measurements.

USING THE PROGRAM WITH OR WITHOUT A MOUSE

The PC40 to PC program will support a mouse but does not require a mouse for operation.
This program uses a pull-down menu system that lends itself to either mouse or keyboard
operation. The keyboard is always active even when a mouse is in use.

Mouse operation

Across the top of the screen are seven menu headers. To gain access to the commands under
the headers you must "pull down" on the header to expose the commands below. To "pull
down" with a mouse, place the mouse cursor on the desired menu header and click the left
mouse button. This will expose all the menu items below that header. To select a particular
item, place the mouse cursor over the desired item and then click the left mouse button.

As other windows are opened and menu items are selected, you will need to use the same
method of point and click., Some windows have a "close window" marker that if pointed to and
clicked upon will close that window without taking any action and return you to the main menu.
The "close window" marker is diamond shaped symbol located in the top left-hand corner of
the window.
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Now that the "File" menu has been "pulled-down" you can see all of the commands under this
menu header. You will note that the first menu item is highlighted. If you pressed the <cr>
(Enter or Return) key, that item would be selected. To select other items in the menu use the
up and down arrow cursor keys to highlight the menu item of choice. After highlighting your
selection press the <cr> key to select it.

Once a menu has been "pulled down", there is a shortcut that can be used to select a menu
item. You may press the key that corresponds to the first letter of the desired menu item. For
Example: To directly select "Get Plot" press the "G" key. Again, capitalization does not
matter. If there is more than one menu item with the same first letter, then the first item will
be selected with the first press of the key, and the second item will be selected with the
second press of the same key and so on. This alphabetical selection shortcut only works in
the pull-down menus. It does not work in other windows such as "File Select.”

The "Esc” key allows you to return to the main menu from other screens. For Example:
When a graph is displayed on the screen, the menu bar at the top of the screen disappears.
This allows maximum display area for the graph. To display the menu above the graph, just
press "Esc.” Remember, "Esc" returns you to the menu. You can also click on left mouse
button to display the menu.

PROGRAM OPERATION
STARTING THE PROGRAM
The PC-PC program can support several different types of printers. Ivie has supplied batch
files that will automatically install the desired printer driver and start the program if you start

the program by using one of the supplied batch files.

Should you start the PC-PC program by typing PC40 you will not be able to print any of the
data. You must start the program with a batch file if you intend to print.

Batch files are supplied for the following printers. Epson compatible dot matrix, HP Thinkjet,
IBM compatible dot matrix, HP laser printers and user defined printers.

If you have an Epson compatible printer connected to your PC then start the PC-PC program
by typing: PCEPSON <cr>.

If you have an IBM compatible printer connected to your PC then start the PC-PC program by
typing: PCIBM <cr>.

If you have an HP compatible laser printer connected to your PC then start the PC-PC program
by typing: PCLASER <cr>.

If you have an HP Thinkjet compatible printer connected to your PC then start the PC-PC
program by typing: PCHPINK <cr>.



If your particular dot matrix printer is not listed above then start the PC-PC program by typing:
PCUSER <cr>. This will start a program that will display a variety of dot matrix printers and
prompt you for input about the mixer.

Remember that the program normally uses the first serial port (COM1) to communicate with
the PC40. If you are using the second serial port (COM2) then start the program by typing in
the name of the desired batch file followed by: COM2.

For example: If you have and Epson compatible dot matrix printer connected to your computer
and the PC40 is connected to COM2 then type the following:
PCEPSON COM2 <cr>.

Instructions for operation of the program will be given using examples. The examples will
make use of the sample files included on the program disk. An efficient way to become
Sfamiliar with the program is to follow along on your computer with the example.

SELECTING A MEMORY FILE (under the File menu)

The selection of a file to display begins with the "File" pull-down menu selection. After the
"File" menu has been pulled-down you will see two menu items related to selecting a file.
They are "Select Memory File" and "Select Record File."

If you chose "Select Memory File," you will be shown only files that contain data from the
PC40 memories. Files that have the extension of ".MBK" (memory block) contain data from
a block of twenty memories. If a ".MBK" file is selected another menu will be shown that will
allow you to choose which one of the twenty stored memories you wish to display. Files that
have a ".MEM" extension contain only a single memory.

Remember that at the time you saved a file to a disk in the PC40 you were given the choice of
storing memories as a complete block of twenty or as an individual (single) memory.

Lets pull-down the "File" menu and select "Select Memory File" by pressing <cr>. Next the
"File Select” window will appear with two files: DEMO.MBK and DEMO.MEM. Select
DEMO.MBK. We will now see a listing of twelve memories on the screen. The remaining
memories can be viewed by using the down arrow key to scroll them onto the screen. We can
now choose any of the twenty memories by highlighting the desired memory and either clicking
on it with the left mouse button or pressing the <cr> key.

You will notice that the "NOTE" you appended to the memory at the time of measurement is
displayed in the file select window. This is to assist you in choosing which memory to display.
Let's select the memory titled "Singing in the lab isn't pretty." The program will now display
the curve on the screen along with other pertinent data. Remember that we can return to the
menu by pressing the "Esc" key or the left button on the mouse.

Selecting a single memory file (".MEM") follows the same process as above with exception
that you will not be shown a second screen from which to choose one of twenty memories.



The above example continues with the next section of this manual. In preparation, return to
the menu by pressing either the "Esc"” key or clicking the left button of the mouse.

Now that we have retrieved a file, we can perform some operations on the graph of that file.

EDIT (Main menu item)
The "EDIT" menu allows you to edit the graphic and tabular data.

ADD COMMENTS (Under the EDIT Menu)
The "Add Comments" heading under the "Edit" menu allows you access to the written data
located to the left and bottom of the graph screen.

If you wish to add, delete, or modify the documentation of a graph, select the "Add Comments"
function from the "Edit" menu. Let's try an example. Select the "Singing in the lab isn't
pretty” memory from the "DEMO.MBK" file. After it is up on the screen, return to the menu
(press "Esc or click left mouse button) and select "Add Comments” from the "Edit" menu.

You are now looking at all the data, notes, file name and comments that appear on the screen
with the graph. You can now modify this documentation. The first two lines at the top of the
screen allow you to enter your own company name so that it will appear on the graph. The
two lines for the company name will accept up to fourteen characters. Editing is done with the
cursor and backspace keys. All editing is done in the overwrite mode. Keyboard entries will
overwrite the existing data.

It is important to note that all original data contained in the ".MEM", ".MBK" or ".REC" files
will remain unchanged as all editing is performed only on the screen display.

You will note that the default company name is "IVIE TECHNOLOGIES." This name will
always appear on every graph screen unless you change the default setting. This can be done
under the "File" menu with the "Change Default Parameters” function. Detailed information
on how to do this is in the "Change Default Parameters" section of this manual.

With the "Graph Comments Input Screen" displayed, overwrite "IVIE TECHNOLOGIES"
with your own company name. To view the changes, press the "Esc” key or move the mouse
outside of the "Graph Comments" window and press the left mouse button. You should now
be looking at the graph with your company name.

Now return to the "Graph Comments Input Screen” by returning to the menu and selecting
"Add Comments" under the "Edit" menu. As you edit any field, the computer will only allow
you to enter a limited number of characters per field. Any field that appears on the "Graph
Comments Input Screen" may be edited. There are three lines of notes that may be entered
below the word "Notes." Each of these three lines may have up to seventy-five characters.

Go ahead and experiment by editing some notes on the screen and then viewing the results on
the graph screen. Remember that by pressing the "Esc” key or the left mouse button you will
return to the graph screen.



The above example continues with the next section of the manual. In preparation return to the
menu by pressing either the "Esc” key or clicking the left button of the mouse.

SHOW TABULAR (Under the EDIT Menu)

Another function under the "Edit" menu is "Show Tabular." This function allows the data of
the currently displayed graph to be shown in tabular form. When the function "Print Tabular"
is exercised this data will be sent to the printer as formated on the "Show Tabular" screen.

If you are following along with the above example, select the "Show Tabular” function at this
time so that you may view the tabular data. When ready, return to the main menu by either
pressing the "Esc" key or the left button on the mouse.

PRINT TABULAR (Under the EDIT Menu)

The tabular data that can be viewed by the "Show Tabular" menu item, may be sent to the
printer using the "Print Tabular" function. Before selecting this function make certain that the
printer is connected to the computer and is "on line" ready to print.

The tabular data that will be printed is from the currently displayed graph. Modifications to the
curve, such as "A" or "C" weighting, will be reflected in the tabular data printout.

If you are following along with the above example, select the "Print Tabular" function at this
time so that you may print the tabular data. Make certain that a printer is connected to the
computer and is ready to print. When finished printing, return to the main menu by either
pressing the "Esc" key or the left button on the mouse.

The above example continues with the next section of this manual. In preparation, return to
the menu by pressing either the "Esc" key or clicking the left button of the mouse.

Edit Curve (Under the EDIT Menu)

The "Edit Curve" menu selection allows you to alter or edit the individual data points on any
displayed curve. If two curves are displayed you will be prompted for which curve you wish to
edit. You then select either curve one or curve two, or if desired you may exit this operation
by selecting the "Cancel" box.

A pop-up window will appear on screen displaying the numerical data for the selected curve.
The data points will be labeled with the frequency. An asterisk beside a frequency label
reminds you that the frequency is an octave band center.

To edit, just type in the new data being sure to type in the decimal point as well. Use the TAB
key to move to the next data field or just click on the new field with the mouse. The SHIFT
TAB will allow you move back through the previous data fields.

There is a "Filter Offset" box that allows a value to be added to, or subtracted from, all filters
at the same time. This is very handy if you are trying to lay one curve over top of another
curve. For example: you could shift the entire curve up by 10 dB by entering the value of 10.0
into the filter offset box. If you desired to shift the curve down by 10 dB you need to enter a
minus sign before entering the value of 10.0.



At any time you can elect to accept the data and exit or to exit the window without making any
changes to the curve.

Please note that any changes made to the displayed curve do not change the original data
stored on the disk. If you wish to keep any changes made in the displayed data you will need
to store the modified curve using the "SAVE PLOT" function found under the "FILE" main
menu.

Create 1/3 Curve (Under the EDIT Menu)
This function allows you to create a custom 1/3 octave curve by allowing you to enter in your
own data points for the curve.

A pop-up window will appear on screen prompting you to enter the numerical data for your
curve. The data points will be labeled with the frequency. An asterisk beside a frequency
label reminds you that the frequency is an octave band center.

Type in the new data being sure to type in the decimal point as well. Use the TAB key to
move to the next data field or just click on the new field with the mouse. The SHIFT TAB will
allow you move back through the previous data fields.

There is a "Filter Offset" box that allows a value to be added to, or subtracted from, all filters
at the same time. This is very handy if you are trying to lay one curve over top of another
curve. For example: you could shift the entire curve up by 10 dB by entering the value of 10.0
into the filter offset box. If you desired to shift the curve down by 10 dB you need to enter a
minus sign before entering the value of 10.0.

At any time you can elect to accept the data and exit or to exit the window without making any
changes to the curve. If you wish to keep any changes made in the displayed data you will
need to store the modified curve using the "SAVE PLOT" function found under the "FILE"

main menu.

Create Oct Curve (Under the EDIT Menu)
This function allows you to create a custom octave curve by allowing you to enter in your own
data points for the curve.

A pop-up window will appear on screen prompting you to enter the numerical data for your
curve. The data points will be labeled with the frequency. An asterisk beside a frequency
label reminds you that the frequency is also an octave band center.

Type in the new data being sure to type in the decimal point as well. Use the TAB key to
move to the next data field or just click on the new field with the mouse. The SHIFT TAB will
allow you move back through the previous data fields.

There is a "Filter Offset" box that allows a value to be added to, or subtracted from, all filters
at the same time. This is very handy if you are trying to lay one curve over top of another
curve. For example: you could shift the entire curve up by 10 dB by entering the value of 10.0
into the filter offset box. If you desired to shift the curve down by 10 dB you need to enter a
minus sign before entering the value of 10.0.
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At any time you can elect to accept the data and exit or to exit the window without making any
changes to the curve. If you wish to keep any changes made in the displayed data you will
need to store the modified curve using the "SAVE PLOT” function found under the "FILE"

main menu.

MODIFY (Main menu item)

There are several modifications that may be made to any displayed curve. A curve may be
modified to reflect "A" ,"C", or "Flat" weighting. Also a second curve may be added to the
graph if desired. Modify also allows the difference between two curves to be displayed.

It should be noted that modifications to the curve do NOT affect the sound pressure level data.
The SPL data is not derived from the the octave or 1/3 octave data but comes from its own
detector at the time of measurement. Weighting of the SPL measurement can not be changed
after the measurement has been taken.

A-Weight (Under the Modify menu)

You can change the "Weighting" of the currently displayed curve to "A" weighting by selecting
this function. If the curve is either "Flat" or "C" weighted it will be changed to "A" weighting.
The graph will then be re-drawn to refect the change in weighting. The change in weighting
will also be reflected in the tabular data of the curve should it be displayed or printed.

C-Weight (Under the Modify menu)

You can change the "Weighting" of the currently displayed curve to "C" weighting by selecting
this function. If the curve is either "Flat" or "A" weighted it will be changed to "C" weighting.
The graph will then be re-drawn to refect the change in weighting. The change in weighting
will also be reflected in the tabular data of the curve should it be displayed or printed.

UN-Weight (Under the Modify menu)

You can change the "Weighting" of the currently displayed curve to "Flat" weighting by
selecting this function. If the curve is either "A" or "C" weighted it will be changed to "Flat"
weighting. The graph will then be re-drawn to reflect the change in weighting. The change in
weighting will also be reflected in the tabular data of the curve should it be displayed or
printed.

If you are following along with the above example, select one of the modify functions at this
time so that you may view the effect on the curve. When you are ready, return to the main
menu by either pressing the "Esc" key or the left button on the mouse.

Add Second Curve (Under the Modify menu)

A second curve may be plotted along with the first curve for purposes of comparison. When
you use this function you will be brought back to the main menu so that you may access the
"File" menu. When you pull down the "File" menu you will notice that only the "Select
Memory File" and "Select Record File" functions are active. You would then go through the
same selection process as you did for the first curve.
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Because the first curve selected sets the display range of the graph, some thought should be
given in advance as to which curve will be plotted first.

As with the first curve that was plotted, the second curve will be plotted with a data marker at
all data points. However, a different style of data marker will be used to help differentiate
between the two curves.

If you are following along with the above example, select the "Add Second Curve" function at
this time so that you may view the effect upon the curve. When you are finished, return to the
main menu by either pressing the "Esc" key or the left button on the mouse.

Delete Second Curve (Under the Modify menu)

This function will cause the currently displayed graph with two curves to be redrawn without
displaying the second curve. This will delete the second curve and restore the graph to just
one curve.

If you are following along with the above example, select the "Delete Second Curve” function
at this time so that you may view the effect upon the curve. When you are finished, return to
the main menu by either pressing the "Esc” key or the left button on the mouse.

Curve minus Curve (Under the Modify menu)

This function allows you to compare the difference between two curves that have been
displayed on the screen. You must display two curves on screen before you can use "Curve
minus Curve."

Upon selecting "Curve minus Curve" a pop-up window will appear on the screen. You will
then given the choice of subtracting curve number one from curve number two or vice versa.
Your selection will then be displayed on the graph. You can exit the "Curve minus Curve”
window without performing any operation by selecting the "Cancel" box.

If you wish to once again view both curves after using "Curve minus Curve", go to the
"GRAPH" menu and select "Normal."

GRAPH (main menu item)
The curve may be displayed in one of five different graph formats.

Normal (Under the Graph menu)

Normal is normal. This is the standard amplitude versus frequency graph displayed as a line
graph. This is the default graph display. The graph will automatically set the display range
according to the data being displayed. Also the graph will be set for octave or 1/3 octave
display to match the data in the file.

Each data point is emphasized on the screen. A connecting line is drawn between adjacent
data points. At times there may be a data point that does not have an immediate adjacent
data point due to the constrictions of dynamic range (a filter may be below the invalid data
line). When this happens, a connecting line is not drawn to or from that point. To do so would
infer (visually) that data which does not exist; exists. To return to the menu from the graph
press either the "Esc” key or the left mouse button.
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NC (Under the Graph menu)

Noise Criteria provides a means whereby ambient noise levels in rooms may be quantified. A
reading of the noise in the room is made in octave bands. The NC overlay is then used
determine the NC rating for the room.

When this graph function is selected, an overlay appears on the screen over the normal graph.
Also the NC rating for the curve is calculated and displayed on the screen. The overlay is an
integral part of the plot, and will appear along with the curve when the "Print" or "Save Plot"
functions are used. To return to the menu from the NC graph function press either the "Esc”
key or the left mouse button.

If you are following along with the above example, select the the "NC" function at this time so
that you may view the effect upon the curve. When you are finished, return to the main menu
by either pressing the "Esc” key or the left button on the mouse.

PNC (Under the Graph menu)

Preferred Noise Criteria provides a means whereby ambient noise levels in rooms may be
quantified. PNC and NC are related to one another in that PNC is a second generation NC
curve. You will notice that different weightings are applied to the noise spectrum by the two
curves. The PNC curves were developed after the NC curves.

A reading of the noise in the room is made in octave bands. The PNC overlay is then used to
determine the PNC rating for the room.

When this graph function is selected an overlay appears on the screen over the normal graph,
and the PNC rating for the curve is calculated and displayed on the screen. The overlay is an
integral part of the plot, and will appear along with the curve when the "Print" or "Save Plot"
functions are used.

To return to the menu from the PNC graph function press either the "Esc" key or the left
mouse button.

If you are following along with the above example, select the the "PNC" function at this time
so that you may view the effect upon the curve. When you are finished, return to the main
menu by either pressing the "Esc" key or the left button on the mouse.

NR (Under the Graph menu)
NR is a means whereby ambient noise levels in rooms may be quantified. You will notice
that NR is very similar to NC and PNC. NR is the standard utilized in Great Britain.

A reading of the noise in the room is made in octave bands. The NR overlay is then used to
determine the NR rating for the room.

When this graph function is selected an overlay appears on the screen over the normal graph,
and the NR rating for the curve is calculated and displayed on the screen. The overlay is an
integral part of the plot, and will appear along with the curve when the "Print" or "Save Plot"
functions are used. To return to the menu from the NR graph function press either the "Esc"”

key or the left mouse button. ’
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If you are following along with the above example, select the the "NR" function at this time so
that you may view the effect upon the curve. When you are finished, return to the main menu
by either pressing the "Esc" key or the left button on the mouse.

NIC (Under the Graph menu)

NIC requires that two graphs be displayed before you select NIC. These graphs would be the
"send" and "receive" measurements made on opposing sides of a wall or partition. The NIC
calculation will be made and displayed on the screen along with the overlay.

Detailed NIC data may be viewed by selecting the Show Tabular menu found under the Edit
pull-down menu. The the tabular data may be printed by selecting the Print Tabular menu.

Label (Main menu item)

With the PC to PC program you can place labels anywhere on the graphics screen. This
provides great flexibility in documenting your data. Once the label is "typed in" you can
position it with either the mouse or by using the cursor keys. The resolution of the placement
is confined to column and row spacing of text characters.

Add Label (Under the Label menu)

Upon selecting "Add Label" a pop-up window will appear on screen and will prompt you to
input your text for the label. You can enter a single line of up to sixty characters. After
entering the label text, press <ers>.

Now position the the label as desired. Once the label is in position either click the left mouse
button or press <cr> to anchor the label at that location.

You can exit the pop-up text input window, without generating a label, by either clicking on the
diamond symbol in top left hand corner of the window or by pressing the Esc key.

Should you need to reposition the label after it has been set in place, you will need to delete it
and then re-enter the label again.

Delete Label (Under the Label menu)

You can delete any label by selecting selecting Delete Label. A pop-up window will appear on
the screen with a listing of all the labels currently on the screen. Select which label you wish
to delete by clicking on it with the mouse or by using the cursor keys. If you are using a
mouse the label will be deleted at the time you select it. When using the cursor keys to
highlight a label, you will need to press the <er> key to delete it.

You can exit the pop-up text delete label window, without deleting a label, by either clicking

on the diamond symbol in top left hand corner of the window or by pressing the Esc key.

At this point we would like to conclude our example/demonstration of the PC40 program.
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File (main menu item)

The "File" menu contains those functions that allow us to retrieve and save various files. We
can select files for viewing that we have transferred from the PC40. We can also select files
that we have created and saved as completed graphs.

The "File" menu also contains the utilities for the program. These utility functions include:
Printing, File transfer, and setting program default parameters.

Select Memory File (under the File menu)

The selection of a file to display begins with the "File" pull-down menu selection. After the
"File" menu has been pulled down, you will see two menu items related to selecting a file.
They are "Select Memory File" and "Select Record File."

If you choose "Select Memory File" you will then be shown only files that contain data from
the PC40 memories. Files that have the extension of ".MBK" contain data from a block
twenty memories. If a ".MBK" file is selected you will then be shown another menu that will
allow you to choose which one of the twenty stored memories you wish to display. Files that
have a ".MEM" extension contain only a single memory.

Remember that at the time you saved a file to a disk in the PC40 you were given the choice of
storing memories as a complete block of twenty, or as an individual (single) memories.

Lets pull down the "File" menu and select "Select Memory File". Next the "File Select"
window will appear with two files: DEMO.MBK and DEMO.MEM. Select DEMO.MBK.
We will now see a listing of fourteen memories on the screen. The other six of the twenty
memories can be viewed by using the down arrow key to scroll them onto the screen. We can
now choose any of the twenty memories by highlighting the desired memory and either clicking
on it with the left mouse button or pressing <cr> key.

Lets select the memory titled "Singing in the Lab isn't pretty”. The program will now display
the curve on the screen along with other pertinent data. Remember that we can return to the
menu by pressing the "Esc" key or the left button on the mouse.

Selecting a single memory file (".MEM") follows the same process as above with exception
that you will not be shown a second screen from which to choose one of twenty memories.

Select Record File (under the File menu)

The selection of a file to display begins with the "File" pull-down menu selection. After the
"File" menu has been pulled down you will see two menu items related to selecting a file.
They are "Select Memory File" and "Select Record File."

The "Select Record File" function provides access to any PC40 Record Buffer files that have
been transferred to the PC. All Record Buffer files are saved with a file extension of ".REC."
When you choose "Select Record File" you will be presented with a new window titled "Select
File," with all record files shown in the window.
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Should you need to exit this window without selecting a file you can do this by either pressing
the "Esc" key or by placing the mouse over the diamond symbol located at the top left-hand
corner of the window and pressing the left mouse button.

To select a file, highlight the desired file by using the mouse or the cursor keys. Once the
desired file is highlighted, select it by pressing the <cr> key or the left mouse button.

Once a file is selected another screen will appear displaying the name of the file selected along
with the number of frames in the file. You will also be prompted for the frame number that you
wish to view. After you enter the frame number press the <cr> key. The frame will be
displayed in the normal graph manner. The graph may then be modified or edited as desired.

SAVE PLOT (under the File menu)

The "Save Plot" function allows you to save to the disk, the currently displayed plot or graph.
After you have recalled a memory or record file and modified or edited the graph you can save
all of your changes to a new file. This new file will have a ".GRF" (for graph) extension on its
file name and is a completely different file from the memory or record file. The original memory
or record data file remains totally unchanged.

When you select the "Save Plot" function another screen will appear, prompting you to enter a
name for the new Plot file. The name of the currently displayed memory or record file will be
shown where you are to enter the file name. You need not enter a new file name if you do not
desire to do so. You may elect to use the same file name for the Plot as is used for the data
file. To do this just press <cr> (the Enter or Return key) and the Plot file name will be the
same as the data file name, but with a ".GRF" extension in place of the ".MBK", ".MEM" or
".REC" extension. '

A new or different name may be assigned to the file by typing in the desired file name. A file
name may have a maximum of eight characters. The program will not allow you to type the file
extension. The file will automatically assign the ".GRF" extension to the file name.

If you assign a file name that is already in use, the program will prompt you with another
screen informing you that a file already exists using that file name. You will then be prompted
to either overwrite the existing file, rename the file you wish to write, or abort the entire
procedure.

The "Save Plot" function is not available for use until after a graph has been displayed on the
screen. This, of course makes sense in that you cannot save a plot to disk if a plot does not
exist.

If you were to examine the "File" menu when first entering the program, you would notice that
the "Save Plot" and "Print Plot" functions would be displayed in a different screen attribute
than the other headings. This denotes that they are not available at this time. After a plot
has been displayed, the screen attributes of these two functions will change to have the same
screen attributes as the other functions.
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GET PLOT (under the File Menu)

The "Get Plot" function allows you to retrieve and display ﬁles that have been saved using the
"Save Plot" function. When you choose "Get Plot" you will be presented with a new window
titled "Select File" which will display a listing of all files with a ".GRF" extension.

Should you need to exit this window without selecting a file you can do this by either pressing
the "Esc” key or by placing the mouse over the diamond located in the top left-hand corner of
the window and pressing the left mouse button.

To select a file, highlight the desired file by using the mouse or the cursor keys. Once
highlighted, select it by pressing the <cr> key or the left mouse button.

Print Plot (under the File menu)
The "Print Plot” function sends the currently displayed graph to the printer for printing.

Please note that a printer driver MUST be installed before any printing can occur. The
appropriate driver will be installed automatically when you start the program from one of the
supplied batch files.

For more information on installing the printer driver please refer to the " STARTING THE
PROGRAM?" section of this manual.

TRANSFER DATA FROM PC40 (under the File menu)

Please note: You must save the memories in the PC40 to a CPM computer file before they
can be transferred to the PC. This is done by using the SAVE function in the Utilities section
of the PC40. Typically you would save a block of 20 memories to the "A” drive, which is the
RAM disk.

There are two programs that must be run at the same time in order to effect a file transfer.
One is on the PC40 and other is on your personal computer. The two computers must be
connected as described in the hardware set up section of this manual.

Start the program on the PC40 first. Turn the PC40 ON and while in the normal analyzer mode
press the red QUIT button. You will now see a listing of programs on the C: or ROM drive.
Use the cursor (arrow) keys to highlight the program "PC-PC  BAS." Now press the red
RETURN key. The program will run and provide you with the message on screen "Waiting for
link." The PC40 is now ready to send files to the PC.

Now start the program in the PC by typing name of the desired batch file. The name of the
batch file should describe the type of printer that you have connected to you PC.

The screen on the PC will now display the following:

"Opening COM1 for Link with PC40" (note : it may say COM2 in lieu of COM1)
"Attempting Link with PC40"
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Once the link is established the screen will be updated to display:

"Opening COMI1 for Link with PC40"
"Attempting Link with PC40 - Link Established"
"Enter PC40 File Specification for Directory A:*.M??"

You are now being prompted to enter a file specification. The program wants to know from
what source and what types of files you wish to display. The source of the file is determined
by the drive, and the type of file is determined by the extension of the file. Remember that
files may be stored on any of the drives listed below.

Specification Drive type

RAM disk

Floppy disk drive
Floppy disk drive
Floppy disk drive
Floppy disk drive
Microcassette drive

LQmMmo >

You will notice that there is a default file specification loaded into the prompt. If you pressed
the <er> key, at the prompt, the program would act upon this specification A:*.M??." Lets
take a moment and examine the default file specification.

The "A:" specifies that we want to read the directory of files on the RAM disk (on the PC40)
which is disk drive "A:". The "*.M??" specifies what type of files we want to view in the file
directory. Remember we have three different types of files as listed below.

File Extension Type of File
".MBK" Memory Block of 20 memories
"MEM" Single memory
".REC" Record Buffer file

The "*.M??" makes use of what is called wildcard characters in the file specification process.
The "*" means give me any file name with the following extension. The extension ".M?7"
means give me all file names with extensions that have the letter "M" as their first letter.
The "?7" hold the place for the other two letters in the extension and are also wildcards. So
the file specification "A:*.M?? will request the directory of ALL files (regardless of their file
name) on the "A:" drive that have a ".MBK" or ".MEM" extension.

You may use the default file specification by pressing the <er> key or you may enter your own
specification by typing over the default spec. A spec of "*.*" will allow you to view all
available files. A spec of "*.REC" will show you only the record buffer files.

This shows you a directory of file names that meet your specification and does not actually
transfer any files. These files will be displayed in the "File Directory” window on the PC.
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Once in the PC40 File Directory window you can select which file you would like to transfer to
the PC. You select the file by highlighting it with either the mouse or cursor keys and
pressing the <cr> key or left mouse button. You will notice a file called "ALL Files" in the
window. This allows you to transfer all the files in the directory with one command.

Once an individual file or "ALL Files" has been requested, the screens of the PC40 and PC
will display the progress of the transfer process. After a file is transferred, the PC will again
show you the PC40 file directory window so that you may select another file to transfer. If you
are finished transferring files, then press either the "Esc” key or click the mouse on the close
window symbol to return to the main menu.

To return the PC40 to the analyzer mode, press the red QUIT button to quit the transfer
program. You should now see a screen with a listing of programs in the various drives. The
program "C:PC40Vxx COM"(xx varies with release #) should be highlighted. This is the
program that runs the computer as an analyzer. With the "C:PC40Vxx COM" program
highlighted, press the <cr> (Return) key start the analyzer.

What happens when you press the red QUIT button and you do not return to the screen that
was described above. Instead you see something like "DT Error in 30" followed by the prompt
"Ok." If at anytime you see a screen that you are not familiar with, and it has the word "Ok",
you are in the BASIC programming section of the computer. The PC40 portion of the file
transfer program is written in BASIC.

The way to exit BASIC is to type in the word System and press <er>. This will return you to
the screen displaying "C:PC40Vxx COM". Now press the <cr> key once more to start the
analyzer.

The PC40 may be disconnected from the PC at this time. The PC40 is no longer needed by the
PC.

Change Default Parameters (under the File menu)
There are two default parameters that can be set by the user. These parameters are stored in
a file called "PC40.PRM" This file must always be in the same directory as the "PC40.EXE"

program.
When this function is selected you will see the following information displayed in the window:

Current Path Spec to IBM Data Directory=
Enter New Path for IBM Data Directory- (a flashing cursor will appear here)

Notice that the space after "Current Path Spec to IBM Data Directory="is blank. This
indicates that it is currently set to the same directory as the "PC40.EXE" program. Any time
the program looks for a file or goes to store a file it will look at the directory that contains the
"PC40.EXE" program. We will call this the default directory.

The sample files that came with the software are stored in the default directory. If you change

the default directory and you wish to access these files you should copy them over to the new
directory.
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Now, what about the flashing cursor at the end of the prompt:
Enter New Path for IBM Data Directory- (a flashing cursor will appear here)

If you press the <cr> key without entering a new path, then nothing will be changed. The
default directory will remain unchanged. Lets say that you wish to store and retrieve your
data files from a sub-directory, under the "PC40" directory. You wish to do this so as not to
clutter your PC40 directory. We will assume that you have already created a sub-directory
called "Data" using the DOS command MDIR\PC40\DATA <cr>. Then, at the prompt, type
the following:

Enter New Path for IBM Data Directory-\PC40\DATA <cr>

Now every time the program does anything that requires a file, it will only act upon files found
in the \PC40\DATA directory. It will not know about any other files located in any other
directories. You could create a separate sub-directory for each job that you perform.

Keep in mind that in order to use a different sub-directory two things must take place. First
you must create a sub-directory in DOS for the data. And second, you must tell the PC-PC
program about the new directory using the "Change Default Parameters” function.

Once you have taken care of the Directory prompt, you will see the next prompt:

Current Company Name 1=Ivie
Enter New Company Name 1 - Ivie (with a flashing cursor over the "I")

Unless you want Ivie's name to appear on all of your graphs, type in the name of your —
company. The "Name 1" line will accept up to fourteen characters. There is also a "Name 2"

line that will also accept fourteen characters, so don't worry if your company name will not fit

on "Name 1" line.

After entering the name of your company, press the <er> key. You will now see the prompt:

Current Company Name 2= Technologies

Enter New Company Name 2 - Technologies
(with a flashing cursor over the "T")

If a second line is needed for your company name, enter it at this time. If you wish to have this
line appear blank on the screen then enter a series of spaces to overwrite the existing name.
Now press the <cr> key.

At this point the program will save the default parameters that you have entered in the

"PC40.PRM" file. The program will then refer to this file any time file or company name
information is required.
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INTRODUCTION

The PC40 to PC file transfer program enhances the utility of the PC40. The portability
of the PC40 allows data to be easily gathered and verified in the field. Then, with the
help of the PC40 to PC file transfer program this data may be brought back into the
laboratory for analysis and formal documentation.

Data gathered in the field must be stored as a file, either in the PC40 Ram disk, or on
the microcassette or floppy disk drives. Individual memories or blocks of 20 memories
may be stored as a file. Data stored in the "TRECORD" buffer may also be stored as a
file. Refer to the, "Utilites Functions in Depth", section of the PC40 manual for detailed

information on saving files.

These files may then be transferred from the PC40 to an IBM® PC or compatible clone.
Once transferred, the program allows the files to be viewed in graph and/or tabular
form. The graphs may be appended with notes and other pertinent information for
purposes of documentation. Noise Criteria and Preferred Noise Criteria overlays may
be used with the graphs. Filter weightings of "A" or "C" may be either applied to, or
removed from, the octave or 1/3 octave data.

Any graph that has been created with comments or other data may be stored as a
graph file for future reference and recall. All graphs may be printed using a standard
dot-matrix "Epson Compatible" printer .



SYSTEM REQUIREMENTS

PC40 with PC-PC program in ROM (Drive C:)
PCA40 serial transfer cable. lvie part #725.

IBM PC® or compatible with:
CGA color graphics capability with Monochrome or Color monitor
Serial port (may require a female/female gender adapter for #725 cable)
Printer port
Floppy disk drive
Optional Mouse
"Epson Compatible printer"
PC40 to PC program on floppy disk.

MANUAL CONVENTIONS

Throughout this manual we will be using the expression <cr> (which stands for
carriage return). Whenever you see <cr> it means you should press a certain key on
your computer. Depending upon the labeling of your computer press either the
"RETURN" or "ENTER" key when you see <cCr>.

Bold type is used to indicate that you are to enter, via the keyboard the bold printed
items, into the computer. You will see text appearing in bold type along with
instructions to type the commands into the computer.

SOFTWARE INSTALLATION

As always it is good practice to make a backup copy of all progam disks. So take a
minute right now to make a copy of the PC40 to PC program disk. It is not copy
protected.

You may run the program directly from the floppy disk or you may install it on your hard
drive. There are two files that are required for operation of the program. First, there is
the file "PC40.EXE", which is the actual progam file. The second file is "PC40.PRM"
which contains user supplied preferences or parameters for the program file. These
two files must always be in the same directory.

You will notice that there are other files on the disk. These are sample data files of
individual memories, memory blocks and record buffer files. You may use these files to
become acquainted with the graphing portion of the program. These files are not
necessary to the operation of the program and may be erased if desired.



FLOPPY DISK OPERATION

Running the program directly from the floppy disk requires no installation. Insert the
floppy into the default drive and type PC40 <cr>. Remember that <cr> means to
press the ENTER or RETURN key.

You will see a screen that is blank except for a menu bar at the top of the screen.
Please refer to the program operation section of this manual for futher details on
program operation. To exit the program and return to the DOS prompt, press and hold
the ALT key, while pressing the "Q" (for quit) key. Then press the <cr> key to return to
the DOS prompt.

HARD DISK INSTALLATION/OPERATION

- You will need to make a directory for the PC40 program. While in the ROOT directory of
your hard drive, type: MDIR \PC40 <cr>. Next type CD PC40 <cr> to change to
the PC40 directory that you have just created. Now place the backup copy of the PC40
to PC progam disk into the A: drive and type the following command: COPY A:*.*
<cr> This will copy all of the files on the floppy into PC40 directory on the hard drive.

You may desire to create a sub-directory in which to store the data files transferred from
the PC40. This will allow you to keep your PC40 directory uncluttered. You could
create a sub-directory for each "job" if desired. Let's say that we wish to create a
general sub-directory called "DATA" in which we will store our files. Type: MDIR
\PC40\DATA <cr>. We will show you how to access this directory from within the file
transfer program (see the Change Default Settings menu under the "File" heading).

HARDWARE SETUP
We will assume that your PC has been functioning properly as a computer with CGA
graphics and with an "Epson Compatible " printer.

We need to connect the PC40 to the PC. This is accomplished by using the serial
connecting cable for the PC40 (lvie part #725). The small round end of the cable is
connected to the RS-232 connector on the PC40. The flat rectangular end of the cable
goes the RS-232 serial port on the PC. Please note that you may need to purchase,
from a local source, a DB-25 gender changer (female to female) to allow the cable to
match the serial connector on the computer.

Some PCs have only one serial connector while some have more then one. Also a
serial connector may already be in use by a mouse. The PC40 to PC program will only
recognize serial communication ports one and two. So we must use port one or port
two for the serial connection between the two computers. The program will
automatically look to serial port number one for the file transfer data. You can use port



number two if that is more convenient but when you start the program you will need to
tell it to look at port number two. This is accomplished by typing the following when
starting the program: PC40 COM2 <cr> (COM2 stands for Serial Communication
Port #2). If you have an available serial port (one or two) connect the #725 cable to it
at this time.

What about the computer that has only one serial communications port and that port is
currently being used by a mouse? Well, you will need to share the port. If your
computer has only one serial port we will assume that this is port number one.

When you wish to make a file transfer, disconnect the mouse and restart the computer
by pressing the following three keys at the same time: Control (Ctrl), Alternate (Alt) and
Delete (Del). Now the computer will not see the mouse connected to the port as it
restarts and will treat it as an available port.

When using serial port one, start the program with the command: PC40 <cr> . |If
desired, you may quit the program after all the data has been transferred from the PC40
to the PC, then reconnect the mouse to the serial port and restart the computer as
described above. You can then start the program and have full use of the mouse. The
PC40 does not need to remain connected to the PC once data has been transferred.
The PC40 may then be returned to the field for other measurements.

USING THE PROGRAM WITH OR WITHOUT A MOUSE

The PC40 to PC program will support a mouse but does not require a mouse for
operation. This progam uses a pull-down menu system that lends itself to either mouse
or keyboard operation. The keyboard is always active even when a mouse is in use.

Mouse operation
Across the top of the screen are six menu headers. To gajn access to the commands
under the headers you must "pull down"” on the header to expose the commands
below. To "pull down" with a mouse, place the mouse cursor on the desired menu
header and click the left mouse button. This will expose all the menu items below that
header. To select a particular item, place the mouse cursor over the desired item and
then click the left mouse button.

As other windows are opened and menu items are selected, you will need to use the
same method of point and click. Some windows have a "close window" marker that if
pointed to and clicked upon will close that window without taking any action and return
you to the main menu. The "close window" marker is diamond shaped symbol located
in the top left-hand corner of the window.




When a graph is displayed on the screen and you wish to return to the main menu,
press the left key of the mouse.

There is a special note about using the mouse in the "Graph Comments Input Screen."
The mouse may be used to place the cursor in any of the fields that you wish to edit.
Locate the cursor and then click the left mouse button. Of special note is that when you
are finished editing and you wish to leave the screen, you must move the mouse
outside and below the "Graph Comments Input Screen"” and press the left mouse
button.

Keyboard operation

Across the top of the screen are six menu headers. To gain access to the commands
under the headers you must "pull-down" on the header to expose the commands
below. To "pull-down" a menu with the keyboard, press and hold the "Alt" key while
pressing the first letter of the desired menu item.

For example: To pull down the "File" menu, press and hold the "Alt" key while pressing
the "F" key. By the way, you need not worry about capitalization of the letter. The "
key could be used instead of the "F" key.

Now that the "File" menu has been "pulled-down" you can see all of the commands
under this menu header. You will note that the first menu item is highlighted. If you
pressed the <cr> (Enter or Return) key, that item would be selected. To select other
items in the menu use the up and down arrow cursor keys to highlight the menu item of
choice. After highlighting your selection press the <cr> key to select it.

There is a shortcut that can be used to select a menu item. You may press the key that
corresponds to the first letter of the desired menu item. For Example: To directly select
"Get Plot" press the "G" key. Again, capitalization does not matter. If there is more than
one menu item with the same first letter, then the first item will be selected with the first
press of the key, and the second item will be selected with the second press of the
same key and so on. This alphabetical selection shortcut only works in the pull-down
menus. It does not waork in other windows such as "File Select.”

The "Esc" key allows you to return to the main menu from other screens. For Example:
When a graph is displayed on the screen, the menu bar at the top of the screen
disappears. This allows maximum display area for the graph. To leave the graph and
return to the menu just press "Esc." Remember "Esc" returns you to the menu.




PROGRAM OPERATION

STARTING THE PROGRAM
Start the program on the PC by placing the program disk in the floppy drive or if you are
using a hard drive going into the PC40 directory of the hard drive and typing the

following:
If Serial Port One is connected to the PC40 type: PC40 <cr>

If Serial Port Two is connected to the PC40 type: PC40 COM2 <cr>

Instructions for operation of the program will be given using examples. The examples
will make use of the sample files included on the progam disk. An efficient way to
become familar with the progam is to follow along on your computer with the example.

SELECTING A MEMORY FILE (under the File menu)

The selection of a file to display begins with the "File" pull-down menu selection. After
the "File" menu has been pulled-down you will see two menu items related to selecting
a file. They are "Select Memory File" and "Select Record File."

If you chose "Select Memory File," you will be shown only files that contain data from
the PC40 memories. Files that have the extension of ".MBK" contain data from a block
of twenty memories. If a ".MBK" file is selected another menu will be shown that will
allow you to choose which one of the twenty stored memories you wish to display.
Files that have a ".MEM" extension contain only a single memory.

Remember that at the time you saved a file to a disk in the PC40 you were given the
choice of storing memories as a complete block of twenty or as an individual (single)
memory.

Lets pull-down the "File" menu and select "Select Memory File." Next the "File Select"
window will appear with two files: DEMO.MBK and DEMO.MEM. Select DEMO.MBK.
We will now see a listing of fourteen memories on the screen. The other six of the
twenty memories can be viewed by using the down arrow key to scroll them onto the
screen. We can now choose any of the twenty memories by highlighting the desired
memory and either clicking on it with the left mouse button or pressing the <cr> key.



You will notice that the "NOTE" you appended to the memory at the time of
measurement is displayed in the file select window. This is to assist you in choosing
which memory to display.

Let's select the memory titled "Singing in the lab isn't pretty." The program will now
display the curve on the screen along with other pertinent data. Remember that we can
return to the menu by pressing the "Esc” key or the left button on the mouse.

Selecting a single memory file (".MEM") follows the same process as above with
exception that you will not be shown a second screen from which to choose one of
twenty memories.

The above example continues with the next section of this manual. In preparation,
return to the menu by pressing either the "Esc" key or clicking the left button of the
mouse.

Now that we have retrieved a file, we can perform some operations on the graph of that
file.

ADD COMMENTS (Under the EDIT Menu)
The "Add Comments" heading under the "Edit" menu allows you access to the written
data located to the left and bottom of the graph screen.

If you wish to add, delete, or modify the documentation of a graph, select the "Add
Comments" function from the "Edit" menu. Let's try an example. Select the "Singing in
the ab isn't pretty" memory from the "DEMO.MBK" file. After it is up on the screen, return
to the menu (press "Esc or click left mouse button) and select "Add Comments”" from the
"Edit" menu.

You are now looking at all the data, notes, file name and comments that appear on the
screen with the graph. You can now modify this documentation. The first two lines at
the top of the screen allow you to enter your own company name so that it will appear
on the graph. The two lines for the company name will accept up to fourteen
characters. Editing is done with the cursor and backspace keys. All editing is done in
the overwrite mode. Keyboard entries will overwrite the existing data.

It is important to note that all orginal data contained in the ".MEM", ".MBK" or ".REC" files
will remain unchanged as all editing is performed only on the screen display.

You will note that the default company name is "IVIE A MARK IV CO." This name will
always appear on every graph screen unless you change the default setting. This can



be done under the "File" menu with the "Change Default Parameters™ function.
Detailed information on how to do this is in the "Change Default Parameters” section of
this manual.

Go ahead and overwrite "IVIE A MARK IV CO " with your own company name. To view
the changes, press the "Esc" key or move the mouse outside of the "Graph Comments"
window and press the left mouse button. You should now be looking at the graph with
your company name.

Now return to the "Graph Comments Input Screen" by returning to the menu and
selecting "Add Comments" under the "Edit" menu. As you edit any field ,the computer
will allow you to enter only the maximum number of characters per field. Any field that
appears on the "Graph Comments Input Screen" may be edited. There are three lines
of notes that may be entered below the word "Notes." Each of these three lines can
have up to seventy-five characters.

Go ahead and experiment by editing some notes on the screen and then viewing the
results on the graph screen. Remember that by pressing the "Esc” key or the left mouse
button you will go to the graph screen.

The above example continues with the next section of the manual. In preparation
return to the menu by pressing either the "Esc” key or clicking the left button of the
mouse.

SHOW TABULAR (Under the EDIT Menu)

Another function under the "Edit" menu is "Show Tabular." This function allows the
data of the currently displayed graph to be shown in tabular form. When the function
"Print Tabular" is exercised this data will be sent to the printer as formated on the
"Show Tabular" screen.

If you are following along with the above example, select the "Show Tabular" function
at this time so that you may view the tabular data. When ready, return to the main
menu by either pressing the "Esc" key or the left button on the mouse.

PRINT TABULAR (Under the EDIT Menu)

The tabular data that can be viewed by the "Show Tabular" menu item, may be sent to
the printer using the "Print Tabular" function. Before selecting this function make
certain that the printer is connected to the computer and is "on line" ready to print.

The tabular data that will be printed is from the currently displayed graph. Modifications
to the curve, such as "A" or "C" weighting, will be refelected in the tabular data printout.



If you are following along with the above example, select the "Print Tabular" function at
this time so that you may print the tabular data. Make certain that a printer is connected
to the computer and is ready to print. When finished printing, return to the main menu
by either pressing the "Esc" key or the left button on the mouse.

The above example continues with the next section of this manual. In preparation,
return to the menu by pressing either the "Esc" key or clicking the left button of the
mouse.

MODIFY CURVE (Main menu item)

There are several modifications that may be made to any displayed curve. A curve may
be modified to reflect "A" ,"C", or "Flat" weighting. Also a second curve may be added to
the graph if desired.

It should be noted that modifications to the curve do NOT affect the sound pressure
level data. The SPL data is not derived from the the octave or 1/3 octave data but
comes from its own detectors at the time of measurement. Weighting of the SPL
measurement can not be changed after the measurement has been taken.

A-Weight (Under the Modify menu)

You can change the "Weighting" of the currently displayed curve to "A" weighting by
selecting this function. If the curve is either "Flat" or "C" weighted it will be changed to
"A" weighting. The graph will then be re-drawn to refect the change in weighting. The
change in weighting will also be reflected in the tabular data of the curve should it be

displayed or printed.

C-Weight (Under the Modify menu)

You can change the "Weighting" of the currently displayed curve to "C" weighting by
selecting this function. If the curve is either "Flat" or "A" weighted it will be changed to
"C" weighting. The graph will then be re-drawn to refect the change in weighting. The
change in weighting will also be reflected in the tabular data of the curve should it be
displayed or printed.

UN-Weight (Under the Modify menu)

You can change the "Weighting" of the currently displayed curve to "Flat" weighting by
selecting this function. If the curve is either "A" or "C" weighted it will be changed to
"Flat" weighting. The graph will then be re-drawn to reflect the change in weighting.
The change in weighting will also be reflected in the tabular data of the curve should it
be displayed or printed.



If you are following along with the above example, select one of the modify functions at
this time so that you may view the effect on the curve. When you are ready, return to
the main menu by either pressing the "Esc" key or the left button on the mouse.

Add Second Curve (Under the Modify menu)

A second curve may be plotted along with the first curve for purposes of comparison.
When you use this function you will be brought back to the main menu so that you may
access the "File" menu. When you pull down the "File" menu you will notice that only
the "Select Memory File" and "Select Record File" functions are active. You would then
go through the same selection process as you did for the first curve.

Because the first curve selected sets the display range of the graph, some thought
should be given in advance as to which curve will be plotted first. '

As with the first curve that was plotted, the second curve will be plotted with a data
marker at all data points. However, a different style of data marker will be used to help
differentiate between the two curves. '

If you are following along with the above example, select the "Add Second Curve"
function at this time so that you may view the effect upon the curve. When you are
finished, return to the main menu by either pressing the "Esc" key or the left button on
the mouse.

Delete Second Curve (Under the Modify menu)

This function will cause the currently displayed graph with two curves to be redrawn
without displaying the second curve. This will delete the second curve and restore the
graph to just one curve.

If you are following along with the above example, select the "Delete Second Curve"
function at this time so that you may view the effect upon the curve. When you are
finished, return to the main menu by either pressing the "Esc" key or the left button on
the mouse.

GRAPH (main menu item)
The curve may be displayed on one of three different graph formats.

Normal (Under the Graph menu)

Normal is normal. This is the standard amplitude versus frequency graph displayed as
a line graph. This is the default graph display. The graph will automatically set the
display range according to the data being displayed. Also the graph will be set for
octave or 1/3 octave display to match the data in the file.

RRE



Each data point is emphasized on the screen. A connecting line is drawn between
adjacent data points. At times there may be a data point that does not have an
immediate adjacent data point due to the constrictions of dynamic range (a filter may be
below the invalid data line). When this happens, a connecting line is not drawn to or
from that point. To do so would infer (to the mind) that data which does not exist; exists.

To return to the menu from the graph function press either the "Esc" key or the left
mouse button.

NC (Under the Graph menu)

Noise Criteria provides a means whereby ambient noise levels in rooms may be
quantified. A reading of the noise in the room is made in octave bands. The NC
overlay is then used determine the NC rating for the room.

When this graph function is selected, an overlay appears on the screen over the normal
graph. Also the NC rating for the curve is calculated and displayed on the screen. The
overlay is an integral part of the plot, and will appear along with the curve when the
"Print" or "Save Plot" functions are used.

To return to the menu from the NC graph function press either the "Esc" key or the left
mouse button.

If you are following along with the above example, select the the "NC" function at this
time so that you may view the effect upon the curve. When you are finished, return to
the main menu by either pressing the "Esc" key or the left button on the mouse.

PNC (Under the Graph menu)

Prefered Noise Criteria provides a means whereby ambient noise levels in rooms may
be quantified. PNC and NC are related to one another in that PNC is a second
generation NC curve. You will notice that different weightings are applied to the noise
spectrum by the two curves. The PNC curves were developed after the NC curves.

A reading of the noise in the room is made in octave bands. The PNC overlay is then
used to determine the PNC rating for the room.

When this graph function is selected an overlay appears on the screen over the normal
graph, and the PNC rating for the curve is calculated and displayed on the screen. The
overlay is an integral part of the plot, and will appear along with the curve when the
"Print" or "Save Plot" functions are used.
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To return to the menu from the PNC graph function press either the "Esc" key or the left
mouse button.

If you are following along with the above example, select the the "PNC" function at this
time so that you may view the effect upon the curve. When you are finished, return to
the main menu by either pressing the "Esc" key or the left button on the mouse.

At this point we would like to conclude our example/demonstration of the PC40
program.

File (main menu item)

The "File" menu contains those functions that allow us to retrieve and save various files.
We can select files for viewing that we have transferred from the PC40. We can also
select files that we have created and saved as completed graphs.

The "File" menu also contains the utilities for the program. These utility functions
include: Printing, File transfer, and setting program default parameters.

Select Memory File (under the File menu)

The selection of a file to display begins with the "File" pull-down menu selection. After
the "File" menu has been pulled down, you will see two menu items related to selecting
a file. They are "Select Memory File" and "Select Record File."

If you choose "Select Memory File" you will then be shown only files that contain data
from the PC40 memories. Files that have the extension of ".MBK" contain data from a
block twenty memories. If a ".MBK" file is selected you will then be shown another
menu that will allow you to choose which one of the twenty stored memories you wish
to display. Files that have a ".MEM" extension contain only a single memory.

Remember that at the time you saved a file to a disk in the PC40 you were given the
choice of storing memories as a complete block of twenty, or as an individual (single)
memories.

Lets pull down the "File" menu and select "Select Memory File". Next the "File Select"
window will appear with two files: DEMO.MBK and DEMO.MEM. Select DEMO.MBK.
We will now see a listing of fourteen memories on the screen. The other six of the
twenty memories can be viewed by using the down arrow key to scroll them onto the
screen. We can now choose any of the twenty memories by highlighting the desired
memory and either clicking on it with the left mouse button or pressing <cr> key.

Lets select the memory titled "Singing in the Lab isn't pretty". The program will now
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display the curve on the screen along with other pertinent data. Remember that we can
return to the menu by pressing the "Esc" key or the left button on the mouse.

Selecting a single memory file (".MEM") follows the same process as above with
exception that you will not be shown a second screen from which to choose one of
twenty memories.

Select Record File (under the File menu)

The selection of a file to display begins with the "File" pull-down menu selection. After
the "File" menu has been pulled down you will see two menu items related to selecting
a file. They are "Select Memory File" and "Select Record File."

The "Select Record File" function provides access to any PC40 Record Buffer files that
have been transferred to the PC. All Record Buffer files are saved with a file extention
of ".REC." When you choose "Select Record File" you will be presented with a new
window titled "Select File,” with all record files shown in the window.

Should you need to exit this window without selecting a file you can do this by either
pressing the "Esc" key or by placing the mouse over the diamond symbol located at the
top left-hand corner of the window and pressing the left mouse button.

To select a file, highlight the desired file by using the mouse or the cursor keys. Once
the desired file is highlighted, select it by pressing the <cr> key or the left mouse
button.

Once a file is selected another screen will appear displaying the name of the file
selected along with the number of frames in the file. You will also be prompted for the
frame number that you wish to view. After you enter the frame number press the <cr>
key. The frame will be displayed in the normal graph manner. The graph may then be
modified or edited as desired.

SAVE PLOT (under the File menu)

The "Save Plot" function allows you to save to the disk, the currently displayed plot or
graph. After you have recalled a memory or record file and modified or edited the
graph you can save all of your changes to a new file. This new file will have a ".GRF"
(for graph) extension on its file name and is a completly different file from the memory
or record file. The original memory or record data file remains totally unchanged.

When you select the "Save Plot" function another screen will appear, prompting you to

enter a name for the new Plot file. The name of the currently displayed memory or
record file will be shown where you are to enter the file name. You need not enter a
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new file name if you do not desire to do so. You may elect to use the same file name
for the Plot as is used for the data file. To do this just press <cr> (the Enter or Return
key) and the Plot filename will be the same as the data filename, but with a ".GRF"
extension in place of the ".MBK", ".MEM" or ".REC" extension.

A new or different name may be assigned to the file by typing in the desired file name.
A file name may have a maximum of eight characters. The program will not allow you to
type the file extension. The file will automatically assign the ".GRF" extension to the
filename.

If you assign a file name that is already in use, the program will prompt you with
another screen informing you that a file already exists using that filename. You will
then be prompted to either overwrite the existing file, rename the file you wish to write,
or abort the entire procedure.

The "Save Plot" function is not available for use until after a graph has been displayed
on the screen. This, of course makes sense in that you cannot save a plot to disk if a
plot does not exist. '

If you were to examine the "File" menu when first entering the program, you would
notice that the "Save Plot" and "Print Plot" functions would be displayed in a different
screen attribute than the other headings. This denotes that they are not available at
this time. After a plot has been displayed, the screen attributes of these two functions
will change to have the same screen attributes as the other functions.

GET PLOT (under the File Menu)

The "Get Plot" function allows you to retrieve and display files that have been saved
using the "Save Plot" function. When you choose "Get Plot" you will be presented with
a new window titled "Select File" which will display a listing of all files with a ".GRF"
extension.

Should you need to exit this window without selecting a file you can do this by either
pressing the "Esc" key or by placing the mouse over the diamond located in the top
left-hand corner of the window and pressing the left mouse button.

To select a file, highlight the desired file by using the mouse or the cursor keys. Once
highlighted, select it by pressing the <cr> key or the left mouse button.



Print Plot (under the File menu)

NOTE: The DOS command "GRAPHICS" must be used (Installed) before proper
graphics printing can occur.

The "Print Plot" function sends the currently displayed graph to the printer for printing.
The printer must be compatible with Epson printer commands. Even an Epson
MX-series computer will work with the program.

The plot or graph of the curve will be printed as it appears on the screen. The screen
will be printed length-ways on the paper so that the aspect ratio of the paper and the
screen more closely match.

In order for the computer to send the proper commands to the printer the DOS
command "GRAPHICS" must be installed in the computer. The print-out of the graph
screen contains two types of information. There is the graphics portion which is the
graph and curve. Then there is the text portion which is all of the comments and
documentation at the left and bottom of the graph.

If you use the "Print Plot" function and only the text portion of the screen is printed, then
you have not invoked the DOS command "GRAPHICS" on your computer. This is
easily accomplished by quitting the program and returning to the DOS prompt and
typing: GRAPHICS <cr>. Then restart the program and try the "Print Plot" function.

TRANSFER DATA FROM PC40 (under the File menu)

There are two programs that must be run at the same time in order to effect a file
transfer. One is on the PC40 and other is on the PC. The two computers must be
connected as described in the hardware set up section of this manual.

Lets start the program on the PC40 first. Turn the PC40 ON and while in the normal
analyzer mode press the red QUIT button. You will now see a listing of programs on
the C: or ROM drive. Use the cursor (arrow) keys to highlight the program "PC-PC
BAS." Now press the red RETURN key. The program will run and provide you with the
message on screen "Waiting for link." The PC40 is now ready to send files to the PC.

Now start the program in the PC by typing PC40 (or PC40 COM2). After the menu
appears at the top of the screen pull-down the "File" menu and select "Transfer Data
from PC40" and press <cCr>.



The screen on the PC will now display the following:

"Opening COMT1 for Link with PC40" (note that it may say COM2 in lieu of COM1)
"Attempting Link with PC40"

Once the link is established the screen will be updated to display:

"Opening COM1 for Link with PC40"
"Attempting Link with PC40 - Link Established"
"Enter PC40 File Specification for Directory A:*.M??"

You are now being prompted to enter a file specification. The program wants to know
from what source and what types of files you wish to display. The source of the file is
determined by the drive, and the type of file is determined by the extension of the file.
Remember that files may be stored on any of the drives listed below.

Specification Drive type

RAM disk

Floppy disk drive
Floppy disk drive
Floppy disk drive
Floppy disk drive
Microcassette drive

TOMMO»

You will notice that there is a default file specification loaded into the prompt. If you
pressed the <cr> key, at the prompt, the program would act upon this specification
A:*.M??." Lets take a moment and examine the default file specification.

The "A:" specifies that we want to read the directory of files on the RAM disk which is
disk drive "A:". The "*.M??" specifies what type of files we want to view in the file
directory. Remember we have three different types of files as listed below.

File Extension Type of File
".MBK" Memory Block of 20 memories
".MEM" Single memory
".REC" Record Buffer file

The ".M??" makes use of what is called wildcard characters in the file specification
process. The "" means give me any filename with the following extension. The



extension ".M??" means give me all flenames with extensions that have the letter "M"
as their first letter. The "??" hold the place for the other two letters in the extenstion and
are also wildcards. So the file specification "A:*.M?? will request the directory of ALL
files (regardless of their filename) on the "A:" drive that have a ".MBK" or ".MEM"
extension.

You may use the default file specification by pressing the <cr> key or you may enter
your own specification by typing over the default spec. A spec of ".*" will allow you to
view all available files. A spec of "*.REC" will show you only the record buffer files.

This shows you a directory of filenames that meet your specification and does not
actually transfer any files. These files will be displayed in the "File Directory" window
on the PC.

Once in the PC40 File Directory window you can select which file you would like to
transfer to the PC. You select the file by highlighting it with either the mouse or cursor
keys and pressing the <cr> key or left mouse button. You will notice a file called "ALL
Files" in the window. This allows you to transfer all the files in the directory with one
command.

Once an individual file or "ALL Files" has been iniated, the screens of the PC40 and PC
will display the progress of the transfer process. After a file is transferred, the PC will
again show you the PC40 file directory window so that you may select another file to
transfer. If you are finished transferring files, then press either the "Esc" key or click the
mouse on the close window symbol to return to the main menu.

To return the PC40 to the analyzer mode, press the red QUIT button to quit the transfer
program. You should now see a screen with a listing of programs in the various drives.
The program "C:PC40Vxx COM"(xx varies with release #) should be highlighted. This
is the program that runs the computer as an analyzer. With the "C:PC40Vxx COM"
program highlighted, press the <cr> (Return) key start the analyzer.

What happens when you press the red QUIT button and you do not return to the
screen that was described above. Instead you see something like "DT Error in 30"
followed by the prompt "Ok." If at anytime you see a screen that you are not familar
with, and it has the word "Ok", you are in the BASIC programming section of the
computer. The PC40 portion of the file transfer program is written in BASIC.

The way to exit BASIC is to type in the word System and press <cr>. This will return

you to the screen displaying "C:PC40Vxx COM". Now press the <cr> key once more to
start the analyzer.
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The PC40 may be disconnected from the PC one at this time. The PC40 is no longer
needed by the PC.

Change Default Parameters (under the File menu)

There are two default parameters that can be set by the user. These parameters are
stored in a file called "PC40.PRM" This file must always be in the same directory as the
"PC40.EXE" program.

When this function is selected you will see the following information displayed in the
window:

Current Path Spec to IBM Data Directory=
Enter New Path for IBM Data Directory- (a flashing cursor will appear here)

Notice that the space after "Current Path Spec to IBM Data Directory=" is blank. This
indicates that it is currently set to the same directory as the "PC40.EXE" program. Any
time the program looks for a file or goes to store a file it will look at the directory that
contains the "PC40.EXE" program. We will call this the default directory.

The sample files that came with the software are stored in the default directory. If you
change the default directory and you wish to access these files you should copy them
over to the new directory.

Now, what about the flashing cursor at the end of the prompt:
Enter New Path for IBM Data Directory- (a flashing cursor will appear here)

If you press the <cr> key without entering a new path, then nothing will be changed.
The default directory will remain unchanged. Lets say that you wish to store and
retrieve your data files from a sub-directory, under the "PC40" directory. You wish to do
this so as not to clutter your PC40 directory. We will assume that you have already
created a sub-directory called "Data" using the DOS command MDIR\PC40\DATA
<cr>. Then, at the prompt, type the following:

Enter New Path for IBM Data Directory-\PC40\DATA <cr>

Now every time the program does anything that requires a file, it will only act upon files
found in the \PC40\DATA directory. It will not know about any other files located in any
other directories. You could create a separate sub-directory for each job that you
perform.



Keep in mind that in order to use a different sub-directory two things must take place.
First you must create a sub-directory in DOS for the data. And second, you must tell the
PC transfer program about the new directory using the "Change Default Parameters”
function.

Once you have taken care of the Directory prompt, you will see the next prompt:

Current Company Name 1=lvie
Enter New Company Name 1 - Ivie (with a flashing cursor over the "I")

Unless you want lvie's name to appear on all of your graphs, type in the name of your
company. The "Name 1" line will accept up to fourteen chatacters. There is also a
"Name 2" line that will also accept fourteen characters, so don't worry if your company
name will not fit on "Name 1" line.

After entering the name of your company, press the <cr> key. You will now see the
prompt:

Current Company Name 2= a MARK |V CO.
Enter New Company Name 2 - a MARK IV CO.
(with a flashing cursor over the "a")

If a second line is needed for your company name, enter it at this time. If you wish to
have this line appear blank on the screen then enter a series of spaces to overwrite the
existing name. Now press the <cr> key.

At this point the program will save the default parameters that you have entered in the

"PC40.PRM" file. The program will then refer to this file any time file or company name
information is required.
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Geting Started with Your PC40 Disk Drive(s)

READ THE MANUAL {when all else fails)

The manual titled "User’s Manual for the PF- 10 Portable Floppy Disk Drive for Epson Geneva”
contains the nitty-gritty blow-by-blow description on preparing the disk drive for use. If you
have read the manusl and followed its instructions, the floppy drive should be set as Drive "D”
or Drive "F" and it should be connected to the PC40 via the *#726 cable. Also the batteries have
been installed and are charging at this time.

It you have not read the above manual you will need to do so before proceeding.

If are going to use two drives with the PC40 then | hope you paid particular sttention to page 14
of the drive manual on using two disk drives. |t describes how one drive must be designated a3
"D" and the other drive designated as “F". 1t tells you how to remove the battery pack to gain
access to the DIP switches so that their drive designation can be set. If you sre only usingone
drive than there i3 no need to change its designation as they come factory set to Drive "D”.

YHATS NEXT?

If you have not already done 36 please turnon the FC40 and PF-10Q. Place the PC40in the
snalyzer mode with the normal display on screen. The following instructions wm take you from
this screen out to the drive and back into the analyzer screen.

1.0n the PC40 press the red button labled "QUIT". This will take you out of the analyzer mode
into the MENU screen of the computer. You will see displayed in this screen the applications
programs for the computer. You should see the analyzer programs C:PC 40Y>’X LCOM (the
Tetters XX will be numbers on your screen) andB:BASIC.COM

The C: in front of the PC40XX.COM program indicates that the program is stored in the “C"
drive which is the internsl ROM Capsule 2. This is the program that runs the analyzer.
The B: indicates that Basic i3 stored in the "B drive which is the internal ROM Capsule 1.

2.0n the PC40 press the UTILITIES/ESC button. This will take you out of the MENU screen and
into the CCP screen. This screen is displayed when the system is operating in the CP/M mode.
In this mode you can execute CP/M commands or application programs.

You will see the CP/M "prompt™ at this time. The "prompt” is the letter of the current drive
followed by ">" greater than symbol. More than likely the prompt will be "A>" indicating
that the current drive is "A™ which is the internal RAIMDISK of the computer.

3. Insert the disk labeled "PC40 Utilities” into the PF- 10 that has been designated as the "D”
drive. Then type "D:" (do not include the quotation marks) inte the computer and press red
RETURN key. The prompt on the screen should now be "D»>". This shows that the computer
now recegnizes the "D" drive as the current drive. '



4. Now type "DIR" {without the quotes) and press the red RETURN key. DIR stands for
directory and reads the directory or listing of all files on the disk and prints them onto the
screen of the computer. If there are too many files to fit on the screen; thenas files are
pri nted to the bottom of the screen other files will be scrolled off the top of the screen.

Mot to worry, the files that scrolled off of the screen may be reviewed by pressing the
UPARROW key while holding down the SHIFT key. You can scroll down the screen by using the
DOWHNARROW key while pressing the SHIFT key.

You now have listed on the screen all of the files that are on the utilites disk. There are
several files on this disk but we are only concerned about the "COPYDISK" file at this time.

FORMAT THE DISK BEFORE BACKUP

It is always prudent to make a copy of your software and then store the original disk in a safe
place. |f anything happens to the copy then you have the orginal from which to make another
copy. The process of copying your PC40 utilities disk will allow to learn the pocedures for
formatting a disk and copying a disk. We first need to format a disk before we can copy data onto
that disk.

1. At the "D>" prompt type "COPYDISK™ (no quotes) and press the RETURN key. This will load
the COPYDISK program from the utilities disk (on drive D) into the computer. You will then
be prompted with the question "How many drives connected”. Pressthe "1" key and then the
RETURN key if you are using one drive. If you are using two floppy drives then press the "2°
key and then the RETURN key. Remove the utilities floppy disk from the drive at this time.

2. You should now see a menu with the prompt "Select COPYDISK operation”. Before we can use
a new disk we must prepare it for use with a process called for matting.

So, press the "1" key and then the RETURN key to select the for matting operation from the
menu. You now need to press the "D™ keyand then the RETURHM key to select drive "D".

3. In response to the instruction on the screen, insert a new floppy disk into drive "D". ¥fith
the floppy to be formatted in the drive, press the RETURN key to start the formatting
process. ,

4. Once the disk is formatted the screen will show the prompt "Repeat with new diskette(s)
{(¥/N) 27 Now would be a good time to format some additionsl disks for the PC40. You will
need one disk to copy the utilities program onto and at 1east one more for data file storage
from the analyzer. So press the "Y™ key to format another disk. You will repeat the above
formatting process on a new disk.

S. Whén you are finished formatti ng press the "N” key followed by the RETURHN key. You will
then be asked if you wish to “exit or Continue COPYDISK (X/C)?". Press the "C” key to
continue with the copydisk program in order to make a backup copy of your utilities disk.

6. Youare instructed to "Insert Source diskette.”, this is the disk you wish to have copied. So
insart your PC40 Utilities Disk into the drive. NOTE! That in order to prevent any accidental



writing on, or erasing of, your PC40 utility disk, please make certain that disk is "write
protected.” Instructions for write protecting your disk can be found on page one of the DISK
UTILITES SOFTWARE manual for the PF-10.

7.5tart the copyi ng' process by preési ng the RETURN key.

8. At the screen prompt, remove your PC40 utilities disk and replace it with a disk that you
have formatted for this purpose. Now press the RETURN key. Data that was copied from the
first disk and stored in the computer's R&M i3 now being written onto the new disk.

You will need to swap the original (source) disk and the disk being copied to{destination disk)
in and out of the drive until all the data is transfered to the new disk. You will be prompted
by the computer for each swap.

IT you have wondered whether or not to purchase a second disk drive, the dlskcopg experience
might help you with that decision.

9. When the copy pocedure finishes, press the QUIT key to exit from the copydisk pregram and
return to the MENU screen. You should see the two spplication programs C:PC40YXX.COM
{the letters XX will be numbers on your screen) andB:BASIC.COM .

- The C:PC40¥XX.COM program should be highlighted. To return to the analyzer press the
RETURN key. You should now be back into the analyzer.

You now have a backup copy of your PC40 utilities disk and one or more formatted disks read
for data storage. v

USING YOUR PC40 DISK DRIYE FOR DATA STORAGE

The PC40 can generate threa different types of data files. Each of these different files can be
stored to a "DRIYE". The PC40 can store the data to one of three different drives. Thereis the -
floppy disk drive that we have been reading aboutin the above sections, there is the RAM disk
drive which is interal to the PC40 and there is the Tape Cartridge drive.

Ye will concern ourselves with only the floppy disk drive in this section of the manual. The
floppy disk drive has the capacity to store up to 320K bytes of data in a8 maximum of 64
different files per floppy disk. It is portable and battery operated so it can be easily used on
the jobsite.

TYPES OF FILES '

* The twenty memories in the PC40 can be stored to disk either as a single individual memories
or as a block of 20 individual memories. When stored &3 a block, all 20 memories are stored
to the disk under one filename. YYhen they are recslled into the PC40 they will replace the
twenty memories currently residing in the PC40.

This enables you to store and recall your most frequently used reference and off3et curves



with little effort. At the conclusion of your job you can transfer the data from the memories

to a data file on the disk drive.

There is also the ability to store single individual PC40 memories to the disk drive. Whensa
single' memory is recalled from the disk to the PC40 you are required to assign ita
particular memory in the PC40. 4

_ The data stored in the record buffer can also be written to a file on the ﬂophu disk. RT60

decay files, which are a special form of record buffer files may also be written to the floppy
disk.

When 8 file is named by you and stored to a disk, the computer automaticaly appends an
extension to the filename designating the type of file. For example, if the file i3 a block of
twenty memories and you give it the name of "LCHURCH™ the computer will add the extension
of “.MBK "(for Memory BlocK). When you view the file in the directory the name will
appear a3 "LCHURCH.MBK". If you store a single memory, the extenstion of ".MEM"

{ MEMory) will be appended to the filename. In the case of an Record buffer or RT60 file,
the extension of ".REC" (RECord buffer) will be appended to the filename.

HOYf TO STORE A FILE TO THE FLOPPY DISK

Firstof all, the PC40 and the PF- 10 disk drive need to be connected together as was done for
the formath ng and copying of disks a3 described above. You will also need a formatted disk on
which to store the data.

If you do not have a for matted disk or do not know how to connect the computer and disk drive
together, then go to the section of the manual titled "Getting Started with Your PC40 Disk
Drive(s).”

STORE A BLOCK OF 20 MEMORIES TO THE FLOPPY DISK.

3.

For our first data store operation lets the 20 memories to the disk. It does not matter how
many memories in the computer you have used to store data. The block store will store blank
memories as well as memones mth data. It will even store 20 blank memories if that is
what you have.

. Whilein the analyzer mode press the UTILITIES key. You should now be looking at the utilites

menu screen.

. Now press the PF1 function key to get into the SAYE utility. You will now see the menu for

the SAYE utility.

Press the letter “M" on the keyboard to select the "MEMORY BLOCK (all 20)"

4. In response to the question "Which DRIVE?" you will need to press the letter "D" or the letter

“F™ on the keyboard depending upon which drive you wish to 3end the data. If you have only
one drive and you have not changed the factory preset of the DRIVE designation, then type the



letter "D". If you are using two drives than you may need to press either "D"or "F".

5. Make certain that the PF- 10 disk drive is turned on. Otherwise you will get-anerror

message when you try to save to the disk.

The screen is prompting you to enter a name for the file. This is the name that will show on
the disk directory when go to recall the file. The filename can be up to eight charactersin
length. The computer will not allow to enter more than eight characters for the filename and
the first character of the filename must be letter, it cannot be a numeral.

Enter a filename at this time and press the RETURN key to save the file to the disk. The file
will be written to the disk at this time.

. At the completion of the file writing procsss, the SAYE utility screen will appear. At this

point you can elect to save other files to disk by repeating the above steps or to exit to the
analyzer mode. You can exit bsck to the UTILITY screen by pressing the UTILITY key. To get
back to the analyzer screen press the UTILITY key one more time.

RECALL A BLOCK OF MEMORIES FROM THE FLOPPY DISK TO THE PC40

™

3.

Before you can recall a block of memories from the floppy disk it is assumed that you have
resd and followed the above instructions on stering a block of memories to the disk. The
process of recalling memories from the disk drive to the PC40 is very similar the process
used orginally to store them to the disk.

First of all, the PC40 and the PF~-10 disk drive need to be connected together as was done for

_the formatting and copying of disks as described above. You will al30 need s disk on which
."data has been stored.

. While in the analyzer mode press the UTILITIES key. You should now be looking at the utilites

MEeny screen. .

. Now press the PF2 function key te get into the SAYE utility. You will now see the menu for

the LOAD utility.

. In response to the question "Which DRIYE?™ you will need to press the letter “D” or the

letter-"F" on the keyboard depending upon which drive you have placed the disk with the data.
If you have only one drive and you have not changed the factory preset of the DRIVE
designation, then type the letter “D". If you are using two drives than you may need press
either "D"or "F". '

Press the letter "M” on the keyboard to seiect the "MEMORY BLOCK (all 20)".

4. The screen will show you a directory of a1l memory block {.MBK) files on the disk. Motice

that one of the files is highlighted in inverse video. This indicates the file that will be loaded
into the computer when you press the RETURN key. Use the the ARROW keys to select the file
that you wish to load and then press the RETURN key.



5. The screen will show the words “LOADING FILE™ and "DATA in MEMORY will be
OYERWRITTEN! Do you wish to continue? (y/n). This notice is telling you that whatever you
have in the 20 computer memories i3 about to be replaced {or overwritten) by the files on
the floppy disk. This provides a chance for you to abort the process for any reason. Hormally
you will press the "y~ key to continue the loading proceess. If you press the "n” key than the

process will be aborted and the memories in the computer will remain as before the loading
process was started.

After you press the either the "y” or "n" key the computer will return to the UTILITIES
menu.

SINGLE MEMUORY AND RECORD BUFFER STORE OR RECALL

* The process of storing and recalling either a single memory or record buffer is very similar
to working with the twenty memory block. We will not go into detail on the process for these

two procedures but would reccommend that you refer to the above sections on storing and
recalling the twenty memory block. -



INFORMATION ON PC40 UTILITIES SOFTWARE DISK

A variety of software is supplied on the "PC40 UTILITIES” disk that is included with the PF-10
disk drive. Some of the programs are standard utilities for use with a CP/M computer. Some
are specific application programs for the computer portion of the PC40. Other programs are
written specifially for the PC40

Some of these programs are useful only to someone with a background in programming and/or
CP/M computers. We recognize the technical expertise of some of our customers so we have
included these programs on the disk. Cetec Ivie does not maintain the resources to provide
training and support for these types of programs, they are supplied soley a3 a resource for the
user.

Some of these programs such as HXEDIT (a word processing type program) are public domain
and are supplied a3 convienence to our customers. We neither endorse, reccommend or provide
support for these programs. They stand on their own merits - besides, the price is right.
There is however, documentation provided on the disk for the HXEDIT program.

Many of the programs are supported with documentation either in the Epson HX-tiEl OPERATING
MANUAL or the PF- 10 USERS MANUAL. Cetec Ivie will endeavor to the assist the user , as time
and resources allow, with these programs.

There are several programs written in BASIC as examples of how to extract data from PC4Q0 files
or to support certain PC40 sccessories. These programs are not complete applications

pregrams but provide an example or program “kernel” that the user can build upon and
incoporate into his own programs. |t is assumed that the user is familiar with the BASIC
programing language and i3 capable of writing his own programs. Cetec lvieis willingte ~
provide limited support to such users in helping them to understand the data format and its
conversion process for use in such programs.

STANDARD PROGRAMS
The following programs are supplied with documentation in the HX- 40 OPERATION MANUAL:
STAT
TERM
PIP
FLINK
CONFIG
In the manual they are refered to as being on the "Utilities ROM”. Because of $pace constraints,
Cetec Ivie has elected to supply these programs on the PC40 UTILITIES DISK.

The following programs are supplied with docurentation in the PF- 10 USERS MANUAL.
COPYDISK

XSUB Please note that in the PF~10 USERS MANUAL this programis refered to as DEXSUB.

TEXT EDITOR
HXEDIT is a public domain text editor type program. It has undergone several generations of
adaptation from the PXEDIT program. This program is supplied soley as a resource for our

users. There are two documentation files to help you with HXEDIT. Theyare HXEDIT.DOC and
PXEDIT.DOC .

To view the document files you must first be in CP/M operating aystem with the drive connected
and the PC40 UTILITIES disk indrive. You must also have the CP/IM prompt on the disk drive.
This would be dnve "D or dme ”F" Type in the filename HXEDIT and press return. This will
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If you have connected the PC40 to a printer you can print the decumentation by pressing the ESC
key followed by the "P" key. This is the HXEDIT command to print the document. You will be
prompted for some set up codes. ¥hen this occurs just hit the RETURN key at each prompt. The
document will then be sent to the printer. When you wish to leave the HXEDIT program press
the ESC key followed by the "Q" key(Q for Quit).

All files that carry the “.DOC" extension can be printed out using the HXEDIT program. You can
also print out any file with the ".DOC" extension by pressing and holding the CTRL key while
pressing the "P” key. This will send anything that appears on the screen to the printer. Then
use the CP/M command TYPE to display the desired file on the screen. Information on this
command can be found on page 2-79 of the HX- 40 OPERATING MANUAL.

BASIC APPLICATION PROGRAMS FOR THE PCA40 ,

There are three BASIC application programs on the PC40 UTILITIES disk. They are RECORD.BAS,
MEMORY.BAS and DMMTEST.BAS . You should note that all BASIC progrems have the extension of
".BAS” appended to them at the time they are stored to the disk.

RECORD.BAS and MEMORY.BAS were both written by Cetec |vie as an example of how to retrieve
data files into basic so that they can manipulated via user defined programs.

For more information print out the RECORD.DOC file which contains documentation on the

RECORD.BAS program. The information is this document can also be applied to the MEMORY.BAS
program.

The DMMTEST.BAS program is documented in the users manual that comes with the DI1M module
for the PC40. The DMM (Digital MultiMeter) is sn accessory plug in module for the PC40.

PROGRAMMERS® FILES

All other files on the disk are supplied as resource and a3 a convience for the users who have the
gbility to utilize them. Cetec Ivie cannot and will not provide support assistance for these
programs as they go beyond the'scope of the application of the PC40. '
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Basic and the PC40

The BASIC programming language that comes with the PC40 is very close
to the that found on an IBM PC or compatable. This manual assumes that
the reader has a working knowledge of that kind of BASIC. If this is not
the case, it is suggested that the reader first become familiar with
programming in BASIC through one of the many tutorials that are
commercialy available. This manual will not be teaching how to program
in BASIC, rather it will attempt to describe how to utilize the machine
language subroutines found in the PC40 program from BASIC. This will
bring out performance characteristics that BASIC could not achieve on {ts
own. This is however a two edged sword. Many of the machine language
routines have no error checking and there are rules that need to be strictly
followed. Lack of dilligence in these areas can cause program crashes that
could result in complete 10ss of data. To this end, the manufacturer, the
dealers, and the representives of the PC40 claim no responsibility or
liability for the programs run in BASIC by the user. Therefore the user
should check and recheck all programs created and or entered into the
PC40 before running them. The two major RULES to follow to prevent
CRASHING are these: 1. ALWAYS use INTEGER VARIABLES in the CALL
_ statements, and 2. ALWAYS be sure to check for CORRECT SPELLING of the
—#RTABLES used in the CALL statements. Failure to do either of these will
result in CALLING to 8 memory location where no programs exist or into
the middle of & program. Since the Z80 processor or its operating system
has no error trapping to prevent this very strange things can and will
happen and in these cases nothing in memory is sacred. As a final note
before getting started, the patches from BASIC to the PC40 program
routines have not been created and supplied to facilitate programming by
the manufacturer. Instead, they have been supplied so that the users of
the PC40 can create and customize their OWN programs. The manufacturer
and its representatives will be happy to answer questions where possible
and give examples of "HOW TO", but will not tailor programs for each and
every user.

Aow o Aoa Basic 7o refemmn |

’%‘/If/ovl s _/g

Getting Started

The subroutines used in the PC40 program have been made accessable to
BASIC by using the CALL statement. In every case CALLs will be made to a
machine language routine that has been down loaded beforehand to a
protected area of memory. This routine will bank switch memory over to
the ROM that contains the PC40 program, and will JUMP to the routine
needed. After the routine has completed its task, control is handed back to
the machine language routine first called where the BASIC ROM 1s bank
switched back in and control 18 handed back to BASIC where the next
logical instruction is executed.



PR 1=

,ﬁ“"i_/f\
7] |
)~ [ YEAR ”f\——/\
MONTH
DAY .
g HOURS Time & Date values } be & d'kb‘ﬂ*)
?

MINUTES are 1 byte each e Loy AN

BCD format /J/ 7
f— SECONDS /,?f//éaf 7 re ! 7o Foere )
pev | NOTE 40 bytes of
: ASCI| format
L - )

FITLERS Each channel is 2 bytes
signed binary LSB,MSB - Loy G conVansics-
60 bytes total i ek /

SPL 2 bytes unsigned binary
with 4 bit MSB mantissa \/\/

S i)

STaTuec— Status (setup) 1 byte each  —

_ =

F/ﬁ /(975 /=S

Lo



CLEAR AND GETTING LOADED Pacs o

The first statement that should always be run when BASIC is first started
is; :

10 CLEAR ,&H5E30

The statement number can be any number as long as it is the lowest or the
first thing basic does. Don't forget the comma just before the ampersand
symbol or the statement will not work. Now come the first caution; When
using the patch routines, NEVER initialize internal RAM disk allocation
larger than 26K. (Default value) RAM disk space also under lies the BASIC
and the PC40 ROM. If it is Intialized to larger than 26K, it will conflict
with the area normaly loaded by the machine language patch routine and
will be overwritten. This causes no problem for the machine 1anguage
routine but data residing in RAM disk can get clobbered. “The way to avoid
this 1s to check the sign on message in BASIC. If it shows less than 20313
bytes of free space then there may be & problem with RAM disk being too
large. If this is the case, the computer will have to be reinitialized or the
“CONFIG" utility run to reduce the RAM disk size to 26K. The second
statement that needs to be runis;

20 BLOAD"C:PC40BSUB.CIM"

This will cause the object file named "PC40BSUB.CIM" on drive “C:" to be
loaded starting at the address CLEARed by the first statement. It will not

only load the machine language routine, but will also load the default R

values for the analyzer and clear the memory locations used by the PC40
subroutines. These two statements once run will never need to be run
again as long as BASIC is in operation. If BASIC {s exited to go back to the
SYSTEM prompt, then all is lost including the BASIC programs and these
statements will need to be executed again when BASIC is reentered. Any
programs that were SAVEd to RAM disk will still be intact.

MEMORY AND VARIABLES

The PC40 subroutines use part of the memory protected by the CLEAR
statement as areas to keep variables. Variables that control the analyzer
when some routines are run to variables that receive data from other
routines. Control variables are used by POKEing a value in the appropriate
lacation and then calling the routine that exercises control using that
variable. The rest of the variables are used for storing or passing data to
BASIC programs usually by the PEEK statement. Listed below are the
variables used by the PC40 routines, their location, and the amount of
memory the variable addresses. Below each variable {s an explanation of
how the variable is used. In manu instances there are snecifir values that

A/M/"-
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WK
REFERENCE : Location &HSE35 - 1 byte PoKe ko7, 6 BpY
(Rerer®) Controls the gain of the analyzer and is set in relation to the QY
dB 1evel of the REFERENCE LINE /10. To set the REFERENCE LINE to 60 dB, R
poke this location with 60/10 = 6, then CALL the port setup routine. ¥hen v i
using the Microphone as input valid references can be 3 to 14. When using N >
the probe, valid references can be from 5 to 18. Defout7 =60 Z‘ D
DN
o )
DECAY : Location &HSE36 - 1 byte poKeE DecAY Yo, | X3

DECAY Controls the responge of the filter detectors. There are three

speeds; 1=slow, 2=medium, and 3=fast. Dpefaxf? /s Fast

SCALE : Location &HSE37 - 1 byte POKE SCALE 75,3
sekeZ Sets the resclution of the display screen. It can take on
values of 1,2, or 3 and corresponds to the dB/step. Defaw? 3a3/575 4

RESPONSE : Location &HSE38 - 1 byte
ResPOW7s  Controls the response of the SPL detector. Valid values are

1=fast, 2=slow, 3=peak, or 4=impulse. Defa/? = FAsT

- WEIGHT  : Location &H5E39 - 1 byte

we&477¢  Controls the SPL weighting and can also control the filter
weighting if the filters have been set to follow the SPL weightinq. Yalid

values are O=FLAT, 1=C WT., 2=4 WT. Defoust = /T  gee Dinplay b beleo

DISPLAY : Location &HSE3A - 1 byte

ospeaydy  This controls two separate items. First, it sets the filters to

OCTAVEor 173 OCATVE response. Second, it causes the filters to follow
the SPL weighting or sets the filters to flat response. 0=0CTAVE and
FLAT, 1=1/3 OCTAVE and FLAT, 2=0CTAVE and follows SPL weighting,

3=1/3 OCTAVE and follows SPL weighting. owpde, = peraks = 5 octore

MIC/PROBE : Location &HSE3B - 1 byte

micPRB%  There are two possible inputs to the analyzer. When this
location is 0, the input is taken from the 2P microphone input. Yalues of
1,2, or 3 will cause the analyzer to take input from the BNC Probe
connection. When set to 1, the SPL print routine will scale the SPL value
to dBM. When set to 2, the SPL will be scaled to dBY. When set to 3, the
value returned by the CONVERT routine will be scaled to AC volts. Pefou?

T4 SHET RECDRAT B @ xp2 0w toam

-MEMORY  : Location &HSE44 - 110 bytes  Formet'o Frgee -
This is the place where PC40 memories are brought back,
realtime converted data is stored, and where records from the record
buffer are returned. Hence, this area sees alot of changes and care must
be teken in CALLing routines so that importent dete residing there is

stored somewhere else before the CALL. The Memory area is dividedup

:5?1«

chl fwu—f}%

'fl)
]}J"ée'/{,mm ot
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into smaller areas depending on the routine CAlLLed and the tgpe of data.
PIEE &

These areas are as follows:

STAHMP : Location &HSE44 - 6 bytes

Here is the actual Time and Date Stamp created for 8 MEMORY
when the STORE button was pressed. It is kept in packed BCD format. If
this is a problem, be aware that these values are decoded by the memory
fetch routine and stored in another location which will be shown later.

NOTE : Location &HSE4A ~ 40 bytes

Here is the 40 character note for a memory that has been
returned by the memory fetch routine. It is kept in ascii format and can be
PEEKed into a string variable as will be seen later.

PIXELS . Location &HSES4 - 30 bytes

This is field is of little use to the user directly. It is brought
to light here to show thet it {s sharing the same space as NOTE. It is used
to store the number of pixels that are OFF in the bargraph on the screen.
The values can either be calculated by a routine or brought straight in as
is the case for a realtime sample.

FILTERS : Location &HSE72 - 60 bytes

Here is the values for each of the 30 filter channels. They are
kept in signed, binary format and are relative to the reference at the time
they were stored. They are also stored in LSB, MSB format which means
that the Least Significant Byte if first and the Most Significant Byte is
second. This means that there are 2 bytes/value and the values start with
25 Hz and end with 20 KHz. If this is & problem, there is an easy way to
return these values directly to an array predefined in the BASIC program.

SPL : Location &HSEAE - 2 bytes

The SPL data is also kept in binary format just as the filters
are with two exceptions. First, the value is unsigned and has a 4 bit MSB
mantissa. SAY WHAT? Don't worry too much this is also decoded
automatically by the SPL print routine. Plus there are easy to follow
BASIC statements that will be shown later to handle the decoding.

STATUS  : Location &HSEBO - 2 bytes
Compressed into these 2 bytes is all of the analyzer

parameters such as reference, decay, response, weighting, ect. Don't
MQ, there again is a simple wey to decode this information.
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THE ROUTINES

Here is where the fun begins. Consequently, this is also where the danger
begins so as a word of caution, BE SURE TO CHECK ALL STATEMENTS BEFORE
RUNNING THEM! To simplify the programming process another help has
been added besides the subroutine patch to the PC40 ROM. The program is
called "STARTUP.BAS" and also resides in the PC40 ROM which is known to
the computer as disk drive “C:". This program performs most of the
variable assignments for the machine language addresses and the locations
of the variables in the PC40 workspace area. Before looking at this
routine however lets get into BASIC.

Turn the analyzer on and Quit the PC40 application (program). Now should
be seen the CP/M prompt or MENU. If the MENU is in effect, place the
cursor over “B:BASIC.COM" and press return. |f the system is in the
PROMPT mode, then type in

B:BASIC.COM<CR> The "<CR»" means to press 'RETURN'.

The analyzer should now show the USER LOGIN MENU for BASIC. Pressing
the 'SPACE’ bar should login to USER AREA 1 with the ever-so-popular "0K”
prompt showing up in the left most column just under the BASIC sign on
message. |f you have failed to get this far then stop everything and refer
to the OPERATING SYSTEM MANUAL and the BASIC MANUAL that came with
the PC40.

Once safely in BASIC, type in the following;
LOAD "C:STARTUP.BAS"<CR>

The response on the next 1ine down should be “0K" with a flashing cursor
below the "0K". If the next line down says, "NE ERROR" and then displays
the "0OK" prompt, check the spelling of the line with LOAD on it. If
neccessary, move the cursor with the cursor arrows up to the mistake and
type over it with the correct spelling. If it is correct now, press ‘RETURN'.
If a1 has gone well, the “OK” prompt will write over where the "NE” used
to be and the response on th next two lines down will read,

“0K ERROR"
0K

Now type,

LIST<CR>



The program that was listed to the screen is devised to make all of the
PrPAEE &

normal variable assignments and declarations for the user. This program
can be altered end SAVEd or used to CHAIN to a user written program.
More about that 1aterl Now, lets use this program as a starting point and
add a little to it.

Read the last line of the program. it shduld read,
"630 CHAIN "PC40BAS™,,ALL"

Delete the line by typing,

DELETE 630¢CRy

Now type,

630 CLS:CALL PATCHB(DRAWSCRNZ)}CR> - praws
640 FOR 18=0 TO 1000:NEXT IB<CR> - o

Remember sintax (spelling) is very important; CHECK YOUR WORK! When
the program is correct tupe,

RUN

¥hat happens next is that you will think that the analyzer has gone back to

the PC40 program and in a way it has. Only after a second or two the PC40 >
screen will shift up one line and the "0K" prompt will be back indicating

that the BASIC program has finished it's task. Always include a clear

screen command before executing this routine or weird things can happen

such as the upper half of the screen on the bottom.

SCREEN DRAY ROUTINE

The routine uses the control variables to graphicailly construct a sckeletal
screen upon which other information can be overlayed such as the filter
channel data. Before that , however, lets take a minute to see what affect
the contro] variables have on the screen. Insert a new line of instruction

by typing,

625 POKE REFER®,3<CR>

RUN<CR> % w¥
%
By changing the valuas for the REFERence it should be changing the number v

that is printed by the REFERENCE LINE on the screen. Remember, only enter {67);1;,
those values that are valid. : &A

Now try changing "REFER®" to the variable "DECAYZ" and try the valid M“f ?"’A



v
How try changing "REFERZ" to the variable "DECAY®" and try the valid poke ?0*‘{ _

values. The decay indicator box on the righthand side of the screen should s"é“"
<R
of
POy N
be moving to the appropriate positions. W/sw'”

Now use the variables "SCALE®", "RESPONZ", "WEIGHT 3", "DISPLAYZ", and
"MICPRB®Z" and observe the result. Note, when changing “MICPRB®", the
result will be to change "SPL" in the bottom righthand corner to "DBM",
"DBV”, to "ACV".

ANALYZER CONTROL

All of the control parameters for the analyzer are handled by one routine,
but this routine has two entry points. The first entry point is used to
initialize the |/0 port adapters and then set the control lines going to the
analyzer. The second entry point 1s used for setting the control lines
without initializing. The reason for the two entry points 1s that once the
I/0 ports have been initialized, it is not necessary to do again unless the
analyzer has beenturned off: Also, during initialization of the 1/0 ports
:}K-,r\ e the control lines all go 1o a high state which will cause 8 momentary
L glitch in the audio circuitry of the analyzer. Before using this routine it is
\3..)” . necessary to be sure that the control variables contain the desired values.
l"i/)g/ when the machine object file "C:PC40BSUB.CIM" is 1oaded in the variables
A are set to a default value. The default settings are listed below.

Reference = 60 -
Scale = 3 dB/step >
SPL Responce = Fast
SPL Weighting = Flat
Filter Bandwidth = 1/3 Octave
Filter Weighting = Flat fn
Filter Decay = Fast f‘*"b/)
Input = Microphone (SPL) A { pex
Aop

o, S
The syntax for this command is, _vov™*?
o r
- CALL PATCHR(PORTRRE) = mfialipes porT ghthes awclio 1o anatsy .,
or :
CALL PATCHZ(PORT®)
The latter statement will set the control lines without intializing the 170
ports.
ﬂ”saby‘/""a"“ - - 7 T -

STATUS SETUP & RETURN

Before it was stated that thg analyzer setup was also encoded down into
two bytes called "STATUS". This is done 8o when data is stored, it does
not take up as much space. There are two routines that encode and decode: ~- -



" status bytes. The other goes the opposite direction and rewrites the
. PR 0

control variables based on the status bytes. These routines are used when
recalling data from memory or putting data into memory. In the first case
, after fetching 8 memory from the PC40, the status to variable routine
would be used to set the control variables to the state they were in when
the memory was stored. Afterward a screen would be generated and the .
data displayed just as it was saved. To use these routines they should L
Took 1ike this, i

\
kY

CALL PATCHZ(STATVARIZ) Converts STATUS bytes to Control Variables 2

\
A

or :
CALL PATCHRB(VARISTAT®) Converts Control Variables to STATUS bytes ,;f,,,n*/
DISPLAYING DATA

There are four routines that display data. They are Filter display, SPL
display, Battery display, and Screen Redraw. We have already seen how
screen redravw works. The other three routines are called in the same
manner as the Screen Redraw routine. However, there are no defauit
values for the other routines because they depend on data that has been
created by some means as recalling @ memory or taking a realtime sample.
Do not use these routines unless valid data exists. Failure to follow this
rule will possible cause a program crash. The syntax for these routines is,

CALL PATCHR(FLTDSP®) Filter bargraph drawing routine

and , >
CALL PATCH®(SPLDSP®) SPL prints in bottom righthand corner

and :

CALL PATCHE(BATDSP%) Draws bargraph indicator i n top right corner

TAKING A SAMPLE :
| .,)"““
The routine for taking a sample assumes that the analyzer has been turned 5 }’, d
on. Of course if this is not the case, the data returned will be garbage ke 4
although it will not cause the computer to crash. Before running this W~ 17)W 07
routine then it is necessary to have CALLed the analyzer setup routine. y‘”opf .

After having done so you can teke a realtime sample by doing,

CALL PATCH®(CONVERT®) ( 4o
re &
This will return the-retetive level of all 30 filterg) the SPL, and the level
of the Battery. This routine will use the same area as the memory fetch
and the record fetch routines so it assumed that any important data
residing there has been transfered elsewhrere. This routine is unigue in
that you dont need to calculate the height of sl the filter bars after the
routine is done. It does all that as part of the process. Using the routines

. ¥Weknow about this far, lets make 8 realtime analyzer program. Type in

$lam £V a2 o — - ——. —
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routine s done. It does all that as part of the process. Using the routines
we know about this far, lets make a realtime analyzer program. Type in

the following at the end of the "C:STARTUP.BAS" progrem. —

ol G2 .
% sz 61)'5\/
LOACE /.,
7.
630 CALL PATCHZ(PORTRE)
640 CLS:CALL PATCHZ(DRAWSCRNZ) %1 ’a;,imﬁ
650 CALL PATCHB(VARISTATS) -~ ‘l e LT
660 CALL PATCHB(CONVERTS) 5,5 154 3 3 1333
670 CALL PATCHZ(FLTDSP%) j L
680 CALL PATCHZ(SPLDSPE) LOCATE COORINATES
690 CALL PATCHE(BATDSPE) For. Annuncictoy windoos
700 GOTO 660 ' On PeHO Screen

Before typing ‘RUN<CR>" check your typing.

The result should be the PC40 action that you ere used to seeing. The only
exception is that it will not, at this point, respond to any of the keys
except for the ‘QUIT' key which will "BREAK" the program execution. Below
is an explanation of the program.

Line 10-620, sets up the variables for PEEKing, POKEing, and CALLing
Line 630, setsﬁtﬂg Er‘uglfl;zpr PL] and sets the control lines

Line 640, cledrs the Scréen 8nd draws the basic sceen graphics

Line 650, sets the status bytes = the variables (not necessary here but a
good practice

. Line 660, gets realtime data from the analyzer

Line 670, displays the filter levels

Line 680, displays the decoded version of the SPL

Line 690, displays the battery level

Line 700, 1oops the program back for more (indefinitly)
To Stop M the Quit hitlon

FETCHING A MEMORY

Returning a memory STOREd by the PC40 is just a little different than
vrhat we have seen so far. Beyond CALLing the routine to fetch the memory
vwe also need to tell the routine what memory number to get. This is done
by passing a second parameter in the CALL statement. "Passing a
parameter”; What is that? Well, so far, the CALL statements that have
been used are CALLing to an address in the variable "PATCH2". Then the
routine at that address CALLed takes the valus in the variable inside the
parenthesies as a “passed parameter” and jumps to the address that is
equivalent to the value “passed”. We add the second parameter like this,

CALL PATCHZ(GETMEMZ, NUMZ)

The first variable in the parentesies is the address of the GETMEMory
routine while the second variable is the number of the memory we want to
get back. The two variable must be integer and they must be separated by
a comma. The valid range for memories is 1 - 20. 1 - 10 would correspond
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inverted memories 1 - 9,0. Let see how this works by typing in these
SRS 12

statements at the end of "C:STARTUP.BAS". Note: Before doing this
program you might want to make sure there are some memories stored in
the PC40 or there won't be anything to recall.

o=t

41! 630 CLS:INPUT"SELECT A MEMORY NUMBER (1-20)";NUM® |
P 640 IF NUMB<1 OR NUM®>20 THEN 630 |

650 CALL PATCHZ(PORTR®)

660 OUT 37,INP(37) OR 126

670 CALL PATCHB(GETMEM®, NUMZ)

680 IF PEEK(STATUS1®) THEN 690 ELSE 630

‘690 CALL PATCHZ(STATVARIZ)

700 CLS:CALL PATCHE(DRAWSCRNS)

710 POKE REFBUFF®,PEEK(REFERE)

720 CALL PATCH®B(REFLOCAL®)

730 CALL PATCHRB(PTRCALS)(P/X¥c4c<c )
740 CALL PATCH®(FLTDSP®)

750 CALL PATCHZ(SPLDSP%)

760 K$=INKEY$:IF K$="" THEN 760

770 GOTO 630

Check your work before typing 'RUN<CR»’
You must have noticed that there were a number of CALLs and procedures
that have not been discussed yet. Well let's see what is hapening here.

Line 630, Prompting for memory number to get.

Line 640, Test input against limits to be sure the number is ok.

Line 650, Configure the ports. Even though the analyzer is not being used
this needs to be done so that the routine can address the RAM in the PC40.
Line 660, Turn the anlyzer power OFF. Not absolutely necessary but
helpful. Aotoe

Line 670, Get the memoryato display.

Line 680, Test STATUS byte #1 to see if the data is there. If data was
actually stored here then this location would not be zero. If this memory
is not active then there is nothing to display.

Line 690, Set up the control variables so the screen draw routine will
reflect theféfgfup when the memory was stored

Line 700, Draw generic PC40 screen.

Line 710, Set the original reference equal to the new reference. This is
done so that when the filter bar heights are calculated, they are figured on
the basis that they are being displayed with the original reference. To see
the data at a different reference, after executing Line 710 then reset the
variable REFER® to the desired reference/10. This must be done before
CALLing the routine REFLOCALZ on line 720.

Line 720, This routine sets the lower limit of the screen so the next
routine can calaulte how high to make the bars on the filter bargraph. The
result is not returned to BASIC, but is stored in work space for later
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_routine can calaulte how high to make the bars on the filter bargraph. The
result is not returned to BASIC, but is stored in work space for later

reference. P53

Line 730, Calculate how high to make each bar on the filter bargraph. This
must be done because unlike realtime, the pixel data for the height of the
bars is not readily available. Since it not stored it must be recalculated.
This feature allows the user to recalculate the filter bars for different
references and scales.

Line 740, The rest is the same as before except that the battery is not
displayed. This is simply due to the data not being kept. Who cares what
the battery was doing then, what matters is what it is doing right now
which is now then so again, Who cares?

Line 760, Simply a mechanism to hold the program up until your ready to
look &t the next memory. Again the program can be quit by pressing the
"QUIT® key.

NOTES AND TIME

The memories are all stored with a time and date stamp as well as a 40
character note. These are available, but the note needs to be read out of
work space memory before the pixel calculation takes place as that
routine shares space with the note area. To read out the note use the PEEK
command in & 1oop sch as this,

10 HOTES=""

20 FOR 18=6TO 45 / £ §
30 NOTES= NOTE$+CHR$(PEEK(MEMUR‘{%+ 7y

40 NEXT 1% T cepen sy al #aamm/w\_‘l

Line 10, clear any previous note.

Line 20, the note goes from position 6 to position 45 in the memory area.

Line 30, concatonate all of the characters. read ant adilto pofe sﬁfﬁ excl twihpidsl) chareA
Line 40, do al1 of the 40 characters.(spaces and all)

At this point the note$ can be : inted;
ever else you do with strings. 7herete ¥ safflir 51 “Com the M
/ ﬁy P’S(,caﬂ

The time and date are not over writtenyand can be directly read at memory
locations 0-5 relative to the value kept in MEMORY®. The time is kept in
BCD format, most significant to least. First is the Year, then Month, Day,
Hour, Minutes, Seconds. If BCD is scery to you then use the decoded values
placed in work space for you at the location kept in the variables YEAR®,
MONTHZ, DYZ, HOUR®, MINUTE®, SECOND®. The reason the variable DY® {s
spelled DAY® 1s that DAY 1s a reserved word to BASIC. To get a value out
of memory simply PEEK it. (ie. PEEK(YEARZ))

GETTING A RECORD

Fetching information back from the record buffer {s the sama as fetching a
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record checking exists The two things to keep in mlnd while using this
Forn PBasce Kerpo Frote .»b/ﬁt ﬁfc"“" 5 Recovebant PAES />/

routine is know beforehand the limits of the record buffer (Available RAM)
and know how many records have been put there. The range can take on
values from 0 to 8155. The statement to get the record would look like
this,

CALL PATCH®(GETREC®,NUMZ)

All of the same calculation procedures have to be done before you can
display the results.

c vo /&L /2
RECORDING RECORDS J””f J“ of 3 C ¥ A

za‘wiww#w“"fza/?‘a/vy e fice to

This routine will go out ancTFgcord what ever number of records it is told.
Using the rate specified by the control variables as well as the set up, the
routine will not return to BASIC until the 11mit specified has been reached.
Rate by the way, is a control variable that has not been priviously covered.
Pointed to by the variable RECDRATEZ, valid values that can be POKEd
there are 1 to 100. Any values outsdie this range will have unpredictable
results. the default is 30, which meand that the analyzer will take
samples at a rate of 30 spectral stores per second. One spectral store
includes all 30 filters, the SPL, and the two status bgtes Use of this
routine might look like this,

638 As=INPUTS(1)

630 CLS:INPUT"ENTER NUMBER OF SAMPLES":NUM® €4 (AL rCAHrECY, et
640 IF NUM$>400 THEN 630 €68 P FEFRRTY Pk ) )
650 INPUT"ENTER RATE TO SAMPLE"RATER RT 7 670 GAL PICE i)
660 IF RT<1 OR RT®> 100 THEN 636 s s €50 FR 17 0 10 A
670 POKE RECDRATER RATER KT % : 8 GAL MO
6680 CALL PATCHE(PORTRR) 7I8 CAL BT
685 CALL PATCHE(YARISTATR) BT
690 INPUT*PRESS ANY KEY WHEN READY":DUMMY$ 756 6010 78
695 CALL PATCHB(RECDE NUMSZ)
700 OUT 37, INP(37) OR 128 — 7%ans o=’ M %
__~705 POKE REFBUFE/PEEK(REFERS)
710 CALL PATCHZ(DRAWSCRNE) 7o Fem T
715 CALL PATCHZ(REFLOCALSE) sirs 7, 1wrl37) el 127

720 FOR 18=0 TO NUMZ

730 CALL PATCHB(GETRECR, 1)

740 CALL PATCHB(PHEALR) (» e 2 )
750 CALL PATCHE(FLTDSPZ)

760 CALL PATCHZ(SPLDSPR)

770 NEXT 1%

Much of this program should be readily understood when compared with
those given already. Therefore, only those statements that dlffer will be
dicussed.
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those given already. Therefore, only those statements that differ will be
dicussed. ‘

Line 705, the difference here is order in the program. It should be noted

PAsE s

that the original reference need only be set once if the data is not going to
be changing in reference. Likewise the lower screen 1imit only needs to be
calculated once if the data {s not going to be rescaled.

Line 740, calculation can be done without any more reference or screen
low limit calculations because the date is being displayed without any
rereferencing or rescaling.

What should happen during the execution of the program is the user will be
prompted for the number of sample to record and the rate at which to
record the samples. Then the program will wait for the user to press a
key. After the key press, the program will then record the number of
samples requested and then when done will display what has been
recorded.

PUTTING RECORDS AND MEMORIES BACK

The routines that do the reverse of getting are available but there is &
word of caution; BE SURE THE RECORD OR MEMORY AREA CONTAINS THE
ARRANGEMENT OF DATA THAT IS CONSISTANT WITH RECORDS OR MEMORIES.
So there is no confusion, below is a8 memory map of the area.

(INSERT FIG 2 HERE)

The sintax for these statements should read, .
/»—-— mas‘/wnf/c. AT, flm oL nete ‘Ot[w'e Ca&/j

CALL PATCHE(PUTHEMBNUME) — 72 cXock fool for sum Janr

and w/ /éjg

CALL PATCHZ(PUTRECZ,NUME) —~ Kheo limats T off werks recovel spacso VI

~—"GpL - TO CODE OR NOT TO CODE

The question has been raised. It has been said previously that the SPL
value returned to the work space is 2 byte, unsigned binary with a 4 bit
MSB mantissa. So the number will be of value to the user in BASIC other
than using the print routine, we will take some time to explain the
‘concept. First of all, the term 2 byte, unsigned binary means that the
number is kept in a manner that is conveinent for the computer. With 2
butes the number can take on values from 0 to 65535 if there is no sign.
Since the SPL is recorded to 1/10 of a dB and the computer does not like
decimal points, the velues are multiplied by 10. So the number range we
are dealing with 1s O to 2000. This correlates to 0.0 to 200.0 dB SPL. In
hexidecimal format that would be 0 to 07D0Oh. Notice that the leading O in
07D0h; since this position is never really used to store the value it can be
used to store other information such as where to put a decimal point if one
vhere used. This could onlu be done if that 1eadina position where



~—----gtripped off before the number-was actusily used. In the case of SPL
values this is not really necessary because the decimal point is always in
PAEES L&

the same place.(ie. 10.0, 200.0, 9.5) However, recording values in Volts AC
is another story. So we adopted a method of storing decimal place
information in the unused upper 4 bits of the 2 byte number and limit
Volts AC to 999. (03E7h) The number contained in the upper nibble (4 bits)
is the position to place the decimel point as starting from the left. For
example, if we ANDed FOOOh with ths SPL value that was recorded in dB,
we would get 4000h. If we then ANDed the SPL value with OFFFh and got
back 0755, the decimal place would be 0755.5. The first position is in
front of the 0, the second place infront of the 7 and so on. This was done
to facilitate the machine language print routine and not to be
mathimaticly handy. It is also easier to store and takes up less room than
other matissa techniques. It can be celculated in BASIC by using the
following statements.

10 SPL&=PEEK(RLTMSPL%)+PEEK(RLTMSPL®+1)*256
20 D%=(SPL% AND.&HF000)/&H 1000

30 SPL&=SPLZ AND &HFFF

40 SPL=SPL&*10*(D&-5)

Line 10, get the value returned to memory.

Line 20, strip off the 4 bit mantissa and bring it down to the one’'s place-

Line 30, strip off the SPL from the mantissa.

Line 40, mathimatically set the decimal place into & single precision *‘O
variable. “\»

7
This over kill if not dealing with Volts AC. When just dealing with dB, ‘bef";
use, 2 A

= s._n = L T Nt P
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SPL - ANOTHER WAY STILL CHLOAD Froofln Koo ﬂ!“‘“’i:; A Ay
C NSHUE Rreer Amn CH A ve = 7<M7u«/

If it is desired to return the numerical data without drawing the fancy

bargraph or screen, there is another way. There is a routine pointed to by

the variable called CHLOADS. In the Tisting of “C:STARTUP.BAS", there is

at line 610, a statment which is dimentioning an array called CHZ(). The

routine searches for this array in the variable table of BASIC. When and if

found it procedes to load the srray with the 30 filter values, the SPL, and

the STATUS bytes. The result is the array variables will contain the

decoded values times 10. The array positions start with the lowest filter

{25 Hz) in CH®(0) and go to the highest filter (20KHz) in CH®(29), with the

stripped SPL velue in CH®(30), Status2 in CH%(31), Status! in CHE(32).

The filter values loaded into the array are also converted to absolute. This

means that if a value less than zero is returned and the analyzer is set up
far AR QPRI then the nitmhar ehnisld ha thnunht nf as 7zern. This routine is

S/~
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-for dB SPL, then the number should be thought of as zero. This routine is
CALLed when ever the data pointed to by RLTMFILD®,RLTMSPLE,STATUS2Z,

A08E /7

end STATUS1% needs to be transfered to the array variable CHE().. As an
example, go back to the GET MEMory program. After the memory has been
retrewed bg Hne 670 execute the statements,
? { H
680 CALL PATCH%(CHLOAD%) o
690 FOR 18=0 T0:30 R
700 PRINT CHE(1®)/10
710 NEXT |2 a

This routine will print the values for the data numerically. The screen
will scroll upward as the printing goes beyond 8 lines, but the numbers can
be seen after the program stops by using SHIFT and the up-arrow. Since
the numbers are kept as times ten, they need to be divided by ten before
printing.

c AP 7'572-« PRI cnet(2) s=1s o%r»/éé;l S
DUMPING THE SCREEN 7¢ e/ /f/)ﬂ'//vr cHRE(3)  sets “"”dea_

Screen dumps can be accomplished in two ways, sideways or normal. Both
are bit map transfers of the screen to the printer and assume that the user
is operating an EPSON MX or compatable. The normal screen dump is
unusual here because it does not use the same CALLing mechanism. Since
this routine is found in tha SYSTEM ROM, it is CALLed directly by issuing
the statement CALL SCRNDMPE, where the variable SCRNDMP® is equal to

&HEB36. s

The other;routine is used by the PC40 to dump to the cartridge printer. It
is more readable and can be done in two sizes. It also causes the screen
dump to come out sideways on the paper. This routine will work with any
printer as long as it maintains EPSON compatability. The size of the
screen dump.is controlled by a memory location at &HSECE. The value of \
this location is very important and should be &HB80 for the small format
and &HCO for the large format. Any other values will have unpredictable if
not disasterous results. The default value is 'Small’. Algo thereisa
second variable passed with the CALL that selects or deselects the
frequency labling.  If.the Second variable is zero, the frequencysabling
will not appear. If the second variable is a one then it will. As an
example, try the GET MEMory program again, only this time insert the line,

755 NUMB=0:CALL PATCHE(SDEDMPE NUMS) — 5 relovss, , ~< ,\/{Wv/

755 ADRB-SHEBSECALL ADRE  — “on - Ty
S P % g
BATTERY DISPLAY -

(18]

The batterg mmcator normally seen while in realtime anaiysis can o



recreated by CALLIng the routine located by BAIDSPE. This routine : ST
assumes that a realtime semple has been taken and that the gata located

VaaZoXe /{

in memory used by the routine is correct. If this is not so it will be crash
time again. In otherwords, don't CALL this routine unless you have run the
sample routine at least once.

STARTUP.BAS ROUTINE

This BASIC program is supplied in the PC40 ROM to aid the user.in learning
"how to interface with the PC40 application and to conserve on memory
when running programs. It is specifically devised to assign values to
memory pointers and then get out of the way by chaining to the program
thet will be doing the actual work. It is not necessary for this program to
be used before every progrem. The user is free to take statements out of
this program or customize it in any way that the user desires. In fact this
may be very advantageous once the program is developed {o conserve on
evan more memory. If there is something that is of no use, don't use {tl
This 1s easily accompiished by LOADing the program into BASIC, EDITing it
~ then SAVEing it eway under a different file name. It is also advantageous
~ to condense the names of the variables to two letters as this will also
save program memory space. Also, there is nothing scred about the
variable names, they can be what ever you choose. {(Just be sure to be
consistant)

BASIC - SPEED & EFFICIENCY

Sorry for the contradition in terms, BASIC has never been known for
either. However, there are a couple of things to remember so as to make it
as painless as possible. First, always use INTEGER variables where
possible, especially in 1oop counters. A 25% savings in time can be
realized by using integer variables as the counters in FOR-NEXT loops.
Second, always locate statements that are pointed to by GOTOs, GOSUBs,
NEXTs, etc. as near to the beginning of the program as possible.

m 32 /37 S o I S.;C)
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10 REM DEMO Recall Stored Memories and Place in Array

20 REM NOTICE - This Software is a DEMO ONLY

30 REM - Designed to Demonstrate Programming

/O REM - Techniques for the PC40.

50 KEM - 8/30/90 DRM

60 REM

70 REM Get and Define PC40 Constants and Calls

80 CLS:PRINT "Loading PC40 Definitions..."

90 CHAIN MERGE "C:STARTUP.BAS",60000!

100 REM ---> NOTE ** User Program MUST start at LINE 100 ** NOTE <---
110 DIM A%(19,30)

120 REM setup i/o ports to allow access to instrument memory
130 CALL PATCHZ(PORTR%)

140 REM set analyzer to low power mode

150 OUT 37,INP(37) OR 128

160 CLS:PRINT "Loading Data"

170 FOR MEM%=0 TO 19

180 REM recall the memory data

190 REM

200 REM Note: GETMEM memories are numbered 1-20

210 GMEMZ=MEM%+1

220 CALL PATCHZ(GETMEMZ,GMEM%Z)

230 REM transfer data from workspace to Basic CH%Z() array
240 CALL PATCHZ%(CHLOADZ)

250 REM test to verify memory contained valid data

260 IF PEEK(STATUS1Z) THEN 300

270 REM if data invalid, force it to zero

280 FOR FREQ%=0 TO 30:CH’%(FREQ%)=0:NEXT FREQ%

290 REM load target array with this memory data (includes wideband spl)
300 FOR FREQ%=0 TO 30:A%(MEM%,FREQ%)= CH%(FREQ%):NEXT FREQ%
310 A%(MEMZ,30)=A%(MEMZ,30)AND &HFFF

320 NEXT MEM%

330 REM here with all memories transferred to Basic Array AZ()
340 REM

350 REM

360 REM now dump the data to verify its there

370 PRINT "Printing Array"

380 FOR MEM%=0 TO 19

390 LPRINT "Data From MEMORY ";MEM%

400 FOR FREQ/=0 TO 29 STEP 6

410 REM print data 2 octaves per line

420 LPRINT USING “###_# “;A%(MEMZ,FREQ%)/10;

430 LPRINT USING "###.# ";A%(MEM%,FREQ%+1)/10;

440 LPRINT USING "###.#  “;A%(MEMX,FREQ%+2)/10;

450 LPRINT USING "###.# ";A%Z(MEMZ,FREQ%+3)/10;

460 LPRINT USING "###_# ";A%(MEMY, FREQ%+4)/10;

470 LPRINT USING "###.#"; A% (MEMY, FREQZ+5)/10

480 NEXT FREQY

490 LPRINT " Wide Band SPL for this Memory *;

500 LPRINT USING "###.#";A%(MEMZ,30)/10

510 LPRINT

520 LPRINT

530 NEXT MEM%

540 SYSTEM
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Basic and the PC40

<
g The BASIC programming language that comes with the PC40 is very close
*; to the that found on an IBM PC or compatable. This manual assumes that
W the reader has a working knowledge of that kind of BASIC. If this is not
the case, it is suggested that the reader first become familiar with
‘;’ programming in BASIC through one of the many tutorials that are
o commercialy available. This manual will not be teaching how to progream
in BASIC, rather it will attempt to describe how to utilize the machine
3& language subroutines found in the PC40 program from BASIC. This will
X . bring out performance characteristics that BASIC could not achieve on its
Qg own. This is however a two edged sword. Many of the machine language
3% ‘routines have no error checking and there are rules that need to be strictly
R followed. Lack of dilligence in these areas can cause program crashes that

~could result in complete loss of data. To this end, the manufacturer, the
dealers, and the representives of the PC40 claim no responsibility or
liability for the programs run in BASIC by the user. Therefore the user
should check and recheck all programs created and or entered into the
PC40 before running them. The two major RULES to follow to prevent
CRASHING are these: 1. ALWAYS use INTEGER YARIABLES in the CALL
statements, and 2. ALWAYS be sure to check for CORRECT SPELLING of the

—#RIABLES used in the CALL statements. Failure to do either of these will
result in CALLING to a memory location where no programs exist or into
the middle of a program. Since the Z80 processor or its operating system
has no error trapping to prevent this very strange things can and will
happen and in these cases nothing in memory is sacred. As a final note
before getting started, the patches from BASIC to the PC40 program
routines have not been created and supplied to facilitate programming by
the manufacturer. Instead, they have been supplied so that the users of
the PC40 can create and customize their OWN programs. The manufacturer
and its representatives will be happy to answer questions where possible
and give examples of "HOW T0", but will not tailor programs for each and
every user.

Getting Started

The subroutines used in the PC40 program have been made accessable to
BASIC by using the CALL statement. In every case CALLs will be made to a
machine language routine that has been down loaded beforehand to a
protected area of memory. This routine will bank switch memory over to
the ROM that contains the PC40 program, and will JUMP to the routine
needed. After the routine has completed its task, control is handed back to
the machine language routine first called where the BASIC ROM 1s bank
switched back in and control is handed back to BASIC where the next
logical instruction is executed.
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CLEAR AND GETTING LOADED

PAcE o

The first statement that should always be run when BASIC s first started
is;

10 CLEAR ,&HS3E30

The statement number can be any number as long as it is the lowest or the
first thing basic does. Don't forget the comma just before the ampersand
symbol or the statement will not work. Now come the first caution; When
using the patch routines, NEVER initialize internal RAM disk allocation
larger than 26K. {(Default value) RAM disk space also under lies the BASIC
and the PC40 ROM. If it s Intialized to larger than 26K, it will conflict
with the area-normaly loaded by the machine language patch routine and
will be overwritten. This causes no problem for the machine language
routine but data residing in RAM disk can gst clobbered. “The wey to avoid
this is to check the sigh on message in BASIC. If it shows legs than 20313
bytes of free space then there may be & problem with RAM disk being too
large. If this is the case, the computer will have to be reinitialized or the
“CONFIG" utility run to reduce the RAM disk size to 26K. The second
statement that needs to be runis;

20 BLOAD"C:PC40BSUB.CIM”

This will cause the object file named "PC40BSUB.CIM" on drive "C:" to be
loaded starting at the address CLEARed by the first statement. It will not
only load the machine language routine, but will also load the default
values for the analyzer and clear the memory locations used by the PC40
subroutines. These two statements once run will never need to be run
again as long as BASIC {s in operation. If BASIC is exited to go back to the
SYSTEM prompt, then all is lost including the BASIC programs and these
statements will need to be executed again when BASIC is reentered. Any
programs that were SAVEd to RAM disk will still be intact.

MEMORY AHD VARIABLES

The PC40 subroutines use part of the memory protected by the CLEAR
statement as areas to keep variables. Variables that control the analyzer
when some routines are run to variables that recefve data from other
routines. Control varisbles are used by POKEing a value in the appropriate
lacation and then calling the routine that exercises control using that
variable. The rest of the variables are used for storing or passing data to
BASIC programs usually by the PEEK statement. Listed below are the
variables used by the PC40 routines, their location, and the smount of
memory the variable addresses. Below each veriable is an explanation of
how the variable 1s used. In many instances there are specific values that
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~ cancause serious problems. : PAsE 5

~ ‘;.
= vy 7

PoKe LHEZ3S 6 g

¥
REFERENCE : Location &HSE35 - 1 byte PoKe #eleZ,¢ {

(RekerZ ) Controls the gain of the analyzer and is set in relation to the
dB level of the REFERENCE LINE /10. To set the REFERENCE LINE to 60 dB,
poke this location with 60/10 = 6, then CALL the port setup routine. ¥hen
using the Microphone as input valid references can be 3 to 14. when using
the probe, valid references can be from 5 to 186. DefGul7 =6 Q

LV A, |
-
-

o &
s EE

DECAY  : Location &HSE36 - 1 byte poke pecarYs, | \
DECAY Controls the responte of the filter detectors. There are three
speeds; 1=zslow, 2=medium, and 3=fast.  pefal? 3 Fost

SCALE : Location &HSE37 - 1 byte PoKE SCALE T, 3
s™E%  gets the resolution of the display screen. It can take on
values of 1,2, or 3 and corresponds to the dB/step. Defaw? 3ax0/57

RESPONSE : Location &HSE38 - 1 byte
ResPoW7e  Controls the response of the SPL detector. Valid values are

1=fast, 2=slow, 3=peak, or dzimpulse. Defau/? = LasT

- WEIGHT  : Location &H5E39 - 1 byte
“wex+477  Controls the SPL weighting and can also control the filter
weighting if the filters have been set to follow the SPL weighting’. Valid
values are O=FLAT, 1=C WT., 2=A WT. Defult = 7/ oo Droplag b Beleno

DISPLAY : Location &HSE3A - 1 byte

prspcnydy  This controls two separate items. First, it sets the filters to
OCTAVE or 1/3 OCATVE response. Second, it causes the filters to follow

the SPL weighting or sets the filters to flat response. 0=0CTAVE and

FLAT, 1=1/3 OCTAVE and FLAT, 2=0CTAVE and follows SPL weighting,

3=1/3 OCTAVE and follows SPL weighting. owste, = perankt = 5 ocTore

MIC/PROBE : Location &HSE3B - 1 byte
micPRBZ%  There are two possible inputs to the analyzer. When this
location is O, the input is taken from the 2P microphone input. VYalues of
1,2, 0r 3 will cause the analyzer to take input from the BNC Probe
connection. When set to 1, the SPL print routine will scale the SPL value
to dBM. When set to 2, the SPL will be scaled to dBY. When set to 3, the
value returned by the CONVERT routine will be scaled to AC voits. Defeul? =574
T4 SRET RECDRAT B exprloradtwn ,
A — -~MEMORY  : Location &HSE44 - 110 bytes  Formet'io Figus - e W
B This is the place where PC40 memories are brought back, Reol f o 2}
w e realtime converted data is stored, and where records from the record  ,..fe 1:""“ o
buffer are returned. Hence, this area sees alot of changes and care must a;j;g .
be teken in CALLing routines so that importent data residing there is

stored somewhere else before the CALL. The Memory ares is divided up

i



into smaller areas depending on the routine CALLed and the tgpe of data.
PEsE &

These areas are as follows:

STAMP : Location &H5E44 - 6 bytes

Here is the actual Time and Date Stamp created for 8 MEMORY
when the STORE button was pressed. It is kept in packed BCD format. If
this is a problem, be aware that these values are decoded by the memory
fetch routine and stored in another location which will be shown later.

NOTE . Location &H5E4A - 40 bytes

Here is the 40 character note for a8 memory that has been
returned by the memory fetch routine. It is kept in ascii format and can be
PEEKed into & string variable as will be seen later.

PIXELS : Location &HSES4 - 30 bytes

This is field is of little use to the user directly. It is brought
to light here to show that it is sharing the same space as NOTE. It is used
to store the number of pixels that are OFF in the bargraph on the screen.
The values can either be calculated by e routine or brought straight in as
is the case for a realtime sample. ‘

FILTERS : Location &HSE72 - 60 bytes

Here is the values for each of the 30 filter channels. They are
kept in signed, binary format and are relative to the reference at the time
they were stored. They are also stored in LSB, MSB format which means
that the Least Significant Byte if first and the Most Significant Buyte is
second. This means that there are 2 bytes/value and the values start with
25 Hz end end with 20 KHz. If this is a problem, there is an easy way to
return these values directly to an array predefined in the BASIC program.

SPL : Location &HSEAE - 2 bytes

The SPL data is also kept in binary format just as the filters
are with two exceptions. First, the value is unsigned and has a 4 bit MSB
mantissa. SAY WHAT? Don't worry too much this is also decoded
automatically by the SPL print routine. Plus there are easy to follow
BASIC statements that will be shown later to handle the decoding.

STATUS  : Location &HSEBO - 2 bytes
Compressed into these 2 bytes is all of the analyzer

parameters such as reference, decay, response, weighting, ect. Don't
H worry, there again is a simple way to decode this information.
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THE ROUTINES

Here is where the fun begins. Consequently, this is also where the danger
begins so as a word of caution, BE SURE TO CHECK ALL STATEMENTS BEFORE
RUNNING THEM! To simplify the programming process another help has
been added besides the subroutine patch to the PC40 ROM. The program is
called "STARTUP.BAS" and also resides in the PC40 ROM which is known to
the computer as disk drive “C:". This program performs most of the
yariable assignments for the machine language addresses and the 1ocations
of the variables in the PC40 workspace area. Before looking at this
routine however lets get into BASIC.

Turn the analyzer on and Quit the PC40 application (program). Now should
be seen the CP/M prompt or MENU. If the MENU is in effect, place the
cursor over “B:BASIC.COM" and press return. If the system is in the
PROMPT mode, then type in

B:BASIC.COM<CR> The "<CR>" means to press '‘RETURN'.

The analyzer should now show the USER LOGIN MENU for BASIC. Pressing
the 'SPACE’ bar should 1ogin to USER AREA 1 with the ever-so~popular “0K"
prompt showing up in the left most column just under the BASIC sign on
message. |f you have failed to get this far then stop everything and refer
to the OPERATING SYSTEM MANUAL and the BASIC MANUAL that came with
the PC40.

Once safely in BASIC, type in the following;
LOAD “C:STARTUP.BAS™<CR>

The response on the next 1ine down should be "0OK" with a flashing cursor
below the "0K". If the next line down says, “NE ERROR" and then displays
the “0K" prompt, check the spelling of the line with LOAD on it. If
neccessary, move the cursor with the cursor arrows up to the mistake and
type over it with the correct spelling. If it is correct now, press 'RETURN'.
If a1l has gone well, the "OK" prompt will write over where the "NE" used
to be and the response on th next two lines down will read,

“OK ERROR"
WUK“

Now type,

LIST<CR>



The program that was listed to the screen is devised to make all of the
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normal variable assignments and declarations for the user. This program
can be altered and SAVEd or used to CHAIN to a user written program.
More about that laterl Now, lets use this program as a starting point and
add a little to it.

Read the 1ast line of the program. It shduld read,
"630 CHAIN "PC40BAS”, ALL"

Delete the line by typing,

DELéTE 630<CR> T

Now type,

630 CLS:CALL PATCHB(DRAWSCRNEICR) — Draws
640 FOR 1820 TO 1000:NEXT IZ<CR> -

Remember sintax (spelling) is very important; CHECK YOUR WORK! When
the program is correct type,

RUN

What happens next is that you will think that the analyzer has gone back to
the PC40 program and in a way it has. Only after a second or two the PC40
screen will shift up one line and the "0K" prompt will be back indicating
that the BASIC program has finished it's task. Always include & clear
screen command before executing this routine or weird things can happen
such as the upper half of the screen on the bottom.

SCREEN DRAY ROUTINE

The routine uses the control variables to graphically construct a sckeletal
screen upon which other information can be overlayed such as the filter
channel data. Before that, however, lets take a minute to see what affect
the contro] variables have on the screen. Insert a new line of instruction
by typing, |

625 POKE REFER®,3<CR>

that is printed by the REFERENCE LINE on the screen. Remember, only enter ‘5?’159
those values that are valid. . &i"

v _
Now try changing "REFER®" to the variable "DECAY®" and try the valid (e g ?"j

PR R -



How try changing "REFER®" to the variable “DECAYE" and try the valid
values. The decay indicator box on the righthand side of the screen should

POE T
be moving to the appropriate positions.

Now use the variables “SCALEZ", "RESPON®", "“WEIGHT®", "DISPLAY%", and
"MICPRB®" and observe the result. Note, when changing “MICPRBZ", the

~result will be to change "SPL" in the bottom righthand corner to "DBM",

“DBV”, to "ACVY".
ANALYZER CONTROL

All of the control parameters for the analyzer are handled by one routine,
but this routine has two entry points. The first entry point is used to
initialize the /0 port adapters and then set the control lines going to the
analyzer. The second entry point is used for setting the control lines
without initializing. The reason for the two entry points {s that once the
I/0 ports have been initialized, it is not necessary to do again unless the

glitch in the eudio circuitry of the analyzer. Before using this routine it is
necessary to be sure that the control variables contain the desired values.
¥hen the machine object file "C:PC40BSUB.CIM" s 1oaded in the variables
are set to a default value. The default settings are listed below.

Reference = 60

Scale = 3 dB/step

SPL Responce = Fast

SPL Weighting = Flat

Filter Bandwidth = 1/3 Octave

Filter Weighting = Flat £
Filter Decay = Fast pb«f"'//f

Input = Microphone (SPL) ' : ,{
‘ 5J"f
hro

The syntax for this command is, vov!
e r

. CALL PATCH%(PURTR%) = Mﬁ‘x/t).es er 7‘4’/‘-AJS 4‘40(4'0 m amo‘z7}o,

or :
CALL PATCHZ(PORT®)

The latter statement will set the control lines without intializing the /0
ports.

— ——

Tl;a,‘.,,/éy‘/"” 2a =

STATUS SETUP & RETURN

Before it was stated that t%nalgzer setup was also encoded down into
two bytes called "STATUS". This is done so when data is stored, it does

not take up as much space. There are two routines that encode and decode~ ~ -
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status bytes. The other goes the opposite direction and rewrites the

PR o

control variables based on the status bytes. These routines are used when
recalling data from memory or putting data into memory. In the first case
, after fetching 8 memory from the PC40, the status to veriable routine
would be used to set the control variables to the state they were in when
the memory was stored. Afterward a screen would be generated and the
data displayed just as it was saved. To use these routines they should
look like this,

CALL PATCHB(STATVARIZ) Converts STATUS bytes to Control Variables
or :
CALL PATCHB(VARISTAT®) Converts Control Yariables to STATUS bytes

DISPLAYING DATA

There are four routines that display data. They are Filter display, SPL
display, Battery display, and Screen Redraw. We have already seen how
screen redraw works. The other three routines are called in the same
manner as the Screen Redraw routine. However, there are no default
values for the other routines because they depend on data that has been
created by some means as recalling a memory or taking & realtime sample.
Do not use these routines unless valid data exists. Failure to follow this
rule will possible cause a program crash. The syntax for these routines is,

CALL PATCHR(FLTDSP®) Filter bargraph drawing routine

and _

CALL PATCH®B(SPLDSP&) SPL prints in bottom righthand corner

and :

CALL PATCHZ(BATDSP®) Drews bargraph indicator in top right corner

TAKING A SAMPLE
The routine for taking a sample assumes that the analyzer has been turned

on. Of course if this is not the case, the data returned will be garbage
although it will not cause the computer to crash. Before running this

-
-\
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routine then it is necessary to have CALLed the analyzer setup routine. ;f"apf R

After having done so you cen take a realtime sample by doing,

CALL PATCHB(CONVERT®) { poe ¥
e (.
This will return the-retetive level of all 30 filterg) the SPL, and the level
of the Battery. This routine will use the same area as the memory fetch
and the record fetch routines so it assumed that any important data
residing there has been transfered elsewhrere. This routine is unigue in
that you dont need to calculate the height of all the filter bars after the

routine is done. It does all that as part of the process. Using the routines

—we know about this far, lets make & realtime analyzer program. Type in

thhe FAllmnusimm ad dlam o d _ 2 2 [ —
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rout13e1sdone It does Va»l-l that as part of the process. Using the routines
we know _about this far, lets make a realtime analyzer program. Type in

the following at the end of the "C:STARTUP.BAS" program. —

630 CALL PATCHB(PORTR®)

640 CLS:.CALL PATCHZ(DRAWSCRNE)
650 CALL PATCHE(VARISTAT®)

660 CALL PATCHB(CONVERT &)

670 CALL PATCHR(FLTDSP%)

e
153 B 13 :m 53
] |

680 CALL PATCHZ(SPLDSPE) LOCATE COORINATES
690 CALL PATCHZ(BATDSPZ) For Annuncitor windows
700 GOTO 660 ’ On Pedo Screen

Before typing ‘RUN<CR>' check your typing.

The result should be the PC40 action that you are used to seeing. The only
exception is that it will not, at this point, respond to any of the keys
except for the "QUIT" key which will "BREAK" the program execution. Below
is an explanation of the program.

Line 10-620, sets up the variables for PEEKing, POKEing, and CALLing
Line 630, setsﬁtp'g 3r231yzgr on and sets the control lines

Line 640, clears the scréen and draws the basic sceen graphics

Line 650, sets the status bytes = the variables (not necessary here but a
good practice

. Line 660, gets realtime data from the analyzer

Line 670, displays the filter levels

Line 680, displays the decoded version of the SPL

Line 690, displays the battery level

Line 700, 1oops the program back for more {indefinitly)
To St A The QU t AeTlon

FETCHING A MEMORY

Returning a memory STOREd by the PC40 is just a little different than
vhat we have seen so far. Beyond CALLing the routine to fetch the memory
we also need to tell the routine what memory number to get. This is done
by passing a second parameter in the CALL statement. "Passing a
parameter”; What is that? Well, so far, the CALL statements that have
been used are CALLing to an address in the variable "PATCH®". Then the
routine at that address CALLed takes the value in the variable inside the
parenthesies as a “passed parameter” and jumps to the address that is
equivalent to the value “passed”. We add the second parameter like this,

CALL PATCHZ(GETMEM®,NUME)

The first variable in the parentesies is the address of the GETMEMory
routine while the second variable {s the number of the memory we want to
get back. The two variable must be integer and they must be separated by
a comma. The valid range for memories is 1 - 20. 1 - 10 would correspond

., 4 %{
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inverted memories 1 - 9,0. Let see how this works by typing in these
SRS 12

statements at the end of "C:STARTUP.BAS". Note: Before doing this
program you might want to make sure there are some memories stored in
the PC40 or there won't be anything to recail.
o-1
4' 630 CLS:INPUT"SELECT A MEMORY NUMBER (1-20)"; NUM%
__640 IF NUMZ<1 OR NUMZ>20 THEN 630
~ 650 CALL PATCHZ(PORTR®)
660 OUT 37,INP(37) OR 128
670 CALL PATCHR(GETMEME, NUMZ)
680 IF PEEK(STATUS1%) THEN 690 ELSE 630
690 CALL PATCHB(STATVARIRZ)
700 CLS:CALL PATCHEZ{DRAWSCRNE)
710 POKE REFBUFF®,PEEK(REFER®)
720 CALL PATCHE(REFLOCAL®)
730 CALL PATCHR(PIRCALR) (P /¥ <A< %)
740 CALL PATCHE(FLTDSP%)
750 CALL PATCHRB(SPLDSP%)
760 K$=INKEY$:IF K$="" THEN 760
770 GOTO 630

Check your work before typing ‘RUN<CR>’
You must have noticed that there were a number of CALLs and procedures
that have not been discussed yet. Well let's see what is hapening here.

Line 630, Prompting for memory number to get.

Line 640, Test input against limits to be sure the number is ok.

Line 630, Configure the ports. Even though the analyzer is not being used
this needs to be done so that the routine can eddress the RAM in the PC40.
Line 660, Turn the anlyzer power OFF. Not absolutely necessary but
helpful. Aot

Line 670, Get the memoryato display.

Line 680, Test STATUS byte #1 to see if the data is there. If data was
actually stored here then this location would not be zero. If this memory
is not active then there is nothing to display.

Line 690, Set up the control variables so the screen draw routine will
reflect the,fsmgfup when the memory was stored

Line 700, Draw generic PC40 screen.

Line 710, Set the original reference equal to the new reference. This is
done so that when the filter bar heights are calculated, they are figured on
the basis that they are being displayed with the original reference. To see
the data at a different reference, after executing Line 710 then reset the
variable REFER® to the desired reference/10. This must be done before
CALLing the routine REFLOCALZ on line 720.

Line 720, This routine sets the lower limit of the screen so the next
routine can calaulte how high to make the bars on the filter bargraph. The
result is not returned to BASIC, but is stored in work space for later

€ mmmnm
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~. routine can calaulte how high to make the bars on the filter bargraph. The
result is not returned to BASIC, but is stored in work space for later

reference. L5 /3

Line 730, Calculate how high to make each bar on the filter bargraph. This
must be done because unlike reaitime, the pixel data for the height of the
bars is not readily available. Since it not stored 1t must be recalculated.
This feature aliows the user to recalculate the filter bars for different
references and scales.

Line 740, The rest is the same as before except that the battery is not
displayed. This is simply due to the data not being kept. Who cares what
the battery was doing then, what matters is what it is doing right now
which is now then so again, Who cares?

Line 760, Simply a mechanism to hold the program up until your ready to
look at the next memory. Again the program can be quit by pressing the
‘QUIT’ key.

NOTES AND TIME

The memories are all stored with a time and date stamp as well as a 40
character note. These are available, but the note needs to be read out of
work space memory before the pixel calculation takes place as that
routine shares space with the note area. To read out the note use the PEEK
command in & loap sch as this,

10 NOTE$=""

20 FOR 18=6 TO 45 / L7 .
30 NOTES= NUTE$+CHR$(PEEK(MEMURY%+1%)

40 NEXT I3 T cpER " 1" yor #‘enm/un_l

Line 10, clear any previous note.
Line 20, the note goes from position 6 to position 45 in the memory ares.
Line 30, concatonate all of the characters. read el bl to pote sM exch tmihudonl) chaned,
Line 40, do all of the 40 characters.(spaces and all)
At this point the note$ can be 4 i - t
ever else you do with strings, The ot ¥ 3 seffly sl the N

/ ﬁy ?’%C&f
The time and date are not over writtenjand can be directly reed et memory
locations 0-5 relative to the value kept in MEMORY®. The time is kept in
BCD format, most significant to least. First ig the Year, then Month, Day,
Hour, Minutes, Seconds. |f BCD is scery to you then use the decoded values
placed in work space for you at the location kept in the variebles YEAR®E,
MONTH®, DY®, HOUR®, MINUTE®, SECOND®. The reason the variable DY® is
spelled DAYZ is that DAY 1s a reserved word to BASIC. To get a value out
of memory simply PEEK it. {ie. PEEK(YEARR))

GETTING A RECORD

Fetching information back from the record buffer is the same as fetching a
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record checking exists The two th Ings to keep in m1nd vrhile using this
oo Parce lanye Froike o o I 5 o 3 fconled LA 1y
routine is know beforehand the limits of the record buffer (Available RAM)
and know how many records have been put there. The range can take on
values from O to 8155. The statement to get the record would look like
this,
CALL PATCH®(GETREC®,NUMZ)

All of the same calculation procedures have to be done before you can

display the resuits.
mfe_pf.i; e paoes off 7 C O (2L Pty
RECORDING RECORDS - tuill be . #M S et ey o Frce Fo

m

This routine will go out anmcord what ever number of records it is told.
Using the rate specified by the control variables as well as the set up, the
routine will not return to BASIC until the 1imit specified has been reached.
Rate by the wauy, is a control variable that -has not been priviously covered.
Pointed to by the variable RECDRATE®, valid values that can be POKEd
there are 1 to 100. Any values outsdie this range will have unpredictable
results. the default is 30, which meand that the analyzer will take
samples at a rate of 30 spectral stores per second. One spectral store
includes all 30 filters, the SPL, and the two status bytes. Use of this
routine might 1ook like this,

638 AS=INPUT$(1)

630 CLS:INPUT"ENTER NUMBER OF SAMPLES";NUM® €48 CALL PRTCHECRETY, babe)

640 IF NUM$>400 THEN 630 68 PNE Ao P e )
650 INPUT"ENTER RATE TO SAMPLE"-RATER RT 7 £ UL PTG ORECRE)

660 IF RTE<! OR RTZ>100 THEN €3¢ 5o 0 R 1 TN,

670 POKE RECORATES RATER RT % . I8 hs P 11

680 CALL PATCHZ(PORTRE) 728 (AL PTERRLT)

665 CALL PATCHR(VARISTATS) 11

690 INPUTPRESS ANY KEY WHEN READY*:DUMMY$ 798 6010 758

695 CALL PATCHZ(RECDE, NUM%)

700 OUT 37, INP(37) OR 128 — 72wams om=’3 1 W %
__—705 POKE REFBUFPEEK(REFERS)

710 CALL PATCHB(DRAWSCRNE) G Fum T

715 CALL PATCHB(REFLOCAL®) ontTs ?, Jwp(35) cocl (27

720 FOR 12=0 TO NUMZ

730 CALL PATCH®B(GETRECZ,| %)

740 CALL PATCHB(PHEALE) (P e e % )

750 CALL PATCHB(FLTDSP®)

760 CALL PATCH®(SPLDSP®)

770 NEXT 1%

Much of this program should be readily understood when compared with
those given aiready. Therefore, only those statements that dlffer will be
dicussed.
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those given alreadg Therefore, only those statements that differ will be
dicussed.

Line 705, the difference here is order in the program. It should be noted

PAsE L5

that the original reference need only be set once if the data is not going to
be changing in reference. Likewise the lower screen 1imit only needs to be
calculated once if the data is not going to be rescailed.

Line 740, calculation can be done without any more reference or screen
low limit calculations because the data is being displayed without any
rereferencing or rescaling.

What should happen during the execution of the program is the user will be
prompted for the number of sample to record and the rate at which to
record the samples. Then the program will wait for the user to press a
key. After the key press, the program will then record the number of
samples requested and then when done will display what has been
recorded.

PUTTING RECORDS AND MEMORIES BACK

The routines that do the reverse of getting are available but there is a
word of caution; BE SURE THE RECORD OR MEMORY AREA CONTAINS THE
ARRANGEMENT OF DATA THAT IS CONSISTANT WITH RECORDS OR MEMORIES.
So there is no confusion, below is a memory map of the area.

(INSERT FIG 2 HER_E)

The sintax for these statements should read, .
/--— st g te daBB, i) ol note ‘ffw‘e Ca&a-ﬁ

CALL PATCHB(PUTMEME NUME) — 7 choclk fouk for won amer

and /. AQ

CALL PATCHZ(PUTRECENUMZ) — Kneo limats F ot vors reconel spacso SV

N,\L\SPL - TO CODE OR NOT TO CODE

The question has been raised. It has been said previously that the SPL
value returned to the work space is 2 byte, unsigned binary with a 4 bit
MSB mantissa. So the number will be of value to the user in BASIC other
than using the print routine, we will take some time to explain the
concept. First of all, the term 2 byte, unsigned binary means that the
‘number is kept in a manner that is conveinent for the computer. With 2
bytes the number can teke on values from O to 65535 if there is no sign.
Since the SPL is recorded to 1/10 of & dB and the computer does not like
decimal points, the values are multiplied by 10. So the number range we
are dealing with is O to 2000. This correlates to 0.0 to 200.0 dB SPL. In
hexidecimal format that would be 0 to 07DOh. Notice that the leading O in
07D0h; since this position is never really used to store the value it can be
used to store other information such as where to put a decimal point if one
where used Thig rnuld anlit he dnna {f that 1eading nnaitinn whers



-— -stripped off before the number-was actually used. In the case of SPL
values this is not really necessary because the decimal point is always in
: PAEE L

the same place.(ie. 10.0, 200.0, 9.5) However, recording values in Yolts AC
is another story. So we adopted a method of storing decimal place
information in the unused upper 4 bits of the 2 byte number and limit
Volts AC to 999. (03E7h) The number contained in the upper nibble (4 bits)

is the position to place the decimal point as starting from the left. For
example, if we ANDed FOOOh with ths SPL value that was recorded in dB,

we would get 4000h. If we then ANDed the SPL value with OFFFh and got
back 0755, the decimal place would be 0755.5. The first position is in
front of the 0, the second place infront of the 7 and so on. This was done
to facilitate the machine language print routine and not to be
mathimaticly handy. It is also easier to store and takes up less room than
other matissa techniques. It can be caiculated in BASIC by using the
following statements.

10 SPLB=PEEK(RLTMSPLE)+PEEK(RLTMSPLB+ 1)*256
20 D%=(SPLE AND-&HF000)/&H 1000

30 SPLE=SPL% AND &HFFF

40 SPL=SPL%*10*(D%-5)

Line 10, get the value returned to memory.

Line 20, strip off the 4 bit mantissa end bring it down to the one’s place-

Line 30, strip off the SPL from the mantissa.

Line 40, mathimatically set the decimal place into a single precision - 3
variable. f”

7
This over kill if not dealing with Volts AC. When just dealing with dB, 5 .
use, /P" ’ AW
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If it is desired to return the numerical data without drawing the fancy

bargraph or screen, there is another way. There is a routine pointed to by

the variable called CHLOADZ. In the listing of "C:STARTUP.BAS", there is

at line 610, a statment which is dimentioning an array called CHZ(). The

routine searches for this array in the variable table of BASIC. When and if

found it procedes to load the array with the 30 filter values, the SPL, and

the STATUS bytes. The result is the array variabies will contain the

decoded values times 10. The array positions start with the lowest filter

(25 Hz) in CH®(0) and go to the highest filter (20KHz) in CH®(29), with the

stripped SPL value in CH®(30), Status2 in CH&(31), Status! in CHZ(32).

The filter vaiues loaded into the array ere also converted to absolute. This

means that if a valus less than zero is returned and the analyzer is set up

for dB SPL. then the numhear should ha thounht of as zern. This routine is

=Ya
-
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-for dB SPL, then the number should be thought of as zero. This routine is

CALLed when ever the data pointed to by RLTMFILD®,RLTMSPLE,STATUS2Z,
: AWEE /7

and STATUS 1% needs to be transfered to the array variable CHE().. As an
example, go back to the GET MEMory program. After the memory has been
retrewed bg line, 670 execute the statements,

:!.é«- i i . 3
H

680 CALL PATCHR(CHLOADS)
690 FOR 18=0 TO:30 -

700 PRINT CHE(1%)/10
TIONEXT I

This routine will print the values for the data numerically. The screen

will scroll upward as the printing goes beyond 8 lines, but the numbers can
be seen after the program stops by using SHIFT and the up-arrow. Since
the numbers are kept as times ten, they need to be divided by ten before
printing.

. s %ﬁ/éé; 4 o
A PemrEr P cubb(2) st g4
DUMPING THE SCREEN 70 A Pem Lormr cHeb(3) st aormdmete

Screen dumps can be accomplished in two ways, sideways or normal. Both
are bit map transfers of the screen to the printer and assume that the user
is operating an EPSON MX or compatable. The normal screen dump is
unususl here because it does not use the same CALLing mechanism. Since
this routine is found in the SYSTEM ROM, it is CALLed directly by issuing
the statement CALL SCRNDMP®, where the variable SCRNDMP is equal to

&HEB36. e

The other,routine is used by the PC40 to dump to the cartridge printer. It

is more readable and can be done in two sizes. It also causes the screen

dump to come out sideways on the paper. This routine will work with any

printer as long as 1t maintains EPSON compatability. The size of the 4
screen dump.is controlled by a memory location at &HSECE. The value of \
this location is very important and should be &HB0 for the small format

and &HCO for the large format. Any other velues will have unpredictable if

not disasterous results. The default value is "Small’. Also there isa

second variable passed with the CALL that selects or deselects the

frequency labling. . If.the $econd variable is zero, the frequency#abling

will not appear. If the second variable is a one then it will. As an

example, try the GET MEMory program again, only this time ingert the line,

755 NUMB=0:CALL PATCHZ(SDEDMP® NUMB) — 5/0@4«/47 - - 47 4\/{/%4/
or var15L5]
7355 ADRB=&HEB36:CALL ADRE — /"Oh—-.¢$/ % 7

p
S o 4% --§
BATTERY DISPLAY =

The battery mdlcator normaHg seen whﬂe in reamme anatysis can oe

roanrantasd e AL 2L - —_



recreated by CALLIngG the routine located by BAIDSPE. This routine . i
assumes that a realtime sample has been taken and that the data located
' SRS /’{

in memory used by the routine is correct. If this is not so it will be crash
time again. In otherwords, don't CALL this routine uniess you have run the
sample routine at least once.

STARTUP.BAS ROUTINE

This BASIC program is supplied in the PC40 ROM to aid the user.in learning
“how to interface with the PC40 application and to conserve on memory
when running programs. It is specifically devised to assign values to
memory pointers and then get out of the way by chaining to the program
that will be doing the actual work. It is not necessary for this program to
be used before every program. The user is free to take statements out of
this program or customize it in any way that the user desires. In fact this
may be very advantageous once the program is developed to conserve on
evan more memory. If there is something that is of no use, don't use it!
This 1s easily accomplished by LOADIng the program into BASIC, EDITing it
then SAVEing it away under a different file name. It is also advantageous
" to condense the names of the variables to two letters as this will also
save program memory space. Also, there is nothing scred about the
variable names, they can be what ever you choose. (Just be sure to be
consistant) :

BASIC - SPEED & EFFICIENCY

Sorry for the contradition in terms, BASIC has never been known for
either. However, there are a couple of things to remember so as to make it
as painless as possible. First, always use INTEGER variables where
possible, especially in loop counters. A 25% savings in time can be
realized by using integer variables as the counters in FOR-NEXT loops.
Second, always locate statements that are pointed to by GOTOs, GOSUBs,
NEXTs, etc. as near to the beginning of the program as possible.

/m 37 3] 2 sﬂ
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20

20

40

50

60

70

80

S0

100
110
120
130
140
150
160
170
180
190
200
210
220
230
240
250
260
270
280
290
300
310
320
330
340
350
360
370
380
390
400
410
420
430

450
460
470

490
500
510
520
530
540

REM DEMO Recall Stored Memories and Place in Array

REM NOTICE - This Software is a DEMO ONLY

REM - Designed to Demonstrate Programming
REM - Techniques for the PC40.

REM - 8/30/90 DRM
REM
REM Get and Define PC40 Constants and Calls
CLS:PRINT "Loading PC40 Definitions..."
CHAIN MERGE "C:STARTUP.BAS", 40000!

REM -~=> NOTE %k User Program MUST start at LINE 100 ** NOTE <---
DIM A%(19,30)

REM setup i/o ports to allow access to instrument memory
CALL PATCHZ(PORTRZ)

REM set analyzer to low power mode

OUT 37,INP(37) OR 128

CLS:PRINT "“Loading Data"

FOR MEM%=0 TO 19

REM recall the memory data

REM

REM Note: GETMEM memories are numbered 1-20
GMEMZ=MEM%+1

CALL PATCHZ(GETMEMZ ,GMEMZ)

REM transfer data from workspace to Basic CHZ() array
CALL PATCH%(CHLOAD%)

REM test to verify memory contained valid data

IF PEEK(STATUS1%) THEN 300

REM if data invalid, force it to zero

FOR FREQ%=0 TO 30:CHJ%(FREQ%)=0:NEXT FREQ%

REM load target array with this memory data (includes wideband spl)
FOR FREQ%Z=0 TO 30:A%(MEMJ,FREQ%)= CH%(FREQ%):NEXT FREQ%
A% (MEMZ,30)=A% (MEMZ%,30)AND RHFFF

NEXT MEMZ

REM here with all memories transferred to Basic Array A%Q)
REM

REM

REM now dump the data to verify its there

PRINT "Printing Array"

FOR MEM%=0 TO 19

LPRINT “Data From MEMORY ";MEMY

FOR FREQY%=0 TO 29 STEP 6

REM print data 2 octaves per line

LPRINT USING "“###.# ";A%(MEMX,FREQY)/10;

LPRINT USING "###.# ";A%(MEMY, FREQ/+1)/10;

LPRINT USING "###.# “;A%(MEM%, FREQZ+2)/10;

LPRINT USING “###.# “;A%(MEMY, FREQ%+3)/10;

LPRINT USING "###.# ";A%(MEMY, FREQ/+4)/10;

LPRINT USING “###.#"; A% (MEMY, FREQ%+5) /10

NEXT FREQY

LPRINT " Wide Band SPL for this Memory *;
LPRINT USING "###. #";A%(MENZ,30)/10
LPRINT

LPRINT

NEXT MEMZ
SYSTEM
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Header Block Layout
- Numb f Records in each Data Block
- g?iis 1’% - %:gégnggg -“geﬁgrﬁ Rate in use at time of measurement (100 Sq~pies ger Q&léj)
byte % - (RT6OCNT) - Number of RT60 Tests Averaged togeather in
the Average Data Block. .
byte 5 - (FNCTSTAT) - Byte containing Bit Flags for various Internal
Functions. )
byte 6,7 - Llsb,msb of RT60 Measurement Period. 181 => 1.81 Seconds etc
bytes 813 -6 bytes of Date/Time Stamp when measurment was taken. .
pate/Time bytes contain Year, Month,Day, Hours, Min,Sec.
Packed 1 byte each in BCD format.
bytes 14-53 - 40 Bytes of ASCLl Note Info Entered with Measurment |
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Dat

bytes 1,2
bytes 3,4
bytes 5,6

bytes 57,58
bytes 59,60
bytes 61,62
byte 63

byte 64

a RECORD Layout

Lsb,msb of Signed Binary Relative Level for 25 Hz Filter
Lsb,msb of Signed Binary Relative Level for 31.5 Hz Filter
tsb,msb of Signed Binary Relative Level for 40 Hz Filter

Lsb, msb of Signed Binary Relative Level for 16K Hz Filter :
Lsb, msb of Signed Binary Relative Level for 20K Hz Filter i
Lsb,msb of Unsigned Binary SPL with 4 bit MSB mantissa
(STATUS2) - Bit Fields Pefining Instrument Setup .
such as Weighting, Response, Decay, and Octave or 1/3
Octave.
(STATUS1) - Bit Fields further Defining Instrument Setup H
such as Reference Level, mic/probe selection, 20/40 dB
input atten setting. !
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DEFINT A-Z

'Open the Data File and Define the 64 byte Data Record Format.
OPEN path$ + File§ FOR RANDOM AS #9 LEN = .64
FIELD #9, 60 AS FilterData$, 2 AS Spl$, 1 AS stat2$, 1 AS stat1$

'Position to the desired Data record and Read it.
GET #9, Rec’

'Decode and Calculate the Reference Level
ref! = (ASC(stat1$) AND &HF) * 10

‘Decode the SPL reading for this Data Sample
WD.spl = (CVI(Spl$) - &H4000) / 10

'Now Decode and Calculate the Absolute Level for each Filter
FOR i% =1 T0 30
wft! = (CVI(MID$(FilterData$, i% ¥ 2 -1, 2)) / 10)
'if filter level is not under range then convert to abs else flag
' under range error.
IF wft! > -471 THEN wft! = wft! + ref! ELSE wft! = 0
Wl (i%) = wft!
NEXT %

‘Decode and Convert the Status Bytes
stat2% = ASC(stat2$)
SELECT CASE stat2% AND &H3

CASE O
WD.Splwt = "fFlat"
CASE 1
WD.Splwt = “C-wt"
CASE 2
WD.Splwt = "A-wt"
END SELECT

WD.Fltwt = "Flat"
IF stat2X AND &H80 THEN WD.Fltwt = WD.Splwt

SELECT CASE stat2X% AND &HC

CASE RHO
WD.splrsp = "Fast"
CASE 8H4
WD.splrsp = "Slow"
CASE &H8
WD.splrsp = "Peak"
CASE &HC
WD_splrsp = "Impil"
END SELECT :
SELECT CASE stat2’ AND &H30
CASE &H10
WD.Fltdcy = “Slow"
CASE &H20
WD.Fltdcy = "Med "
CASE &H30
WD.Fltdcy = "Fast"
END SELECT

IF stat2% AND &H40 THEN WD.Oct = false ELSE WD.Oct = true

4//‘7/70
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Header Block Layout

Lsb,msb of
(RECDRATE)
(RT60CNT)

Number of Records in each Data Block
- Record Rate in use at time of measurement (0D Sgmpies pex

— Number of RT60 Tests Averaged togeather in

bytes 1,2
byte 3
byte 4

)

 DATA
Gq 6\’1’( «CU’

the Average Data Blo

ck.

(FNC

Lsb,
.6 by
Da

byte 5

byte 6,7
bytes 8-13

TSTAT) - Byte containing Bit Flags for various Internal

Functions.
msb of RT60 Measurement Period. 181 => 1.81 Seconds etc
tes of Date/Time Stamp when measurment was taken.
te/Time bytes contain Year,Month,Day Hours,Min,Sec.

packed 1 byte each in BCD format.
40 Bytes of ASCII Note Info Entered with Measurment

bytes 14-33
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bytes 1,2
bytes 3,4
bytes 5,6

bytes 57,58
bytes 59,60
bytes 61,62
byte 63

byte 64

[ O I |

Lsb,msb of Signed Binary Relative Level for 25 Hz Filter
Lsb,msb of Signed Binary Relative Level for 31.5 Hz Filter
Usb,msb of Signed Binary Relative Level for 40 Hz Filter

Lsb, msb of Signed Binary Relative Level for 16K Hz Filter
Lsb,msb of Signed Binary Relative Level for 20K Hz Filter
Lsb,msb of Unsigned Binary SPL with 4 bit MSB mantissa
(STATUS2) - Bit Fields Defining Instrument Setup.
such as Weighting, Response, Decay, and Octave or 1/3
Octave.
(STATUS1) - Bit Fields further Defining Instrument Setup
such as Reference Level, mic/probe selection, 20/40 d8
input atten settina.
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DEFINT A-1

‘Open the Data File and Define the 64 byte Data Record Format.
OPEN path$ + File$ FOR RANDOM AS #9 LEN = 64
FIELD #9, 60 AS FilterData$, 2 AS Spl$, 1 AS stat2$, 1 AS statl1$

‘Position to the desired Data record and Read it.
GET #9, Rec’

'Decode and Calculate the Reference Level
ref! = (ASC(stat1$) AND 8HF) * 10

'Decode the SPL reading for this Data Sample
WD.Spl = (CVI(Spl$) - &H4000) / 10

'Now Decode and Calculate the Absolute Level for each Filter
FOR i% = 1 710 30
wft! = (CVI(MID$(FilterData$, i% * 2 - 1, 2)) / 10)
'if filter level is not under range then’ convert to abs else flag
' under range error.
IF wft! > -41 THEN wft! = wft! + ref! ELSE wft! =0
Wil (3%) = wft!
NEXT %

'Decode and Convert the Status Bytes .
stat2% = ASC(stat2$)
SELECT CASE stat2% AND &H3

CASE O
WD.Splwt = "Flat"
CASE 1
WD.Splwt = "C-wt"
CAS
WD.Splwt = "A-wt"
END SELECT

WD.Fltwt = “Flat"
IF stat2” AND &H80 THEN WD.Fltwt = WD.Splwt

SELECT CASE stat2’ AND &HC

CASE &HO
WD.splrsp = “Fast"
CASE &H4
WD.splrsp = "sSlow"
CASE &H8
WD _splrsp = "Peak"
CASE &HC
WD.splrsp = “Impl"
END SELECT :
SELECT CASE stat2’ AND &H30
CASE &H10
WD.Fltdcy = "Slow"
CASE &H20
WD.Fltdey = "Med “
CASE &H30
WD.Fltdey = “Fast"
END SELECT

IF stat2’ AND &H40 THEN WD.Oct = false ELSE WD.Oct = true
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PC40 POWER SUPPLY

Connect vafiable. DC power supply to PC40. Check 5 wvolt
regulator. Measure 5V + .4V between source of Q37 (middle leqg)
and source of Q41 (farthest right leg). fhis is the output of the
regulator circuit. Vary power supply voltage from 8V to 15V.
Regulator output should be 4.8 to 5.3V. If voltage is over 5.5
volts unplug power supply immediately or the DC to DC converter
will be damaged. Set power supply to 9Vdc. From ground to pin 7
on IC27 measure +8Vdc + .5V. From ground to pin 4 on IC27 measure
—8Vdc +.5V. From ground measure 8Vdc +1V to + battery pin which
is - the closest pin to the DC to DC converter. Measure 6Vdc at
drain of +.3V Q41 (middle lég). Adjust 7 volt reference. From pin
1 to U28 to ground measure 7Vdc. If not 7Vdc adjust R170 to get
as close to 7Vdc as possible. + .001. Adjust 12 volt reference.
- From pin 7 of U28 to ground measure 12Vdc. If not 12Vdc adjust

R169 to get as close as possible to 12Vdc + .001.
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PC40; Weight Calibration
45559
Reference the PC40 to 90. The SPL needs to be in A welght
Input 1kHz sine wave through 6 pin connector of PC40 uslng,eather

the - 82AD or 83AD. Adjust the 'amplitude of the input until there

2.5 : Rop Tacte aAva
is JArms at. SPE—TP& or—pin—t4—ofU6. Voltage at-the output of the

. 51newave generator should be approx1mate1y 2 8Vr’ins "Change - SPL to

C welght and adJust R74 unt11 there is #Vrms at === Change SPL.
2.5 Lok Jacke.

to flat and adJust~R;76 untll there is —l—\lrms at TPt
After these adJustme_nts have been made” change the fre-quency
of the generator and 'see that the data on the follow1ng table is

JoCA-Tide

confirmed. All measurements are from ¥P+to ground.

" 100Hz - . 1kHz . 10kHz

V270 L300 - 2,97 4.52% 1875 1.967
A weight .108 - .120 - .990 - 1.010 750 - .795
2,51 .upS @ 2415 Fses ] 462 [.¢©
C weight .939 - .994 .990 - 1.010 .983 - .640
: 1!(/75 2.5€2 2 47 279 2.525 ';',érz'g
Flat 1990 - 1.025 7990 - 110 1.010 - 1.050

Check the SPL output ‘on J4. It should be the same as the

input voltage to the 6 pin connector + .05. Check the filter
input voltage. It should be 1.03Vrms + .05.
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PC40 Logger Calibration

(Requires digitalvboard to be separated from analog board)

Réference» PC40 to 90. Input 1kHZ'$inewavé'.through 6 pin
cpnnéctor of PC40 using either the 82AD or BSAD.'Adjust amplitude
df:input until there is 1Vrms at SPL test point,l.

-Coﬁhect scope probe to test point 2 log out or the emitter
of Q9. Set the scope volts/division to 50mv and the time/division

axis to .5V. The scope should look 1like this:

Adjust R34 until peaks overlap each other. Attenuate signal
15dB'and adjust R14 until peaks overlap. Attenuate signal 15dB
more and adjust R16 until peaks overlap. Attenuate signal 15dB
more and adjust R19 wuntil peaks overlap. Attenuate signal 15dB
more and adjust R38 until peaks overlap. Repeaﬁ procedure until
the peaks overlap each time the signal is attenuated 15dB.

NOTE: R40 and R42 should be centered.
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PC40 SPL Calibration

(Requires digital board to separated from analog board)
Reference the PC40 to 12@. Input 1kHz sinewa§e through 6‘pih
‘connector of PC40eusing eitherlihe 82AD or 83AD. Amplitude of ihe
sinewave needs to be,1Vrms.,DC>voltage en_TPB ( pin 14 of Ull)
Should be 9 volts. If not adjust R11 until there is 9 volts.
Adjust R140 until there ie 2Vde on IP4 (pin 8 of Ull). Adjust
R205 until 120.0 is in vSPL windpﬁ. L | |

Set reference to 80. Adjust R125 until there is 5.40Vdc +
.001 on pin 1 of Ul1l. | .

Set reference to 120. Adjust R102 until there is 4.60Vdc
£.001 on pin 1 of Ull. | |

Set reference to 80 and adjust R113 until 120.0 is in the
SPL window. Set reference to 120 and adjust R111 wuntil 120.0 is
in the SPL window. Toggle  between 80 and iZO adjusting the
appropriate pot until 120.0 is iﬁ the SPL window when referenced
at 80 and 120. | |

Set reference to 90 and adjust R100 until 120.0 is in the
SPL window. Set reference to 100 and adjust R101 until 120.0 is
in the SPL window.
Change reference from 80 ro 90 to 100 to 110 to 120 to 130

to 140. SPL window should read 120.0 + .3d4B.
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Real Time Display Calibration

Setup:
reference PC40 to 120
1 dB per division

input 1Vrms at 1kHz

Adjust R137_funti1_1kHz filter is even with the reference
line. Attenuate signal 10dB and change dB per di?ision to"édB.
Adjust R143 until filtef is even with —-10dB division. Attenuate
signal 36dB an&'change dB pér division to 3dB. Adjust R133 and/or
R144 until filter is eveﬁiwith. —-36 dB line. Repeat proceduré
until attenuating the sigﬁal ,10, 20, and 36dB produces the
correct reading on the display. This may take seVeral times as

the adjustments interact.
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